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2 Unit 2 Basic ICT Skills 

2.1 (Higher) About Computers 

2.1.1 Types of Computer 

2.1.1.1 Desktop 
A desktop computer is a personal computer intended for use at a fixed location. It is not portable. 

Early designs had a horizontally placed computer case on which a monitor screen could stand. This 

orientation was intended to save space. Modern designs often have a vertically mounted computer 

case intended to stand either on or under the desk. The computer case is usually linked to a monitor, 

speakers, keyboard and mouse by cables or wirelessly. Desktop PCs are usually designed with free 

slots on the motherboard in which extra hardware can be added, allowing the PC to be gradually 

upgraded by the user, adding drives graphics boards, extra RAM etc. 

   

Figure 1 : A selection of desktop computers 

2.1.1.2 Laptop 
Laptop computers (smaller versions of which are often referred to as notebooks) are personal 

computers designed for portable use. The laptop incorporates the monitor, computer, keyboard, 

mouse (touchpad) and speakers into a single unit. The laptop has a battery on-board which is 

charged by means of an AC power adaptor. Laptops may have less processing power than desktop 

machines for equivalent prices, but the advantages in compactness and portability often outweigh 

this issue. A laptop is generally less user configurable in terms of hardware than the equivalent 

desktop, as there is not generally the space to add hardware within the device. 
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Figure 2 : A selection of laptop computers 

2.1.1.3 Netbook 
A netbook is a small, light, low-power notebook computer that has less processing power than a full-

sized laptop but is still suitable for word processing, running a Web browser and connecting 

wirelessly to the Internet. 

 

Figure 3 : An example of a netbook 

2.1.1.4 All-in-One 
All-in-one computers are becoming more popular, utilising developments in laptop technology to 

negate the need for a separate PC and monitor. An all-in-one PC is a personal computer mounted on 

the desk like a standard monitor, but with the computer built in to the back of the monitor unit. It is 

usually powered by an AC adapter and has USB ports for attaching a mouse, keyboard and other 

devices. All-in-one PCs often have a touch-screen capability built in, allowing users to interact with 

programs by touching the screen itself. They meet the needs of desk based comfort – whilst not 

requiring the space on or under the desk to place the PC box. They lack the possibilities for 

customisation of a standard desktop PC, which is usually designed with free slots to add extra 

hardware, such as drives, graphics cards etc. 
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Figure 4 : An all-in-one computer 

2.1.1.5 Tablet 
A tablet PC is a hand held device with a touch-screen. It may have sockets to connect other devices 

for interaction purposes. Tablet PCs may be lower powered than the equivalent laptop due to size 

restrictions, and therefore may be limited in the software that they can run. Some tablets are built to 

use leaner smartphone operating systems such as Android, Windows Phone or iOS, which are 

designed for less powerful machines. Some tablets are equipped with a stylus (or pointer) for ease of 

selecting finely. 

 

Figure 5 : A typical tablet computer 

2.1.2 Parts of a Desktop Computer 

2.1.2.1 Overview 
A desktop computer can be broken down into its key components, which are generally the computer, 

its monitor, its speakers, its keyboard and its mouse. These are shown in Figure 6. There are other 

peripherals which may also be connected. 
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Figure 6 : A labelled diagram of the main components of a Desktop PC 

2.1.2.2 The Monitor 
The monitor is the computer’s screen. Some have built in speakers, and some have touch screen 

functionality, but all monitors are means of visual display. Older versions tended to be big and heavy 

with a CRT (Cathode Ray Tube) build, but modern monitors use much lighter and less bulky LCD and 

plasma screen technologies. 

 

Figure 7 : A selection of monitors 

 

2.1.2.3 The Computer 
The computer case (sometimes also known as the base unit or Central Processing Unit) usually 

consists of a plastic or metal box mounted in either an upright or horizontal position. It contains the 

computer itself, consisting of the mother board, processor, disk drives, graphics card, RAM and the 

power supply. It also usually has an on/off and a reset switch on the front. At the rear of the unit (see 

Figure 9) there will be a number of sockets to which the other parts of the computer and a power 

cable must be attached. There may also be a power switch at the rear. There are usually also a 

number of USB sockets, some of which may be on the front of the unit for ease of access. 

Computers in this form allow for upgrades as they often have free slots and power connections for 

adding in new hardware. 

  

Figure 8 : Some computer cases 
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Figure 9 : A view of the back of a PC showing the numerous sockets to connect the various peripheral devices 

2.1.2.4 The Mouse 
The mouse is a device that allows interaction with the pointer on the screen. Moving the mouse 

moves the pointer. The mouse also has two or more buttons and sometimes a scroll wheel. The 

functionality is explained in the Input devices section (Section 2.2.1). Most modern mice use a USB 

connector to link to the PC, they may however be wireless or use a PS/2 connection. 

  

Figure 10 : Some mouse pointing devices 

There are many device types which have the functionality of the mouse but may work in slightly 

different ways. A summary of types is given below.  

- Mechanical mouse: Houses a hard rubber ball that rolls as the mouse is moved. Sensors 

inside the mouse body detect the movement and translate it into information that the 

computer interprets. 

- Optical mouse: Uses an LED sensor to detect tabletop movement and then sends off that 

information to the computer for merry munching. 

- Infrared (IR) or radio frequency cordless mouse: With both these types, the mouse relays a 

signal to a base station wired to the computer's mouse port. The cordless mouse requires 

power, which comes in the form of batteries. 

- A mouse with many buttons: The extra buttons can be programmed to do specific things, 

such as navigate the Web or turn pages when you’re reading a document. The typical button-

ified mouse has about five buttons. 
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- Trackball mouse: Like an upside-down mouse. Rather than roll the mouse around, you use 

your thumb or index finger to roll a ball on top of the mouse. The whole contraption stays 

stationary, so it doesn’t need a lot of room, and its cord never gets tangled. 

- Stylus mouse: Another mouse mutation enjoyed by the artistic type is the stylus mouse, 

which looks like a pen and draws on a special pad. 

- Cordless 3-D mouse: This kind of mouse can be pointed at the computer screen like a TV 

remote. 

Further information can be found at http://www.dummies.com/how-to/content/the-different-

types-of-computer-mice.html) 

2.1.2.5 The Keyboard 
The keyboard is a collection of keys with letters numbers and symbols on them for typing text inputs 

into the computer. Its full functionality is detailed in the inputs section (section 0). 

   

Figure 11 : PC keyboards 

2.1.2.6 Speakers 
The speakers are the means of sound output on a desktop PC. There is usually a two speaker system 

– although there may be more than two speakers – or sometimes none at all.  Speakers generally 

stand either side of the monitor and often have some controls to adjust the volume and balance and 

a power switch. It is also common for speakers to be built in to the PC base unit or the monitor. 

 

Figure 12 : PC speakers 

2.1.2.7 The Router or Modem 
The router or modem is a device which allows your computer to have a connection to the internet. It 

may be connected to your computer by a wired or ‘wireless’ connection. These devices are very 

http://www.dummies.com/how-to/content/the-different-types-of-computer-mice.html
http://www.dummies.com/how-to/content/the-different-types-of-computer-mice.html
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varied in appearance, but have the common use of connecting one or more computers to the 

internet. 

  

Figure 13 : A wired and wireless router 

2.1.2.8 The Printer 
The printer is used to print out copies of documents on paper. Some printers are only capable of 

printing in black and white, and some can do colour prints. Many printers have other functionality 

built in such as scanners, making them useful as photocopiers. 

      

Figure 14 : A selection of printers 

2.1.2.9 The Scanner 
A scanner is used to get a copy of a document or picture saved on the computer. It can be seen as a 

sort of electronic photocopier. Some printers also have scanners built into them – known as all-in-

one printer/scanners.  

 

Figure 15 : A scanner 
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2.1.2.10 Webcams 
A webcam is a camera device which can allow people on other computers to see you (if you allow 

them to). Some webcams have a microphone (see next section) built in allowing them to capture 

both images and sound. Some monitors (especially in laptop computers) have a webcam built in 

placed just above the screen (as in the right hand image in Figure 16). 

  

Figure 16 : Webcams (left a USB webcam, and right a built in webcam in a laptop computer) 

2.1.2.11 Microphones 
The microphone is a device which plugs into your computer and allows you to speak to it. This can be 

useful for voice inputs to control the computer or for speech to text inputs. It is also useful for 

communications applications where you can speak to people on other computers. Some 

microphones stand on the desk or clip to the monitor. Others may be a part of a headphone set. 

Some laptop computers have a microphone built in. 

 

Figure 17 : Microphone for a PC 

2.1.2.12 CD, DVD and Blu-ray Drives 
Most computers have a built in drive to read and/or write CDs, DVDs or Blu-ray discs. In a desktop 

machine, it is usually located on the front of the unit. In a laptop or all-in-one machine it is often on 

one of the sides of the machine. The tray is opened by pressing the button on or next to the tray. On 

inserting the disc they will usually automatically run. The tray may be closed by gently pushing it back 

in or sometimes by pressing the open/close button again. 
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Figure 18 : DVD drives in a laptop, desktop and all-in-one machine 

2.1.2.13 Cables and Connections 
The parts of a desktop computer are connected up by a series of cables, each of which has a different 

purpose. This section will identify the cables and where they should be attached to make your 

computer work properly. 

Power cable: The power cable is usually a thick cable with a large connector with three holes in it.  

 

Figure 19 : Power connector 

Monitor cables: There are three main types of display cables, DVI, VGA and HDMI. The first two, 

being quite large, often come with screw fittings to enable a secure connection to the socket. To 

connect them you must first push the plug into the socket, and then (using either fingers or a 

screwdriver) screw the screw fittings until finger tight. The HDMI cable is a more modern alternative 

and just pushes in. 

    

Figure 20 : VGA display connector (left) DVI display connector (MIddle) and HDMI (right) 

Network cables: Network cables generally have a locking mechanism. A piece of sprung plastic clicks 

into place to ensure the network cable stays firmly in its socket. To release a network cable you must 

press down on the clip whilst pulling the plug from the socket. 
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Figure 21 : Network connection 

USB cables: USB cables are the most common sockets for connecting peripherals such as cameras, 

mouse, keyboard, webcam, phone etc. to your computer. They are a standardised socket and should 

have a USB symbol (see Figure 22) on both the socket and the plug. If the symbols are aligned, the 

plug will fit the socket. A USB connector will not fit in the socket if it is the wrong way round. 

  

Figure 22 : A USB plug and the USB symbol 

 

Speakers: A speaker cable uses a connection similar to a headphone plug. These are often colour 

coded, with a green plug for a green socket. 

Microphone: A microphone also uses a headphone type plug. These are often colour coded with a 

pink plug for a pink socket. 

 

Figure 23 : A microphone connector 

PS/2: This is an old style connector for the mouse and keyboard. It has commonly been replaced now 

with USB ports which allow much more general connectivity of devices. These were also often colour 

coded using a purple plug and socket for the keyboard and a green plug and socket for the mouse. 
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Figure 24 : A PS/2 plug for old style mouse and keyboard 

Parallel ports: Some older computers may still have parallel ports for connecting up printers 

scanners and other peripheral devices, but again these have largely now been replaced with USB 

connections. A parallel port is a large long connector with 25 holes and often screw connectors like a 

monitor cable has. 

 

Figure 25 : A parallel port 

Serial port: Some older computers may also have serial ports which have again been largely replaced 

with the use of USB connections. Some older or more specialised hardware may still use a serial 

connection. To connect these to a modern PC with no serial port, a serial to USB convertor cable can 

be purchased. 

 

Figure 26 : A serial plug connector 

Firewire: This was introduced as a faster connection to replace USB 1, but since USB 2, firewire has 

been largely replaced by USB which can transfer data at almost equivalent speeds. Firewire was 

commonly used in video equipment and external hard drives, and by Apple Inc. (who originally 

developed the technology), where speed of data transmission is key.  

 

Figure 27 : A firewire plug 
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Each of the connections above has its own socket type. The socket types available and their positions 

vary from PC to PC. In Figure 28 a typical PC is shown from the rear. Each of the connectors is 

labelled. The majority of connections are grouped as they are mounted directly on the motherboard 

of the computer. There are however separate positions for the power input (a part of the power 

supply unit) and the extra display outputs (mounted in an optional graphics card). 

 

Figure 28 : A labelled diagram of the back of a PC unit showing the various sockets for connection 

2.1.2.14 Assistive Hardware 
This material will be provided by the ATLEC project (www.atlec-project.eu) that focuses on assistive 

technologies training. 

2.1.3 Parts of a Laptop Computer 

2.1.3.1 The Laptop 
The laptop contains the main five parts of a desktop computer in one portable unit. It has a monitor, 

speakers, a computer, a keyboard, and a touch pad pointing device (which works like a mouse). A 

laptop may also have a microphone and webcam built into it. 

http://www.atlec-project.eu/


 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

 

Figure 29 : A diagram showing the key parts of a laptop computer 

2.1.3.2 The Power Supply 
The power supply acts as a recharger for the battery which is usually mounted under the back of the 

laptop. The power supply will need to be connected to the mains and plugged into the laptop if using 

it for prolonged sessions or if the battery is low. 

 

Figure 30 : a power supply for a laptop computer 

2.1.3.3 The Mouse 
A mouse is often plugged into the laptop to control the pointer as this may be easier to use than the 

laptop’s built in touch pad device. Laptops rarely have a PS/2 connection, and so USB is the usual 

means of connecting a mouse. 

  

Figure 31 : A selection of mouse pointing devices 
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2.1.3.4 The Touchpad 
Most laptop computers have a touch sensitive device to perform the operations of the mouse. It is 

usually mounted close to the front edge of the laptop. A touchpad is shown in Figure 32. It can be 

used in a similar way to the mouse. Dragging a finger across the surface of the pad moves the mouse 

pointer across the screen. Clicking the left button acts a left mouse click. Clicking the right button 

acts as a right mouse click. All drag and double click options behave as in a normal mouse (See 

section 2.2.1.2 – ‘Using a mouse’. There is a portion on the right hand side of the touchpad that acts 

as a scroll wheel. Dragging the finger up and down on this portion of the touchpad will scroll the 

current window up and down. 

 

Figure 32 : A touchpad on a laptop computer 

2.1.3.5 Assistive Hardware 
Add items here specific to user group 

2.1.4 Turning the computer on and off and 

logging in and out safely 

2.1.4.1 Starting Up the Computer 
The ‘Power’ Button 

The first step in turning on a computer is locating the ‘Power’ or ‘On/Off’ button. It will usually have a 

symbol like the ones on the buttons in the pictures in Figure 33. 

    

Figure 33 : A selection of power buttons showing the power symbol 

To turn on a desktop computer, you will need to press the one on the computer case and also the 

button on the monitor with the same symbol. First press the on button on the monitor. It should 

come on, but not be displaying anything meaningful. Next press the on button on the computer case. 

It will probably make a beep and a whirring noise, and some lights may come on. On the monitor, 
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you will then see a number of messages flashing on and off as the computer loads up. This process 

can take a minute or two. You need to wait until you see the log in screen. 

To turn on a laptop computer, you will first need to open it. Some laptops will just fold open, others 

will have a push or sliding clasp holding the laptop closed. To open these you will need to slide the 

catch or press the button prior to opening the laptop. Next locate the power button, which is usually 

found above the keys of the keyboard and will be denoted by a symbol like those in Figure 33 : A 

selection of power buttons showing the power symbol, and press it firmly once. It will probably make 

a beep and a whirring noise. The monitor and some lights may come on. On the monitor, you will 

then see a number of messages flashing on and off as the computer loads up. This process can take a 

minute or two. You need to wait until you see the log on screen. 

Logging On 

Depending on your computer system, the log on screen may look different, but most log on screens 

only require you to put in two things, a user name, and a password. The user name may already be 

stored in a list or as an icon. If there is an icon with your log on name click it and then enter the 

password. If there are two text boxes, type your username into the first and your password into the 

second. These will both be case sensitive – which means that you must use capital letters and small 

letters correctly. When you have entered the password click the log on button and the computer 

should continue to load the software. After a minute or two the computer should be ready to use. 

An example boot 

There follows an example of booting up a laptop PC into Windows 7. The first thing to do is open up 

the laptop. Some simply fold open others have a slider or button catch to keep them locked. Once 

the laptop is open, locate the power button. This can be seen in Figure 34 as the silver central button 

with the blue light under it. On pressing the power button, the machine begins to boot. It first shows 

a splash screen for the manufacturer (as shown in Figure 34), and then goes on to say that it is 

‘Starting Windows’ (as in Figure 35). 

 

Figure 34 : Initial screen 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

 

Figure 35 : The machine is 'Starting Windows' 

After a minute or so it will reach the login screen as shown in Figure 36. The login screen in this 

instance has 3 users set up, Andy, Emily and Jack. In order to log in a user must click on their icon. 

There are also some other options on the login screen. The blue icon in the lower left of the screen is 

a shortcut to the ‘Ease of Access Centre’. When clicked, this displays some of the ease of access 

options (see Figure 37) that can help a user to log on and use Windows. 

 

Figure 36 : Windows 7 login screen 
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Figure 37 : The ease of access centre from the login screen 

When one of the user icons is clicked, in this instance ‘Andy’, a password box appears (as seen in 

Figure 38). The user must type their password using the keyboard, and then click on the arrow next 

to it. As can be seen in Figure 39, as the password is typed, the characters appear as a black circle. 

This is to hide the user’s password on the screen and is not an error. It serves to give the user a guide 

to how many characters they have typed without giving away the password to bystanders. When the 

password is entered, the user clicks on the arrow next to the password box (or presses the Enter key) 

to continue. 

Some login screens will not have a list of users, but will have two boxes. One to input a username and 

the other to input the password. If this is the case the user must type their username and password 

into the boxes and click on the arrow or press enter. 

 

Figure 38 : The password entry screen for user 'Andy' 
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Figure 39 : Typing the password 

After the password is typed correctly Windows will continue to load into the user’s log on. If the 

password is typed wrongly the machine will prompt them to try again. Once a correct password is 

given, the ‘Welcome’ screen will load (as in Figure 40) which indicates a successful login. After a short 

wait, the desktop should appear with its familiar icons. On some slower computers it is advisable to 

wait until the system has fully loaded and settled down before attempting to work with the machine. 

The machine is ready to use when the lights indicating drive activity stop flashing on and off. 

 

Figure 40 : Welcome screen 

2.1.4.2 Shutting Down the Computer 
A) Exiting Programs 

When preparing to turn off the computer, prior to shutting down the machine it is important to 

make sure all work that has been done is saved. From the file menu click save on any documents you 

are working on. After this click the ‘x’ cross icon on the top right of the window. This should close the 

application. There is more on this in the ‘Using the Computer’ section. 

B) Software Shutdown from the Start menu 
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Once the applications are closed you can begin shutting down the machine. This is usually done using 

the mouse, but can also be done with keyboard only.  

Using the Mouse to shut down:  

Click on Start in the task bar (if the task bar is not present move the mouse to the bottom edge of the 

screen to make it appear).  

 

Figure 41 : Clicking the start button brings up the Shut Down button 

In Windows XP there is a ‘Log off’ and a ‘Shut Down’ button in the start menu (Figure 41). Log off will 

take the user to the log in page (it will first ask for confirmation that the user wants to log off). Shut 

down will offer a list of options (Figure 42). Shut Down should be selected to shut the computer 

down completely. Out of interest here is what the other options do:  

 Shut Down - shut the computer down completely. 

 Restart – shut the computer down and restart it again immediately 

 Standby – a power saving mode that leaves your computer ready to be used again 

immediately 

 Log Off Username – takes the computer back to the login screen 

 Hibernate – a shut down mode that will bring your desktop back as it was on restarting 

  

Figure 42 : The Shut Down button brings up this window (left), and clicking the dropdown reveals the menu shown right. 

Using the Keyboard to shut down: 

On the keyboard the user should press the ‘Windows Key’ - it will have a symbol like  or  and is 

placed at the bottom of the keyboard close to the ctrl and alt keys. Using  the arrow up key the user 

can step the highlight onto Shut Down. Hitting the ‘Enter’ key performs the operation. The up and 

down arrows move the user through the same dropdown options as described above. The user 

should select the option they require, and hit ‘Tab’ to move the focus to the OK button. Hitting 

‘Enter’ again will activate the shutdown. 

In Windows 7, there is a single button in the start menu called ‘Shut Down’(see Figure 43 : The ‘Shut 

down’ button from the Windows 7 task bar / Start buttonFigure 43).  
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Figure 43 : The ‘Shut down’ button from the Windows 7 task bar / Start button 

C) Turning off the Monitor 

After shut down, the computer will in most cases turn off automatically. If it reaches a screen that 

states ‘It is now safe to switch off your computer’, the power button may be pressed to turn it off. On 

a laptop, the built in monitor will also shut down automatically. The monitor on a desktop machine 

will however stay on standby, and can be turned off by pressing the power button again. This is the 

same button as was used to turn it on previously. 

2.2 Higher Input Devices 

2.2.1 The mouse/touchpad 

2.2.1.1 Parts of the mouse 
A mouse is a device controlled by the user’s hand on a surface, usually a desk. It has a sensor 

underneath (using either a ball or a light) to track its position on the desk. As you move the mouse it 

moves the pointer on the screen. The mouse will usually have at least two buttons (known as the left 

and right mouse buttons) and will also often have a scroll wheel between them. A mouse may also 

have more buttons and features than these, but most of the functions can be achieved using only 

those controls previously listed. 
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2.2.1.2 Using a mouse 
A) Moving the pointer 

To move the pointer on the screen, move the mouse around on the desk. 

B) Left Mouse Click 

A left mouse click is a single press and release of the left mouse button. It is called a click 

because of the sound it makes. A left click will usually select an item on the screen. 

C) Right Mouse Click 

A Right mouse click is a single click of the right mouse button. A right mouse click will usually 

bring up a menu of choices of different things you can do. 

D) Double Click 

A double click is the term for clicking the left mouse button twice in quick succession. A 

double click will select and then activate an action. For example double clicking on an icon on 

the desktop will open a file or application. 

E) Dragging 

Dragging is where the user clicks the mouse button and holds it down. The user then moves 

the mouse across the desk. This process ‘dragging’ enables an object to be selected and 

moved across the screen. 

F) Scrolling 

Scrolling is the term used for turning the scroll wheel. This is often used to scroll through the 

contents of a window with a scroll bar at the side of it. Rolling the scroll wheel away from 

you will move the document up, and rolling it towards you will scroll down the document. 

2.2.1.3 Touchpads 
Laptop computers are designed with a touchpad device that acts as a mouse when use of an actual 

mouse is impractical. It has a touch sensitive area, dragging a finger on which moves the mouse 

pointer. It also has left and right buttons as in a mouse. Some mouse pads will have a small 

thumbstick device, which can be used for scrolling between items or mouse pointer movement. The 

touchpads also often have a scroll area on the right hand side of the pad to allow scrolling in 

windows (similar to a scroll wheel on a mouse). Some touchpads will have a central button to 

represent clicking down on the mouse scroll wheel. Functionality will generally behave as in the 

mouse – see section 2.2.1.2. 
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Figure 44 : A labelled photo of a touchpad 

2.2.1.4 Accessibility assistance for the mouse 
In Windows there are a number of software tweaks which can make the mouse more accessible for 
particular users. They can be turned on and off using the ‘accessibility wizard’ available from the 
accessibility menu under accessories. 

 Use numeric keyboard instead of a mouse – allows the numeric keyboard to double up as a 
mouse 

 Mouser cursor – change the colour or size of the mouse pointer 

 Mouse button settings – switch the mouse for a left handed user 

 Mouse pointer speed – change the speed of the mouse pointer 

Different designs of mouse may increase the ease of use for particular users. A wireless mouse could 

prevent problems caused by wires, or a track ball could be useful where a user has limited 

movement. 

2.2.2 The Keyboard 

2.2.2.1 The keys 
The keyboard is a device designed to allow a user to input data and information into a computer. It 
consists of a device with multiple buttons (or keys) connected to the computer by a cable – or 
sometimes wirelessly. The keys are often grouped to improve the functionality of the keyboard. The 
groupings of the keys are shown below: 

The letter keys are grouped, and usually presented in the ‘QWERTY’ format (shown in blue on Figure 
45). This is a standard layout that once learned allows fast typing speeds. The long bar below them is 
called the space bar, which adds a space between typed words.  

Some keyboards have a number pad to the right (shown in Figure 45 in green) which contains the 
numbers and the most common mathematical operators. This allows for fast number work. Some 
keyboards do not have a number pad in order to make the keyboard more compact. This is common 
on laptops or portable keyboards. All keyboards however have the numbers above the letters (shown 
in Figure 45 in red). There are a set of navigation keys in the centre (shown in Figure 45 in purple), 
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consisting of arrow keys, home and end, page up and page down, insert and delete. The remaining 
keys are also important, and below their respective uses are listed. 

 

Figure 45 : The key groupings on a keyboard 

On the keyboard there are also a number of special keys. These are as follows: 

Shift:  This is a modifier key. When this key is held as another key is pressed, it makes the alternate 
‘upper’ character be displayed. When used with a letter key it will alter the case of the letter. When 
used with one of the keys with lower and upper options (e.g. ‘{‘ or ‘[‘ ) the upper option will be 
displayed. 

Control: ctrl This is also a modifier key. It performs special operations when pressed in conjunction 
with other keys. The ctrl key allows many useful shortcuts to be performed. Some of the most 
commonly used are: 

 CRTL and X – cut 

 CTRL and C – copy 

 CTRL and V – paste 

 CTRL and Z – undo 

 CTRL and A – select 

There are many others and the functionality often changes dependent on the program that is being 
used at the time.  

Alt: This is a modifier key used to ‘alternate’ the function of the key. The functions performed by the 
alt key combinations vary depending on the program being used. Commonly they will allow shortcut 
(or non-mouse-user access) to menus. 

Caps Lock: Caps lock is a toggle switch. Press it once and the case of all characters typed will switch. 
Press it again to switch the case back again. There is often a light on the keyboard which denotes 
whether or not the caps lock toggle is on. Caps lock can also be used to capitalise letters by a user 
without the sufficient two-handed motor control to hold shift whilst typing. 

Windows:  The windows key is a shortcut to the start menu or a means of accessing the menus 
without using a mouse. It also allows a number of shortcuts relating to the movement and 
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maximising/minimising of windows. These shortcuts are listed in Section 0 ‘Higher Using the 
Computer’ 

Tab:  Tab is a key used for aligning text into a tabular form in a document. It is also used in 
windows to cycle between links in html browsers. Tab shifts the highlight to the next link. Shift and 
tab moves the highlight back to the previous link. This is useful for hyperlink selection by non-mouse-
users. 

Enter:     There are two enter (sometimes called return, or carriage return) keys. There is one to the 
right of the letter group, often marked with an arrow pointing down and to the left. There is also one 
on the bottom right hand side of the number pad – usually marked ‘enter’. Both keys perform the 
same function, which is usually to finish and entry and perform a process. It is often the keyboard 
equivalent of clicking an OK button with the mouse. When using a word processing package, the 
enter key will act as a carriage return – beginning a new paragraph. 

Backspace:  The backspace key allows a user to delete the last character they typed. Holding the 
backspace key will repeatedly delete characters. 

Delete: The delete key (sometimes marked ‘del’) serves to delete the character in front of the curser 
point. It can also be used for such functionality as deleting media from documents or deleting a file 
from a folder. 

Escape: (sometimes labelled ‘esc’) the escape key is a shortcut for exiting or ending programs. It is 
often the keyboard version of pressing an exit, no, quit or cancel button. It is also used as a keyboard 
shortcut for the stop button in many html browsers. 

There are also twelve function keys across the top of a standard keyboard, which allow the user to 
perform shortcuts to functions (these are shown in orange in Figure 45). An example of this in 
windows is the F1 button which typically calls up the help system for the current application. 

A number of more accessible keyboard options are available, including large text, large keys, high 
contrast, colour coded keyboards and simplified keyboards. 

2.2.2.2 Assistive keyboard approaches 
In Windows XP there are a number of software tweaks which can make the keyboard more 
accessible for particular users. They can be turned on and off using the ‘accessibility wizard’ available 
from ‘start menu/All Programs/Accessories/Accessibility’ in Windows XP . 

In Windows 7, the controls for these tweaks are found in the ‘Ease of Access Centre’ which is located 
under ‘start menu/All Programs/accessories/Ease of Access/Make the keyboard easier to use’ or by 
pressing the Windows Key + U together and then selecting ‘Make the keyboard easier to use’.   

 Press keys in combinations one at a time - helps with the use of shift, ctrl alt and windows 
keys. 

 Ignore repeated keystrokes – prevent you accidentally pressing a key too many times. 

 Play sound on pressing caps lock, number lock, or scroll lock – prevents accidental pressing of 
the lock keys 

 Extra keyboard help – displays extra keyboard help whenever it is available, useful to non-
mouse users. 

 Use numeric keyboard instead of a mouse – allows the numeric keyboard to double up as a 
mouse 
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 On-screen keyboard – there is an on-screen keyboard available for use where physical 
disability prevents the use of a physical keyboard. A capture of the on-screen keyboard is 
shown in Figure 46. In Windows 7 the On-Screen Keyboard is available through the ‘Ease of 
Access Centre’ . This can be accessed by pressing the Windows Key + U together. Then select 
‘Start On-Screen Keyboard’. In Windows XP, the On-Screen Keyboard can be turned on from 
‘start menu/All Programs/Accessories/Accessibility/On-Screen Keyboard’. A useful shortcut 
in Windows XP is also Windows Key + U which brings up the Utility Manager with controls for 
the On-Screen Keyboard, Narrator and Magnifier. There is also a setting in the Utility 
Manager to run these at start up. 

 

Figure 46 : A screen capture of the Windows XP on-screen keyboard 

Scanning Keyboards - A scanning on-screen keyboard can be used with a switch controller to allow 
users with limited physical ability to be able to type accurately into a keyboard. Scanning keyboards 
such as the ‘Tecla’ scanning keyboard, operate by means of iterative scanning of the keys. First the 
keyboard scans down highlighting each row at a predetermined interval (approximately 1s). The user 
hits the switch when the row containing the character they want is highlighted. The software then 
scans along the row highlighting each key in turn. The user hits the switch to trigger the key they 
want. Tecla is available for both PC and android devices. 

Predictive Text – Predictive text was commonly used on old style mobile phones (with a number pad 
only) in order to speed up the ability to type alphabet characters. It uses a built in library of words to 
predict which words are possible from pressing each of the letter keys only once. When there is more 
than one possible word formable, it offers a list which the user can scroll through to get the word 
they desire. So for example the 6 key has MNO and the 3 key has DEF, so the combination 6,3 could 
be ‘me’ or ‘of’. In most instances the number code forms the unique word that the user wanted to 
type without the need for a list. This style of input can allow for larger buttons providing similar 
typing speeds to full keyboards. In a similar vein, in Microsoft Word and on modern mobile phones, 
the auto-proof function can spot badly spelt words and make suggestions for correction, limiting the 
number of keystrokes required and the need for accurate typing. 

Speech Recognition – From the release of Windows Vista, speech recognition has been built into 
Windows and allows a user to control the machine, and to type using voice (speech-to-text or STT) 
and voice commands. Some of the more recent smart phones have similar tools inbuilt to allow voice 
commands and dictation or quick internet searching by means of voice. Speech recognition obviously 
requires a microphone, and can be found from ‘start menu/Control Panel/Ease of Access/Speech 
Recognition’ in Windows 7. It is not available by default with into Windows XP.  

2.2.2.3 Keyboard shortcuts 
In Windows there are a many shortcuts that can be used. Some are operational and used for 
manipulating windows or accessing programs and tools. Some are general and perform a similar task 
in windows and inside applications (like Microsoft Word or LibreOffice’s Writer). Some are specific to 
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a particular software package. Here we list the most frequently used shortcuts. For a complete list 
please refer to Appendix A. 

Most Common Keyboard shortcuts for use with Windows: 

 F1: opens the ‘Help’ for windows – or the application you are currently using. 

 CTRL + ALT + DELETE: Bring up log off /task manager options 

 ALT + TAB: Switch between open programs 

 ALT + F4: Quit the program you are using 

 SHIFT + DELETE: permanently delete and item (bypassing the recycle bin) 

 WINDOWS KEY: brings up start menu (NB for this you can also use CTRL + ESC) 

 WINDOWS KEY + L: Lock the computer 

 F10: Activates menu bar options (gives good access to menu commands from the keyboard) 

 SHIFT + F10: Opens a shortcut menu on the selected item (similar to a right click of the 
mouse) 

 CTRL + SHIFT + ESCAPE: opens windows task manager 

 ALT + : Open a dropdown list 

 SHIFT: Hold down shift whilst inserting a CD bypasses the Autorun feature. 

 ALT + SPACE BAR: Displays menu allowing window manipulations (restore, minimise, 
maximise, close, move or resize the window) 

 CTRL + TAB: Move between tabs in a Multiple Document Interface program (e.g. between 
open tabs of an internet browser) 

 ALT + F6: Switch between multiple windows running in the same program. 

 CTRL + S: Save 

Most Common Program shortcuts in Windows: 

 CTRL + A: Select All 

 CRTL + C: Copy 

 CTRL + X: Cut 

 CTRL + V: Paste 

 CTRL + Z: Undo 

 CTRL + Y: Redo 

 CTRL + B: Bold toggle 
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 CTRL + P: Print 

 CTRL + I: Italics toggle 

 CTRL + U: Underline toggle 

 ALT + ‘an underlined letter from a program menu’: Opens that menu 

 CTRL + F: brings up the find window 

Most Common Folder and Explorer shortcuts: 

 F2: Rename object 

 F3: Brings up Windows Search  

 ALT + ENTER: Show properties window 

Most Common Internet Browser Shortcuts 

 F5: refresh current page (also CTRL + R) 

 TAB: cycles down from the URL bar to each link, dropdown or text input box on a web page. 

 SHIFT +TAB: cycles back up the links, dropdowns and text input boxes 

 CTRL + TAB: switches between open tabs 

 CTRL + +: Zooms in 

 CTRL + -: Zooms out 

 CTRL + N: opens a new window 

 CTRL + T: Opens a new tab 

 ENTER: Selects the current link or dropdown or enters text inputted 

 CTRL + W: closes the current tab 

 CTRL + U: View Source code 

 CTRL + P: Print 

 CTRL + D: Add a bookmark 

 CTRL + H: Show search history 

 CTRL + J: Show downloads 

Most Common Accessibility Shortcuts: 

 SHIFT (press 5 times): Toggle Stickykeys 

 Right SHIFT + : Toggle FilterKeys 
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 NumLock (Hold for 5 seconds): Toggles ToggleKeys 

 Left ALT + Left SHIFT + NumLock: Toggles MouseKeys 

 Left ALT + Left SHIFT + PrintScreen: Toggles high contrast  

Most Common shortcuts using the special Windows keys: 

 Windows Key + R: Run dialogue box 

 Windows Key + M: Minimise all 

 SHIFT + Windows Key +M: un-minimise all 

 Windows Key + E: Open Windows Explorer 

 Windows Key + F: Find files or folders 

 Windows Key + D: Minimise windows to show the desktop 

 Windows Key +TAB: Cycle through taskbar buttons 

 Windows Key + U: Open the ‘Ease of Access Centre’ 

 Application Key: shows a shortcut menu for the selected item 

In Appendix A you will find a complete list of the shortcut key combinations available in Windows. 

2.2.3 Touchscreens 
Some PCs and in particular mobile devices such as smartphones and tablet computers, and all-in-one 
computers come equipped with a touchscreen. A touchscreen can detect the presence and location 
of a touch on its display. This allows direct interaction with the display without a requirement for an 
intermediate mouse or track ball type device. 

In use, a touch screen works similarly to a mouse. The mapping of touchscreen to mouse is usually 
set to these standard options, although this is often configurable in software: 

 Touch the screen = Left Mouse Click 

 Touch the screen twice quickly = Double Left Click 

 Touch the screen and hold = Right Mouse Click 

 Touch and drag finger on screen = Click and Drag 

 Touch and flick up/down/left/right = Scroll Page Up/Down/Left/Right (a flick is a short drag in 
that direction followed by a release) 

Some touchscreens are capable of registering multiple touches simultaneously. This opens further 
options for interaction. On multi-touch devices there are further possibilities, including: 

 Touch with finger and thumb and bring them together (pinch)= Zoom Out 

 Touch with finger and thumb and drag them apart (spread)= Zoom In 

 Touch with one finger then a second = Right Click 
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Figure 47 : Diagrams showing the modes of interaction with a touchscreen (Original works by Rachel Glaves. Converted 
to Pencil by Frédéric Vandaele. URL: http://evoluspencil.googlecode.com/files/touchscreen.zip) 

2.3 Output Devices 

2.3.1 Display settings 

2.3.1.1 Screen resolution 
The screen resolution represents the number of separate pixels that can be displayed in each 

dimension. It is generally represented as two numbers, width x height (e.g. 640 x 480). If items on 

your screen appear too small, one simple way of increasing the size is to decrease the screen 

resolution. 

In Windows XP to access the screen resolution settings, a right mouse click on the desktop 

background brings up a menu. Select ‘Properties’ from the menu, and then select the settings tab. 

This will bring up the dialogue shown on the left in Figure 48. (Note the shown dialogue is for a two 

screen system. If your setup has multiple screens you can click on the blue screens numbered 1 and 2 

and edit their resolutions separately). Under this there is a slider bar for ‘Screen Resolution’ with a 

number of possible options. The available options will vary and be dependent on the graphic 

capabilities of your computer, but it is usually possible to drop the resolution, thus increasing the size 

objects appear on your screen. 

In Windows 7 right click the desktop background and select ‘Screen Resolution’. This will bring up the 

dialogue shown on the right in Figure 48. On this dialogue there is a dropdown slider bar for ‘Screen 

Resolution’ with a number of possible options. The available options will again vary and be 
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dependent on the graphic capabilities of your computer, but it is usually possible to decrease the 

resolution, thus increasing the size objects appear on your screen.  

  

Figure 48 : The 'Display Properties' dialogue in Windows XP (left) and Windows 7 (right) 

2.3.1.2 Display optimisation 
The software controlling the graphics on your computer should also allow adjustment of brightness 
and colour. Depending on what graphics hardware your machine uses, the ways to access the 
settings will vary. A typical NVIDIA control panel running on Windows XP is shown in Figure 49, and 
as can be seen there are sliders to adjust brightness, contrast, digital vibrancy, gamma and image 
sharpening. This control panel can be selected from the Advanced tab in the ‘Display Properties’ 
window. This is where you should find specific driver software for your specific graphics card if 
available (there may also be a direct shortcut to it from the dropdown list found by right clicking on 
the desktop background). 
 

 
Figure 49 : the NVIDIA control panel 

Windows 7 provides a ‘calibrate colour’ routine which allows a step by step adjustment to get your 

colour brightness, contrast, gamma etc set up to be optimised for your preferences. To access this 

right click the desktop background, select ‘Personalize’ and then ‘Calibrate color’. You will then need 

to follow the on-screen instructions. 
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2.3.2 Monitor settings 

Most modern monitors allow adjustments to be made to the brightness, contrast and colour using 
the monitor’s menu. The means of adjusting these is individual to each monitor make and model, 
and so describing access to these menus here can only be generalised. An example of the button set 
on an HP monitor is shown in Figure 50, and an example capture of the menu that it brings up is 
shown in Figure 51. 

There is usually a menu button, a pair of + and – buttons, and an OK button. The menu button should 
bring up the menu. The plus and minus buttons should allow you then to scroll through the options, 
and the ok button should allow you to access menu items. Sub menus are then navigated in the same 
method until the desired settings have been achieved. If no buttons are pressed on the monitor for a 
predescribed time period (often around 30 seconds), the on-screen menu will close. 

 
Figure 50 : An example of the buttons that may be found on a monitor 

 

Figure 51 : An example of the menu of options that may be available from the monitor settings menu 

2.3.3 Software display settings 
Windows settings: 

In windows you can alter the appearance of the pages you view. It is possible to increase the size of 

text in title bars, dropdowns and menus across your Windows programs. This is done in Windows XP 

from the ‘Display Properties’ ‘Appearance’ tab. To access this, right click on the desktop background 

and then select the appearance tab.  There is a dropdown here which has the options ‘normal’, 

‘Large Fonts’ and ‘Extra Large Fonts’ as shown in the left hand capture in Figure 52. In Windows 7 this 

setting can be accessed by selecting ‘Control Panel’ from the Start Menu and then selecting ‘Display’. 

You will be presented with radio buttons for smaller, medium or larger text as shown in the right 

hand capture in Figure 52.   
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Figure 52 : The display properties appearance box in Windows XP (left)  showing the font size dropdown, and the Display 
control panel item in Windows 7 (right) showing the text size radio buttons 

Application specific settings: 

Some applications allow you to switch settings to within them to make the page clearer by zooming 

either the window (text and graphics are enlarged) or the text size (text only is enlarged).  

 Window Zoom 
Within the View menu of many applications you will find the zoom level. Increasing the zoom 

percentage will make the text and images larger, decreasing the zoom percentage will make the text 

and images smaller. Within a web browser window, you can use the view or settings menu or by 

using CTRL + + will zoom in, and CTRL + - will zoom out. 

Internet Explorer provides these settings under the Page/Zoom menu  

Google Chrome provides these settings under the spanner (customise and control) menu 

Mozilla Firefox provides these controls under the View/Zoom menu. 

 Font Size 
It is also possible in some browsers to zoom the text without zooming other content.  

Internet explorer provides these setting under the Page/Text Size menu. 

Google Chrome Provides these settings under the spanner (customise and control)/Options/Under 
The Bonnet/Web Content/Font Size option. 

Mozilla Firefox provides these controls under View/Zoom/Zoom Text Only. This is a toggle which 
switches the normal zoom control to zoom text only when checked. 

2.3.4 Sound settings 

Adjustment of volume/mute from software 
 
To adjust the volume using the software, you can access the control from the task bar. The volume is 
controlled by selecting the speaker icon (as shown in Figure 53). Clicking on the icon opens a volume 
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scroll bar which can be slid up and down with the mouse or up/down keyboard arrows. There is also 
a mute button on this control which when clicked will mute all sounds from the computer and show 
the volume muted icon (also shown in Figure 53). Clicking the button again will unmute the sound. 
When the sound is muted, the speakers icon on the task bar itself will also show as the volume 
muted icon. 

 

 
Figure 53 : Adjustment of the sound volume from using Windows 7 

Some applications have volume controls built in on top of the overriding Windows volume level. 

Media players often have a built in volume control within the media window. These are often 

represented in a very similar way to the standard windows controls. 

Adjustment of the volume using hardware 

Hardware adjustments of the volume are usually made by means of dials and buttons on the 

speakers themselves. The speakers will often have a volume dial and a power switch allowing control 

of the volume directly from the sound source. If the volume is up on the speakers and you are 

experiencing a loss of sound, it is worth checking that the sound is not muted or turned very low in 

the software (see Figure 53).  

2.3.5 Introduction to assistive output 

technologies 
Both Windows 7 and Windows XP have some accessibility features.  

To access the ‘Ease of Access Center’ in Windows 7 go to ‘start menu/Accessories/Accessibility/Ease 

of Access Centre’, or by pressing the Windows Key + U. This will bring up the dialogue shown in 

Figure 54. The dialogue is accompanied by audio narration of its content. Its main options are to start 

the Magnifier, Narrator and High Contrast functions. 

To access the ‘Utility Manger’ in Windows XP, press the Windows Key + U (This brings up the 

dialogue boxes shown in Figure 55). This allows access to the Narrator, Magnifier and On-screen 

Keyboard functionality. Use ‘Start/Control Panel/Accessibility Options’ to access further accessibility 

aids, such as Keyboard settings, sound settings, high contrast mode, mouse settings etc. (as seen in 

Figure 56) There is also an Accessibility Wizard which allows you to configure Windows XP to suit 
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your needs. Find this under ‘Start/Control Panel/Accessibility Options/Configure Windows to work 

with your vision, hearing and mobility needs’. 

 

Figure 54 : The 'Ease of Access Centre' window in Windows 7 
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Figure 55 : The Utility Manager brought up by Windows Key + U in Windows XP 

 

Figure 56 : Accessibility options accessed on a Windows XP machine 

The Screen Magnifier 

The Screen Magnifier when opened places a strip at the top of the screen where a larger version of 

part of the screen (initially following the mouse pointer) is displayed. An example of this is given in 

the photograph in Figure 57. The strip can be resized by dragging its lower edge. In Windows  7, if the 

magnifier strip is dragged with the mouse it becomes a free floating magnifier box which magnifies 

what it is dragged over. In Windows XP the box can be moved and resized, but does not magnify 

whilst being dragged. 

If the settings button is clicked the way the magnifier behaves can be altered. It can be made to 

follow the mouse pointer, the keyboard focus, or the text insertion point.  It also has a colour 

inversion option. The magnifier options have similar functionality in both Windows XP and Windows 

7. 
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Figure 57 : A screen magnifier in use – showing the magnifier strip at the top of the display 

Microsoft Narrator 

The Narrator – also started from the ease of access menu – will read aloud the screen contents in 

focus, and also voice the inputs used from the keyboard. It is in essence a screen reader but with 

fairly limited functionality. Though much less sophisticated than a full on screen reader program, it is 

available by default on all Windows machines allowing a quick and easy screen reading option when 

specialised and often expensive software is unavailable. 

High Contrast 

High contrast settings are available from the Ease of Access Centre, and can be set up to a user’s 

personal preference using the ‘Personalization’ window.  The theme can then be turned on and off 

with the shortcut ‘Left ALT + Left Shift + PrintScreen’ or using the check box in the Ease of Access 

Centre.  There is a selection of high contrast themes available in Windows 7 with variations of white 

on black, black on white and with different colour variations. There are also options to change the 

desktop icons, mouse pointers and task bar settings available from the Personalisation window. 

Text-to-speech programs 

Although not provided by default with a Windows installation, there are many bespoke text-to-

speech (or TTS) applications available varying from free to expensive with a multitude of voices, 

accents, languages and settings. For a user that relies on audio output such a program may be a 

worthwhile addition. 

For further information on free text to speech software, the following resources may be useful: 

 http://www.naturalreaders.com/index.htm 

 http://www.dyslexia.com/helpread.htm 

Screen readers 

Again, although not provided in a Windows installation by default, it is worth mentioning in this 

course that additional Screen Reader software is available, both commercially and non-commercially. 

Screen readers are even more versatile than Text-to-speech programs providing additional 

functionality through shortcuts to allow different modes of use. They aim to both identify and 

http://www.naturalreaders.com/index.htm
http://www.dyslexia.com/helpread.htm
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interpret what is (or would be displayed) on-screen. The interpretation is imparted on the user via 

text-to-speech. Screen readers can be of use in situations where the user is blind, visually impaired, 

has a learning disability, or cannot read. 

Examples of screen readers shipped with some specific operating systems are:  Microsoft Narrator, 

VoiceOver, EmacSpeak, Yasr,  SpeakUp, Gnome ORCA (Linux environments) and NVDA (Non-Visual 

Desktop Access). There are also commercial packages – which are more widely used – such as JAWS, 

Window-Eyes, Dolphin and ZoomText Magnifier/Reader. 

Refreshable Braille displays 

For Braille readers there is the possibility of using a refreshable Braille display. Although expensive 

and limited to low numbers of Braille cells (18-40) these displays can allow screen reader output to 

be displayed in Braille. 

2.4 Using the Computer 

2.4.1 Desktop Icons 
The desktop will usually contain a number of shortcuts (and example is shown in Figure 58). Double 

clicking these icons with the mouse is the quickest way to open a program or file on your computer. 

The programs you use most regularly should have a shortcut on your desktop, and if they don’t you 

can make one by either dragging an item from your start menu onto the desktop, or by dragging a 

folder or file onto the desktop whilst holding the ‘Alt’ key. 

 
Figure 58 : A capture of a desktop showing a number of shortcut icons which can be used to open programs, files and 
folders. 
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2.4.2 The Task Bar 
The task bar is another fast way of opening a program, or switching between programs, and should 
also present you with a more comprehensive list of the programs available on your PC. The task bar is 
most often found at the bottom of the screen, although it can be repositioned at the sides or top. 
Some computers are set so that the task bar is visible all the time, but on others you must reveal it by 
either: 

 Pressing the Windows key on the keyboard 

 Dragging the mouse to the bottom of the screen (or the edge of the screen where it has been 
repositioned. 

 

 
Figure 59 : A screen shot of the desktop with the task bar visible 

The task bar gives access to a number of items: 

 The start menu – in Windows 7 click on the windows symbol at the left hand side of the 

menu. In Windows XP click on the word ‘Start’. This menu contains a list of program 

shortcuts as well as shortcuts to access the folder system, control panel, devices and printers 

and help and support. 

 Panels representing programs that are already open. Clicking on the outlook icon for example 

would toggle between showing the open Outlook window and hiding it. In order to bring an 

open program to the foreground of your desktop, simply click its icon on the task bar. 

 The time and date can be found on the right hand side. Clicking on this brings up a calendar 

and clock. 

 A speakers icon – which gives access to the volume control and mute control in order to 

quickly adjust the computer’s sound settings (see Section 2.3.4). 
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 Other shortcuts – there may be other shortcuts pinned to the task bar allowing access to 

controls or programs. These may have been placed there by you, or by the program itself 

during installation. 

 

Figure 60 : A capture of the desktop with the task bar and start menu visible 

2.4.3 The Start Menu 
The Start Menu (shown in Figure 60) provides the main means for starting programs. First bring up 

the task bar and then press start, or simply hit the Windows Key on the keyboard which will 

automatically open the task bar and Start menu. 

Many of the items in the Start menu are simply shortcuts, but some of the items are lists. The prime 

example of a list is the ‘All Programs’ option. You can tell it is a list as it has an arrow by it. Clicking on 

‘All programs’ opens a list of all the programs and program groups available. Some actual programs 

do not show up in the initial list, but in a sub-list. For example to find the calculator program you 

must select ‘All Programs’ and then ‘Accessories’ where you will find the calculator shortcut. 

2.4.4 Windows 
Windows are the containers for the programs you have running on your desktop. You can manipulate 

them so that the ones you want are visible and the ones you do not want to see are hidden or closed. 

To close a window you must click on the ‘x’ icon in the top right hand corner (see the example 

window in Figure 61). Doing this will permanently close the window. If you have unsaved work, you 

will be prompted to save it before the window closes. To maximise the window (which will cause the 

window to fill the screen) click on the square icon next to the x. In a maximised window this icon will 
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then change to a ‘restore down’ icon (two boxes one in front of the other) which when clicked will 

cause the window to return to its previous size. To minimise the window click on the line icon next to 

the restore/maximise icon. Doing this keeps the window available to you, and in order to reopen it 

you click the relevant icon which appears on the task bar. 

 

 
Figure 61 : An example of a window 

To move a window, the user needs to click and drag on the title bar of the window. Windows can 
also be resized by clicking on the borders of the window and dragging. Windows 7 offers some 
special functionality of maximising by dragging a window to the top of the screen, or maximising over 
half of the screen by dragging the window to the left or right of the screen. Many windows will have 
a list of dropdown menus at the top of the page below the title bar. In this case we have File, Edit 
Format, View and Help. Clicking these opens further menu options. 
 
Often the contents of a window are too long or wide  for the available screen area, and in such cases 
a scroll bar often appears on the right hand side and/or bottom of the window (as shown in Figure 
62). In this case the content can be viewed by clicking on and dragging the scroll bars with the 
mouse, or by using the arrow keys on the keyboard. 
 

 
Figure 62 : A window showing scroll bars due to oversized content 

2.4.5 Help 
Computers contain a lot of information to help you use them built into their operating systems. An 

important and useful feature in Windows is the Help system. The operating system itself and most 

programs will have built in help files that allow users to find answers to questions they may have. 
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In order to access the help system, you can press F1 on the keyboard or click ‘help’ from the 

program’s menu system, or there is also the ‘Help and Support’ link in the Start menu. If you press F1 

whilst using a program it will bring up help files for that specific program. If you click first on the 

desktop background it will bring up general Windows help (as shown in Figure 63 for Windows 7 and 

Figure 64 for Windows XP). One of the first links it brings up is that of ‘Learn about Windows Basics’ 

(in Windows 7) and ‘Windows Basics’ in Windows XP. This help section provides a lot of help relating 

to the sorts of topics about which we are learning here, and provides hands on practice and 

experience in using the features of Windows. It may be advisable to have a read through some of the 

material there in order to familiarise yourself further with using a PC. 

When you open the help system there is usually a list of menu options and also a search bar. If you 

type a query into the search bar and press return – or click on the magnifying glass, the help system 

will search for results that will help you. You may also navigate to the correct area of help by double 

clicking the links provided in the help menus. 

   

Figure 63 : The Windows 7 Help menu (left) and the window having clicked 'Learn about Windows Basics' (right) 
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Figure 64 : The Windows XP Help system window 

2.4.6 Files and Folders 
It is important to have some understanding of files and folder structures. Mostly our documents will 

be saved in the Libraries folders available from the Windows Start menu (in Windows 7 they are 

called Documents, Music, Pictures and Videos). Within these folders, we can create sub folders. This 

can be done by right clicking in any open folder and selecting new and then folder.  Clicking twice 

(slowly – not a double click!) on the folder you have created will allow you to rename it. You can then 

move files into the folder by dragging them onto it.  

In Figure 65 the user has created a folder called ‘Folder’ in his documents folder. In this the user has 

created three sub0-folders (called sub-folder1, sub-folder2 and sub-folder3). In sub-folder1 the user 

has saved 3 image files. We can tell they are image files because of the .jpg file type. We can see that 

folders are shown with a yellow folder icon. If the view is changed to medium, large or extra large 

icons (by using the right click menu), we can get a preview of the contents of the folders (shown in 

Figure 66). With this view, the files may also show a preview of what is contained in them. 
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Figure 65 : Some example folders showing a structure where files are saved into a sub-folder 

 

Figure 66 : Folders in the Large icons view give a preview of their contents 

2.4.7 File Types 
Windows can be set up to show what are known as file extensions. These are the (usually 3 or four 

character) suffixes that come after the dot in the file name.  Jpg is the example given in the folders in 

Figure 65, which is an image file. The setting to show file extensions can be found from start 

menu/control panel/folder options/ and in the View tab uncheck the ‘Hide extensions for known file 

types’ box. 

What follows is a non-exhaustive a list of common extensions. 

Text files and documents – these are documents that may be edited in a word processor or notepad 

type application 

 .doc or .docx - Microsoft Word document 
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 .odt – LibreOffice Writer document 

 .txt – plain text file 

 .rtf – rich text file 

 .pdf – Adobe portable document format 

Spreadsheets and databases – these are files created by a spreadsheet or database program such as 

Microsoft Excel or Microsoft Access 

 .xls or .xlsx – Microsoft Excel spreadsheet 

 .ods – LibreOffice Calc spreadsheet 

 .db – database file 

 .mdb – Microsoft database file 

 .csv – commas separate values file 

 .xml – Extensible markup language file 

Web pages – these are internet page files 

 .htm or .html or .xhtml – hypertext markup language 

 .css – cascading style sheet (applies formatting to html documents) 

 .php – hypertext pre-processor file 

 .js – javascript file 

Images and pictures – these are image files, they may be photos, logos, graphs or charts, clip art etc.. 

 .bmp – bitmap (uncompressed) 

 .tga – Targa graphic 

 .jpg – compressed image 

 .gif – graphical interchange format file 

 .tif – tagged image file 

 .eps – encapsulated postscript file (a vector image format) 

Sound and music files – these may be music files, system sounds, audio recordings etc. 

 .mp3 – compressed music file 
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 .wav – uncompressed (lossless) sound file 

 .wma – Windows Media audio format 

Video files – these are video and sound combined, the likes of tv programs, films, and camcorder 

recordings. There are many different formats for this type of file. 

 .mp4 - MPEG-4 multimedia file 

 .mov – Quicktime movie 

 .wmv – Windows Media video file 

 .mpg – standard compressed video file 

 .flv – Flash video file 

 .avi – audio/video interleave file 

Program files – these are executable files which means they are programs that can run on your 

machine. You should be wary of running any files with these extensions if they have come from an 

untrusted source such as email or internet. 

 .bat – DOS Batch file 

 .exe – Windows executable file 

 .com – DOS command file 

 .jar – Java archive file 

System Files – these files are used by your computer and its programs while they are working. You 

should not need manually edit, move or remove these files. 

 .dll – dynamic link library (precompiled code) 

 .drv – device driver 

 .ico – an icon file 

 .sys – a Windows system file 

 .cab – a Windows cabinet file 

Compressed files – these are archive files – often used when backing up work or transferring work 
between machines via stick, email or internet. The files will contain either a single file or lots of files 
compressed into a smaller file, but still containing all the data of the original files. An unzip program 
is required to decompress them and use the files they hold. 

 .zip – a zipped archive 

 .rar – WinRAR compressed archive 
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Slideshow  files – these are files created by a presentation application such as PowerPoint 

 .ppt or .pptx – Microsoft PowerPoint presentation 

 .pps – Microsoft PowerPoint show 

 .odp – LibreOffice Impress presentation 

2.4.8 Moving and Copying Files 
It is important to be able to easily find your files on your computer, and to enable this it is important 

to be able to store your files in a neat and tidy structure. To achieve this it helps us to be able to 

move files around and group them together in folders. There are several ways to achieve moving 

files. 

2.4.8.1 Moving and copying with the mouse 
Moving files and folders with the mouse can be achieved using a process of ‘drag and drop’. Firstly 

the user needs to open the location of the file they want to copy or move. Secondly the user needs to 

open the location they want the file to end up. To move the file to the new location (on the same 

drive) simply select the file by clicking on it, and then drag the file to the new location, and drop it 

there. To move multiple files, select them one at a time whilst holding CTRL (this will allow the user 

to select multiple files). Or to select many files in a list select the top one, hold Shift and then select 

the bottom one (this will select the top and bottom files and all files in between). Once all the files 

are selected, perform a drag and drop on the group. To create a copy of the file in the new folder and 

to leave the original in the original folder, hold CRTL when you drop the files. It should be noted that 

if the desired location is on a separate drive this process will copy the file rather than move it by 

default. To move the file between drives (removing the original) hold Shift when dropping the files. 

 
Figure 67 : dragging and dropping a file (file1.jpg) from its current location to a new desired location 
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2.4.8.2 Moving and copying with ‘cut’, ‘copy’ and 

‘paste’ 
If preferred, moving and copying files can be performed using cut, copy and paste commands (or 

their shortcuts CTRL + X, CTRL + C and CTRL + V respectively. First the files that are required to be 

moved must be selected using the mouse or the keyboard. Next the user presses CTRL + C to copy 

the files or CTRL + X to move the files. The user then selects the location to which the files need to be 

moved. CTRL + V will complete the copy or paste. 

2.4.8.3 Deleting (and undeleting) Files and the 

Recycle Bin 
Files can be deleted from a directory by first selecting, and then pressing either: 

1. Delete key  

2. Right click the mouse on the file and select ‘Delete’ from the menu. 

3. CTRL + D 

All of the above will prompt the user ‘Do you really want to delete the file?’. A Yes reply will move 

the file to the ‘Recycle Bin’. A no reply will cancel the action. To avoid using the recycle bin, a 

combination of SHIFT with 1 or 2 above can be used. This will prompt the user as to whether they 

want to permanently delete the file. A file that has been moved to the recycle bin can be retrieved by 

double clicking the ‘Recycle Bin’ icon from the desktop, right clicking on the file that was deleted and 

selecting ‘Restore’. The item should reappear where it was deleted from.  The recycle bin can be 

emptied to permanently remove files from the machine and to free up disk space. This is done by 

Right clicking on the Recycle Bin and selecting ‘Empty Recycle Bin’ from the menu. This action will 

permanently delete all of the items currently in the recycle bin. 

2.4.8.4 Backing up data 
It is generally a good idea to back up your important data. Computer disks can become damaged 

over time, or by impact or fire, and sometimes data gets corrupted and becomes unreadable. It is 

sensible therefore to make copies of important files (known as backing up files) onto a separate disk, 

external drive (USB hard drive or pen drive) or a network drive (e.g. Dropbox, SkyDrive, etc.) on a 

regular basis. 

Some desktop computers will have multiple disks in them where files can be stored on both to 

ensure protection from a disk failure. A portable drive stored in a different location, or the use of a 

network drive will protect also from local environment hazards such as flooding or fire which could 

destroy all local drives. 
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2.5 Making and Saving a simple Document and a simple 

Spreadsheet 
A word processor is one of the most useful programs on your computer. It enables you to create, 
modify and read all kinds of documents, such as letters, reports, and even courses like this. Before 
PCs became commonplace, most business communication had to be written on typewriters. 
Today, typewriters have largely been replaced by word processing software. Some of the advantages 
of using a word processor: 

- you can correct what you have written or insert extra text;  
- you can move text from one part of the document to another; 
- you can print your document easily using a printer connected to your PC; 
- you can save your document on the computer and re-edit it later; 
- you can read documents written by other people. 

 
Good examples of word processors are MSWord and LibreOffice Writer. Both will be explained in the 
following chapters. 

2.5.1 Making, saving and printing a document in 

MSWord 

2.5.1.1 The Basic Layout 
MSWord can be downloaded at http://office.microsoft.com. 
Note: it is NOT free. 

 
To launch MSWord using a mouse (See Figure 68) 

- Click the Windows logo start button on the task bar to display the Start menu (normally 
located at the bottom left on the PC screen).  

- Click the All Programs submenu.  
- Find Microsoft Office in the list of software programs that will appear and click on it. 
- Then you click on Microsoft Word in the list of software programs that will appear and 

MSWord will start. 
- MSWord will open with a blank document. You will see the flashing cursor at the top left 

corner of the page, ready for you to start typing. 
 

To launch MSWord using the keyboard (See Figure 68) 
- Hit the Windows Key to bring up the program menu 
- Use the up arrow key to scroll to all programs 
- Hit return to select 
- Use the up and down arrow keys to locate Microsoft Office in the list 
- Hit return to select 
- Use the up and down arrow keys to locate Microsoft Word 
- Hit return to run the program 

http://office.microsoft.com/
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Figure 68: Start Menu – Word 2010 

At the top of every program that runs on Windows you'll find the title bar. The title bar tells you the 
name of the program and the name of the current open file, for example Document 1 - Microsoft 
Word. Figure 69shows the names of the different elements. 

 

 
Figure 69: Word 2010 opening screen 

The Quick Access Toolbar is in the top-left side of the window. To begin, click the Customize button 
as shown in Figure 70. 
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Figure 70: Customizing the Quick Access Toolbar in Word 2010 

By default, there are only three quick access icons enabled, save, undo, and redo. You can enable 
other commands from the Customize Quick Access Toolbar menu. Once enabled, you will find their 
icons in the Quick Access Toolbar. Quick Access Toolbar was included in Office 2003 and 2007 as well, 
but plays a bigger role in Office 2010. 
 
Some people find the default position of Quick Access Toolbar to be inconvenient. To move it below 
the Ribbon, click on the down pointing arrow icon at the right of the Quick Access Toolbar, and then 
click Show Below the Ribbon option in the context menu which is just under the More Commands 
option. 

 

 
Figure 71: Quick Access Toolbar below the Ribbon 

The next important set of tools is located in the menu ribbon (shown in Figure 72) and its different 
tabs. Each tab has a list of options that allows you to perform different tasks within the program. To 
activate the different menus, you can either select them by clicking on them using the mouse, or via 
keyboard by pressing the Alt key once. Numbers and letters will appear on each menu tab, and once 
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selected characters will appear to activate different menu element. To scroll from menu to menu and 
down through each menu, you can also use after pressing the ALT key once, the arrow keys 
(left/right to swap menus, and within the menu up/down to highlight menu elements. To leave the 
menu bar, press Esc (a full overview of the keyboard shortcuts is provided in Table 1 to Table 8). 

 

 
Figure 72: Menu ribbon with the different tabs and toolbars - Part of the Page Layout tab in Word 2010 

 
Under the menu bar you'll find the toolbar consisting of the different tabs, each one containing small 
images, known as "icons", symbolising different functions. The toolbar has seven different tabs. They 
are: Home, Insert, Page Layout, References, Mailings, Review, View. We will focus in this course on 
the first 2, Home and Insert. 

 

 Home 
This tab holds the basic word processing tools, like for example, size, font, colour, style, etc. You will 
find that that you use this tab for most tasks , hence it is also the default tab. 

 

 
Figure 73: Home tab Word 2010 

2.5.1.2 An exercise in creating a document 
Writing and deleting text 

- Launch Word.  
- Write your name in the text area field.  
- Use the Backspace key to delete your name one letter at a time. 

Selecting text 

- Highlight it by holding the left mouse button and dragging your mouse over the words. 
- Alternatively, if you double-click a word, that word is selected, and if you triple-click 

anywhere on a line, the whole line will be selected. 

Moving the text cursor 

- Write your name again.  
- Press the left arrow key repeatedly until the cursor is at the start of your name, or use your 

mouse.  
- Move the cursor to the end of your name with the right arrow key, or use your mouse.  
- Move the cursor to the next line by pressing return. Write your address in the next line.  
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- Move the cursor around in the text using the up, down, left, and right arrow keys, or use 
your mouse.  

Typing and correcting text 

- Type a short piece of text.  
- Place the cursor to the right of one of the words and delete it using Backspace.  
- Write another word instead.  
- You can use also the options for Undo (CTRL and Z) and Redo (CTRL and Y) (see further) in 

order to undo or redo changes you have made.  

Choose your font 

- Before you start typing, choose a font that you like. Figure 74shows an example of the list of 
fonts that appear when you select the font bar. 

 

Figure 74: Font bar with displayed options 

- If you decide to change the font after you already typed text, then simply press CTRL and A at 
the same time (all text will be selected), and then proceed to the font bar and select the font 
you want. Once that is done, click once with your mouse in the text to deactivate the 
selection, or press once on one of the arrow keys. 

Using “Undo” – “Redo” buttons 

- Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar 
provides you with access to commands you frequently use. By default Save, Undo, and Redo 
appear on the Quick Access toolbar. You can use Save to save your file, Undo to rollback an 
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action you have taken, and Redo to reapply an action you have rolled back. The undo and 
redo icons are shown in Figure 75. 

 

Figure 75: Undo and Redo buttons 

Adding bullets: 

- You can easily create bulleted lists of items. 
1. Select a list of text to which you want to assign bullets or numbers. You can use any 

of the text selection methods already discussed to select the text. 
2. Click the Bullet Button triangle to display a list of bullets you want to assign to the 

list. You can select any of the bullet styles available by simply clicking on it. 
3. If you want to create a list with numbers then click the Numbering Button triangle 

instead of bullet button to display a list of numbers you want to assign to the list. You 
can select any of the numbering style available by simply clicking on it. 

- Several bulleting and numbering styles are available, as shown In Figure 76and Figure 77 
respectively. 

 
Figure 76: Bullet Button triangle to display a list of bullets to assign to selected list 
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Figure 77: Numbering Button triangle to display a list of numbers to assign to selected list 

- Create a List as You Type ( the result is shown in Figure 78): 
1. Type *, and then either press the SPACEBAR or press TAB key, and then type the rest 

of what you want in the first item of the bulleted list. 
2. When you are done with typing, press Enter to add the next item in the list 

automatically and go to add next item’s text. 
3. Repeat the previous step for each list item. 
4. You can create sub-lists which are called multi-lists. It is simple to create sub-lists, 

just press Tab key or use the increase indent button on the toolbar to put items in 
sub-list. 
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Figure 78: Creating bulleted lists as you type 

- You can create a numbered list as you type. Word will automatically format it according to 
your text. Following are the simple steps to create numbered list as you type. 

1. Type 1, and then either press the SPACEBAR or press TAB key, and then type the rest 
of what you want in the first item of the numbered list. 

2. When you are done with typing, press Enter to add the item in the list automatically 
and go to add next item in the list. 

3. Repeat the previous step for each list item. 
4. You can create sub-lists which are called multi-lists. This is simple to create sub-lists, 

just press Tab key to put items in sub-list. The resulting numbered list will look like 
that in Figure 79. 
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Figure 79: Creating numbered lists as you type 

 Insert 

 
This tab (shown in Figure 80) contains further tools which are mainly for inserting things.  
 

 
Figure 80: Insert tab in the menu ribbon 

Insert image (see icons grouped under Illustrations) 
- Click where you want to insert the picture. 
- On the Insert tab, in the Illustrations group, click Picture. 
- Locate the picture that you want to insert. 
- Double-click the picture that you want to insert. 
- Resize the picture by dragging its borders. 

 
Adding a table (see icon under Tables) 

- Click where you want to insert a table. 
- On the Insert tab, in the Tables group, click Table, and then click Insert Table. 
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- Under Table size, enter the number of columns and rows. 
You can also use the Table menu to insert a table and select the number of rows and columns that 
you want. 
- Click where you want to insert a table. 
- On the Insert tab, in the Tables group, click Table, and then, under Insert Table, drag to select 

the number of rows and columns that you want. 

 
You can use table templates to insert a table that is based on a gallery of preformatted 
tables. Table templates contain sample data to help you visualize what the table will look like 
when you add your data. 

- Click where you want to insert a table.  
- On the Insert tab, in the Tables group, click Table, point to Quick Tables, and then click 

the template that you want. 
- Replace the data in the template with the data that you want. 

 
Draw a table 

You can draw a complex table — for example, one that contains cells of different heights or 
a varying number of columns per row. 

- Click where you want to create the table. 
- On the Insert tab, in the Tables group, click Table, and then click Draw Table. 
- The pointer changes to a pencil (as seen in Figure 81). 
- To define the outer table boundaries, draw a rectangle. Then draw the column lines and row 

lines inside the rectangle.  

 

Figure 81: Overview of Draw table gestures 

- To erase a line or block of lines, under Table Tools, on the Design tab, in the Draw Borders 
group, click Eraser. 

- Click the line that you want to erase.  
- When you have finished drawing the table, click in a cell and start typing or insert a graphic. 

 
Adding a hyperlink 

- Select the text or object that you want to display as the hyperlink. 

- Right-click and then click the Hyperlink icon ( ) on the shortcut menu. The menu in Figure 82 
appears: 
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Figure 82: Insert Hyperlink window 

- Under “Link to”, select where you would like to link to. 
o In the Insert Hyperlink window that opens, you can type in the website URL into the 

address box if the link is to a website. 
o However, you could also link to the following: 

 an existing file on your computer – use the Insert Hyperlink window to navigate 
to it, select it and then click OK. 

 a location in the current document – you can select elements like headings and 
sub headings to link to. 

 a new document – you need to specify the name of the document and either 
accept the current path to it or type in a new one. You can also either edit the 
new document right now, or edit it later. 

 an email address 

Each of the above options can be used by clicking on its corresponding button on the 
left of the Insert Hyperlink window. 

- When you’ve specified the destination of the link and clicked OK, the link displays in blue with 
an underline, by default. 

- The second method of inserting a link is MSWord’s automatic link recognition: just type out the 
URL of the website. As soon as you press the spacebar or Enter, Word recognises the text as a 
link and displays it in blue with an underline. 

Note:  To customize the ScreenTip that appears when you rest the pointer over the hyperlink, click 
ScreenTip, and then type the text that you want. If you don't specify a tip, Word uses "Current 
document" as the tip for links to headings. For links to bookmarks, Word uses the bookmark name. 

 Saving the document 

Saving a Word 2010 document creates a permanent copy of what you see onscreen, stored as a file 
on the PC’s storage system. That way, you can use the document again. 
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Following steps should be followed: 

- Click the File tab and select the Save As command. 
o The Save As dialogue box appears. You need to use the Save As dialogue box when you 

first create a document and if you want to save a document with a new name or to a 
different location on the disk. 

 

Figure 83: Save As dialogue box 

- Type a name for your document in the File Name text box. 
o Word automatically selects the first line or first several words of your document as a 

filename and puts it in the Save dialogue box. If that’s okay, you can go to the next 
step. Otherwise, type a name in the File Name box. 

- (Optional) Choose a location for your file. 
o Use the tools in the Save As dialogue box to choose a specific folder for your document. 

- Click the Save button. 
o The file is now safely stored in the PC’s storage system. If your file has been successfully 

saved, the name you have given it (the filename) will now appear on the document’s 
title bar, near the top of the screen. 

- After you initially save your document by using the Save As dialogue box, you can use the Save 
command to update your document, overwriting the old one with the latest version. 

 Closing the document 
 
If you want to close the document after it is saved, click on the icon “X” at the top right corner of the 
screen as shown in Figure 84 
 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

 
Figure 84 : Closing the document 

 (Re-)opening a recent document 
Click the File tab. The dialogue box contains a list of documents previously saved to disk under the 
heading Recent Documents, as in Figure 85. You can select the one you want to open. 
 

 
Figure 85: File tab functionalities - Recent Documents 

In case you want to look for the file yourself on the PC’s hard disk, click the Open button in the File 
tab and you are provided with a screen where you can browse to your file to open it. 
 

 
Figure 86: Dialogue screen to open a file 

 Printing the document 
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- Open a document and ensure that it contains some text.  
- Verify that your printer is ready for the job. 

o Make sure that the printer is connected, turned on, and ready to print. 
- Click the Save button on the Quick Access toolbar. 

o Saving before you print is always a good idea. 
- Click the File tab and select the Print command. 

o Alternatively, you can use the keyboard shortcut Ctrl+P. You see the document 
previewed in the File tab window. That is the Print Settings window, as seen in Figure 
87. 

 

Figure 87: Print Settings window 

- To print one copy of the whole document, click the Print button. 
o The File tab window closes and the document will emerge from your printer. 

Depending on your printer, printing may take a while. Fortunately, you can continue 
working while the document prints. 

- To print a certain page, position the cursor on that page in the document, click the button 
beneath the Settings heading, and choose Current Page from the menu. 

o The single page prints with all the formatting you applied. 
- To print a selection of pages, choose the command Print Custom Range from the Settings 

button menu, then enter the pages you want to print in the Pages text box. 
o For example, to print pages 3 through 5, type 3-5. To print pages 2 and 6, type 2,6. 

- To print a block of text, mark the block of text you want to print in your document and choose 
Print Selection from the Settings button menu. 

o The Print Selection item is available only when a block is selected in your document. 
- To print more than one copy, enter the number of copies in the Copies text box. 

o For three copies, for example, click in the text box and type 3. 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

- Click the Print button. 
o The File tab window closes and the document will emerge from your printer. Printing 

may take a while, but again, you can continue working while the document prints. 
- If nothing prints, don’t use the Print command again! There’s probably nothing wrong; the 

computer is still processing or sending information to the printer. If you don’t see an error 
message, everything you sent should print given time. 

2.5.1.3 Using keyboard shortcuts 
For keyboard shortcuts in which you press two or more keys at the same time, the keys to press are 
separated by a plus sign (+) in Microsoft Word 2010 Help. For keyboard shortcuts in which you press 
one key immediately followed by another key, the keys to press are separated by a comma (,). 
 
Navigating the Ribbon 
Access keys let you quickly use a command by pressing a few keys, regardless of where you are in the 
program. Every command in Word 2010 can be accessed by using an access key. You can get to most 
commands by using two to five keystrokes. To use an access key: 

 Press ALT. 

 The KeyTips are displayed over each feature that is available in the current view. 

 Press the letter shown in the KeyTip over the feature that you want to use. 

 Depending on which letter you press, you may be shown additional KeyTips. For example, if 
the Home tab is active and you press N, the Insert tab is displayed, along with the KeyTips for 
the groups on that tab. 

 Continue pressing letters until you press the letter of the command or control that you want 
to use. In some cases, you must first press the letter of the group that contains the 
command. 

 To cancel the action that you are taking and hide the KeyTips, press ALT again. 
 
Shortcuts 
What follows is an overview of the most common shortcuts that exist in Word 2010: 
Table 1: Common tasks in Microsoft Word - shortcuts 

Common Tasks In Microsoft Word 

To Do This Press 

Create a nonbreaking space. CTRL+SHIFT+SPACEBAR 

Create a nonbreaking hyphen. CTRL+SHIFT+HYPHEN 

Make letters bold. CTRL+B 

Make letters italic. CTRL+I 

Make letters underline. CTRL+U 

Decrease font size one value. CTRL+SHIFT+< 

Increase font size one value. CTRL+SHIFT+> 

Decrease font size 1 point. CTRL+[ 

Increase font size 1 point. CTRL+] 

Remove paragraph or character formatting. CTRL+SPACEBAR 

Copy the selected text or object. CTRL+C 

Cut the selected text or object. CTRL+X 

Paste text or an object. CTRL+V 

Paste special CTRL+ALT+V 
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Common Tasks In Microsoft Word 

To Do This Press 

Paste formatting only CTRL+SHIFT+V 

Undo the last action. CTRL+Z 

Redo the last action. CTRL+Y 

Open the Word Count dialogue box. CTRL+SHIFT+G 

 
Table 2: : Create, View and Save documents in Microsoft Word - shortcuts 

Create, View, And Save Documents 

To Do This Press 

Create a new document. CTRL+N 

Open a document. CTRL+O 

Close a document. CTRL+W 

Split the document window. ALT+CTRL+S 

Remove the document window split. ALT+SHIFT+C or ALT+CTRL+S 

Save a document. CTRL+S 

 
Table 3: Find, Replace and Browse through text in Microsoft Word - shortcuts 

Find, Replace, And Browse Through Text 

To Do This Press 

Open the Navigation task pane (to search document). CTRL+F 

Repeat find (after closing Find and Replace window). ALT+CTRL+Y 

Replace text, specific formatting, and special items. CTRL+H 

Go to a page, bookmark, footnote, table, comment, graphic, or other location. CTRL+G 

Switch between the last four places that you have edited. ALT+CTRL+Z 

Open a list of browse options. Press the arrow keys to select an option, and then press ENTER 
to browse through a document by using the selected option. 

ALT+CTRL+HOME 

Move to the previous browse object (set in browse options). CTRL+PAGE UP 

Move to the next browse object (set in browse options). CTRL+PAGE 
DOWN 

 
Table 4: Switch to another view in Microsoft Word - shortcuts 

Switch To Another View 

To Do This Press 

Switch to Print Layout view. ALT+CTRL+P 

Switch to Outline view. ALT+CTRL+O 

Switch to Draft view. ALT+CTRL+N 

 
Table 5: Print and Preview documents in Microsoft Word - shortcuts 

Print And Preview Documents 

To Do This Press 

Print a document. CTRL+P 

Switch to print preview. ALT+CTRL+I 
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Print And Preview Documents 

To Do This Press 

Move around the preview page when zoomed in. Arrow keys 

Move by one preview page when zoomed out. PAGE UP or PAGE DOWN 

Move to the first preview page when zoomed out. CTRL+HOME 

Move to the last preview page when zoomed out. CTRL+END 

 
Table 6: Delete text and graphics in Microsoft Word - shortcuts 

Delete Text And Graphics 

To Do This Press 

Delete one character to the left. BACKSPACE 

Delete one word to the left. CTRL+BACKSPACE 

Delete one character to the right. DELETE 

Delete one word to the right. CTRL+DELETE 

Cut selected text to the Office Clipboard. CTRL+X 

Undo the last action. CTRL+Z 

Cut to the Spike. CTRL+F3 

 

Table 7: Copy and move text and graphics in Microsoft Word - shortcuts 

Copy And Move Text And Graphics 

To Do This Press 

Open the Office Clipboard Press ALT+H to move to the Home tab, 
and then press F,O. 

Copy selected text or graphics to the Office Clipboard. CTRL+C 

Cut selected text or graphics to the Office Clipboard. CTRL+X 

Paste the most recent addition or pasted item from the Office Clipboard. CTRL+V 

Move text or graphics once. F2 (then move the cursor and press 
ENTER) 

Copy text or graphics once. SHIFT+F2 (then move the cursor and 
press ENTER) 

When text or an object is selected, open the Create New Building 
Block dialogue box. 

ALT+F3 

When the building block — for example, a SmartArt graphic — is selected, 
display the shortcut menu that is associated with it. 

SHIFT+F10 

Cut to the Spike. CTRL+F3 

Paste the Spike contents. CTRL+SHIFT+F3 

Copy the header or footer used in the previous section of the document. ALT+SHIFT+R 

 
To select text and graphics, it suffices to hold down SHIFT and use the arrow keys to move the cursor. 
 
Table 8: Move through your document in Microsoft Word - shortcuts 

Move Through Your Document 

To Move Press 

One character to the left LEFT ARROW 
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Move Through Your Document 

To Move Press 

One character to the right RIGHT ARROW 

One word to the left CTRL+LEFT ARROW 

One word to the right CTRL+RIGHT ARROW 

One paragraph up CTRL+UP ARROW 

One paragraph down CTRL+DOWN ARROW 

One cell to the left (in a table) SHIFT+TAB 

One cell to the right (in a table) TAB 

Up one line UP ARROW 

Down one line DOWN ARROW 

To the end of a line END 

To the beginning of a line HOME 

To the top of the window ALT+CTRL+PAGE UP 

To the end of the window ALT+CTRL+PAGE 
DOWN 

Up one screen (scrolling) PAGE UP 

Down one screen (scrolling) PAGE DOWN 

To the top of the next page CTRL+PAGE DOWN 

To the top of the previous page CTRL+PAGE UP 

To the end of a document CTRL+END 

To the beginning of a document CTRL+HOME 

To a previous revision SHIFT+F5 

After opening a document, to the location you were working in when the document was last 
closed 

SHIFT+F5 

 
A complete overview of all shortcuts can be found at http://office.microsoft.com/en-us/word-
help/keyboard-shortcuts-for-microsoft-word-HP010370109.aspx. 
 
Easy manuals for Word 2010 can also be found via http://www.dummies.com/how-to/computers-
software/ms-office/Word/Word-2010.html. 
 

2.5.2 Making, saving and printing a document in 

LibreOffice Writer 

2.5.2.1 Using LibreOffice Writer 
Writer is the word processor component of LibreOffice. It is quite similar in usage to MSWord, but 
there are some differences, especially in the menu structure. 

This product can be downloaded at http://www.libreoffice.org/download/. 
Note: it is free. 
 
 
 

http://office.microsoft.com/en-us/word-help/keyboard-shortcuts-for-microsoft-word-HP010370109.aspx
http://office.microsoft.com/en-us/word-help/keyboard-shortcuts-for-microsoft-word-HP010370109.aspx
http://www.dummies.com/how-to/computers-software/ms-office/Word/Word-2010.html
http://www.dummies.com/how-to/computers-software/ms-office/Word/Word-2010.html
http://www.libreoffice.org/download/
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1. Adding text and moving the cursor within the text 
 
The same procedure as in MSWord applies for typing and deleting text, or moving around with the 
cursor. 

 
Figure 88: The main Writer workspace in Print Layout view 

For cutting and copying text, you can use the mouse or the keyboard. To move (cut and paste) 
selected text using the mouse (or using SHIFT and ARROW buttons with the keyboard), drag it to the 
new location and release it (or using the keyboard apply CTRL and X to remove it, and subsequently 
CTRL and V to paste it again). 

When you paste text, the result depends on the source of the text and how you paste it. If you click 
on the Paste icon, any formatting the text has (such as bold or italics) is retained. Text pasted from 
Web sites and other sources may also be placed into frames or tables. If you do not like the results, 
click the Undo icon or press Control+Z. If you want the text to be pasted without any formatting, you 
will need to select “paste special” and select then the “unformatted text” option.  

A complete overview of shortcut keys is provided in a separate section. 

Error! Reference source not found.displays the core functionalities of the formatting toolbar. 

 

 

 

1 Open Styles and 
Formatting Window 

5 Align Right 10 Numbering On/Off 

 6 Justified 11 Bullets On/Off 

2 Apply Style 7 Line Spacing: 1 12 Decrease Indent 

3 Align Left 8 Line Spacing: 1.5 13 Increase Indent 

4 Centered 9 Line Spacing: 2 14 Paragraph format dialogue 
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Figure 89 : Formatting toolbar, showing icons for paragraph formatting 
2. Adding  images  

 
Images can be added to a document in several ways by inserting an image file, directly from a 
graphics program or a scanner, or from the LibreOffice Gallery. 

When the image is in a file stored on the computer, you can insert it into a LibreOffice document 
using either of the following methods. 
 

Open a file browser window and locate the image you want to insert. Drag the image into the 
Writer document and drop it where you want it to appear. A faint vertical line marks where 
the image will be dropped. This method embeds (saves a copy of) the image file in the Writer 
document. To link the file instead of embedding it, hold down the Control+Shift keys while 
dragging the image. 

- Another option consists of selecting the Insert option in the menu bar, then select Picture 
and then select From File as in Figure 90. 

 
Figure 90: Screenshot showing selecting the Insert option in the menu bar 

The dialogue dialogue screen in Figure 91 then appears. 
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Figure 91: Insert picture dialogue screen 

3. Adding a table 
For displaying tabular data, you can insert basic tables directly in a number of ways: 

- Choose Insert → Table from the menu bar. 

- Click on the Table button ( ) on the main toolbar. 

 

Each method opens the Insert Table dialogue as seen in Figure 92. 

 

Figure 92: Creating a table with the Insert Table dialogue 

Alternatively, clicking on the black arrow next to the Table button displays a graphic that you can drag 
and select the number of rows and columns for your table as in Figure 93. 
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Figure 93: Creating a table by a graphic dragging and select the number of rows and columns 

With the table selected, the Table toolbar should appear (as shown in Figure 94). If it does not, you 
can access it by selecting View → Toolbars → Table.  

 

Figure 94: Table toolbar 

Having completed the table design, entering data into the cells is similar to working with text box 
objects. Click in the cell you wish to add data to, and begin typing. To move around cells quickly, use 
the following key options: 

- The arrow keys move the cursor to the next table cell if the cell is empty; otherwise they 
move the cursor to the next character in the cell. 

- The Tab key moves to the next cell, skipping over the contents of the cell; Shift+Tab move 
backwards in this manner. 

 
4. Adding a hyperlink 

To add a hyperlink 
- first select the text; 

- Select Insert → Hyperlink (as in Figure 95 ); 

- In the hyperlink dialogue window (see Figure 96), add the URL in the Target field, and select 
Apply and then Close. 
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Figure 95: Inserting a hyperlink. 

 
Figure 96: Hyperlink dialogue window 

5. Saving the document 
To save a document, proceed as following: 

- Select File → Save (or CTRL+ S) (as in Figure 97) 

- In the save dialogue (Figure 98), indicate where you want to save the file, as well as write the 
file name in the File name field. 
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Figure 97: Indicated how the save document: File → Save 

 
Figure 98: Save As dialogue screen 

6. Closing the document 
 
To close LibreOffice completely, choose File → Exit. 

If all the documents have been saved, LibreOffice closes immediately. If any documents have been 
modified but not saved, a warning message appears. 

7. Re-opening the saved document 
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You can open an existing document in one of the following ways. 

- Choose File → Open... 

- Click the Open button on the main toolbar. 

- Press Control+O on the keyboard. 

In each case, the Open dialogue appears. Select the file you want, and then click Open. If a document 
is already open in LibreOffice, the second document opens in a new window. 

In the Open dialogue, you can reduce the list of files by selecting the type of file you are looking for. 
For example, if you choose Text documents as the file type, you will only see documents Writer can 
open (including .odt, .doc, .txt); if you choose Spreadsheets, you will see .ods, .xls, and other files 
that Calc opens. 

You can also open an existing document that is in an OpenDocument format by double-clicking on the 
file’s icon on the desktop or in a file manager such as Windows Explorer. 

If you have associated Microsoft Office file formats with LibreOffice, you can also open these files by 
double-clicking on them. 

8. Printing the document 

Click the Print File Directly icon to send the entire document to the default printer defined for 
your computer. 

You can change the action of the Print File Directly icon to send the document to the printer defined 
for the document instead of the default printer for the computer. Go to Tools → Options → 
Load/Save → General and select the Load printer settings with the document option. 

For more control over printing, use the Print dialogue (File → Print or Ctrl+P) as shown in Figure 99. 

 

Figure 99: The Print dialogue window 

On the General tab of the Print dialogue, you can choose: 

- The printer (from the printers available) 
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- Which pages to print, the number of copies to print, and whether to collate multiple copies 
(Range and copies section) 

- Whether to print any comments that are in the document, and where to print the comments 
(see Figure 100). 

 
Figure 100: Option for choosing whether and where to print comments 

Select the Properties button to display a dialogue (Figure 101) where you can choose portrait or 
landscape orientation, which paper tray to use, and the paper size to print on. 

 

Figure 101: Dialogue where you can choose portrait or landscape orientation, which paper tray to use, and the paper size 
to print on 

In addition to printing a full document, you can choose to print individual pages/sheets/slides, ranges 
of pages/sheets/slides, or a selection of a document. 
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Printing an individual page: 

1. Choose File → Print from the menu bar. 

2. On the Print dialogue, select the page to print. 

a. In the Ranges and copies section of the General page, select the Pages option. 

b. Enter the sequence number of the page you want to print. The preview box changes 
to show the selected page. 

c. If you have restarted page numbering within the document, the sequence number is 
not the same as the page number. 

3. Click the Print button. 

Printing a range of pages: 

1. Choose File → Print from the menu bar. 

2. On the Print dialogue, select the range of pages to print. 

a. In the Ranges and copies section of the General page, select the Pages option. 

b. Enter the sequence numbers of the pages to print (for example, 1–4 or 1,3,7,11). 

3. Click the Print button. 

Printing a selection of text: 

1. In the document, select the material (text and graphics) to print. 

2. Choose File → Print from the menu bar. 

3. The Ranges and copies section of the Print dialogue now includes a Selection option and the 
preview box shows the selected material.  

4. Click the Print button. 

2.5.2.2 Using keyboard shortcuts 
Just like with Word 2010, a great deal of the LibreOffice Writer's functionalities can be called up by 
using shortcut keys. The principle remains the same. For example, the Ctrl+O shortcut keys are shown 
next to the Open entry in the File menu. If you want to access this function by using the shortcut 
keys, press and hold down Ctrl and then press the O key. Release both keys after the dialogue 
appears. 

The shortcut keys are almost identical to Word 2010. 

List of General Shortcut Keys 

Shortcut Keys Effect 

Enter key Activates the focused button in a dialogue 

Esc Terminates the action or dialogue. If in LibreOffice Help: goes up one level. 

Spacebar Toggles the focused check box in a dialogue. 

Arrow keys Changes the active control field in an option section of a dialogue. 
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Shortcut Keys Effect 

Tab Advances focus to the next section or element in a dialogue. 

Shift + Tab Moves the focus to the previous section or element in a dialogue. 

Alt+Down Arrow Opens the list of the control field currently selected in a dialogue. These shortcut keys 

apply not only to combo boxes but also to icon buttons with pop-up menus. Close an 

opened list by pressing the Escape key. 

Ctrl+M Removes direct formatting from selected text or objects (as in Format - Clear Direct 

Formatting) 

Ctrl+Tab When positioned at the start of a header, a tab is inserted. 

Enter (if an OLE object is 

selected) 

Activates the selected OLE object. 

Enter (if a drawing object 

or text object is selected) 

Activates text input mode. 

Ctrl+O Opens a document. 

Ctrl+S Saves the current document. 

Ctrl+N Creates a new document. 

Shift+Ctrl+N Opens Templates and Documents dialogue. 

Ctrl+P Prints document. 

Ctrl+Q Exits application. 

Ctrl+X Cuts out the selected elements. 

Ctrl+C Copies the selected items. 
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Shortcut Keys Effect 

Ctrl+V Pastes from the clipboard. 

Ctrl+Alt+Shift+V Pastes unformatted text from the clipboard. The text is pasted using the format that exists 

at the insertion point. 

Ctrl+Shift+V Opens the Paste Special dialogue. 

Ctrl+A Selects all. 

Ctrl+Z Undoes last action. 

Ctrl+Y Redoes last action. 

Ctrl+Shift+Y Repeats last command. 

Ctrl+F Calls the Find & Replace dialogue. 

Ctrl+Shift+F Searches for the last entered search term. 

Ctrl+Shift+J Toggles the view between fullscreen mode and normal mode in Writer or Calc 

Ctrl+Shift+R Redraws the document view. 

Shift+Ctrl+I Enable or disable the selection cursor in read-only text. 

Ctrl+I The Italic attribute is applied to the selected area. If the cursor is positioned in a word, this 

word is also marked in italic. 

Ctrl+B The Bold attribute is applied to the selected area. If the cursor is positioned in a word, this 

word is also put in bold. 

Ctrl+U The Underlined attribute is applied to the selected area. If the cursor is positioned in a 

word, this word is also underlined. 
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A complete overview of all shortcut keys for LibreOffice Writer is available at 
http://help.libreoffice.org/Writer/Shortcut_Keys_for_Writer. 
 

2.5.3 Making, saving and printing a simple spreadsheet 

in MSExcel 

2.5.3.1 An Overview of Excel 
Excel can be downloaded at http://office.microsoft.com. 
Note: it is NOT free. 
 
To start Excel, choose Start→All Programs→Microsoft Office→Microsoft Office Excel (as in Figure 
102). A new, blank workbook appears, ready for you to enter data (as in Figure 103). 

 
Figure 102: Start Menu –Excel 2010 

 

http://help.libreoffice.org/Writer/Shortcut_Keys_for_Writer
http://office.microsoft.com/
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Figure 103: Excel start up screen  

Figure 104 shows the parts of the Excel window and the terms we use to refer to them. The menu 

systems are similar to those experienced previously in Microsoft Word, but the main body of the 

spreadsheet is built up of cells labelled with letters and numbers. 

 

Figure 104: Parts of the Excel 2010 screen 
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2.5.3.2 Using Excel 
1. Adding a data table 

Excel works with documents called spreadsheets. Spreadsheets consist of a number of individual 
sheets, each sheet containing cells arranged in rows and columns. A particular cell is identified by its 
row number and column letter. Cell A1 is highlighted in Figure 105. 
 

 
Figure 105: Cell A1 is selected: row 1, and column A. 

Cells hold the individual elements—text, numbers, formulas, and so on—that make up the data. 
 
Each spreadsheet can have many sheets (see the tabs shown in Figure 106), and each sheet can have 
many individual cells. 
 

 
Figure 106: Spreadsheet with 3 sheets 

Excel displays a blank data form when starting up, which you can fill in. Type the information for the 

first field and press Tab to move to the next field or press on the right arrow. Excel adds the record to 

the table and displays another blank data form. A sheet with entered data is shown by way of an 

example in Figure 107 
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Figure 107: Example of data entered in a worksheet entitled "Income Analysis" 

2. Displaying as a simple chart (Pie or bar) 
Charts are used to display series of numeric data in a graphical format to make it easier to 
understand large quantities of data in a graphical manner. 
To create a chart in Excel, you start by entering the numeric data for the chart on a worksheet. It is 
important that you properly arrange the data from the very start, considering the different chart 
types and especially the one you would like to use. 
 
Column, bar, line, area, surface or radar chart 
You should arrange the data in columns or rows. 
Data in columns: 

COLUMN HEADING 1 COLUMN HEADING 2 

1 2 

3 4 

Data in rows: 

ROW HEADING 1 1 3 

ROW HEADING 2 2 4 
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Pie or doughnut chart with only one series of data 
The data should be arranged in one column or row only. 
One column of data and one column of data labels: 

A 1 

B 2 

C 3 

One row of data and one row of data labels: 

A B C 

1 2 3 

 
Pie chart or doughnut chart that has more than one series of data 
The data should be arranged in more than one column or row. 
More than one column of data: 

A 1 2 

B 3 4 

C 5 6 

More than one row of data: 

A B C 

1 2 3 

4 5 6 

 
XY (scatter) or bubble chart 
The data should be arranged in columns, so that X values are listed in the first column and 
corresponding Y values are listed in adjacent columns. 
Data in columns: 

X Y 

1 2 

4 5 

 
 
 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 
Stock chart 
The data should be arranged in the following order (in rows or columns): high values, low values, and 
closing values. 
For the labels, you should use names or dates. 
Data in columns: 

DATE PRICE 1 PRICE 2 PRICE 3 

01/02/2012 15 13 21 

Finally, to create the specific chart, the only next step to complete is to select the cells that contain 
the data that you want to use for the chart, and then plot that data into a chart by selecting the chart 
type that you want to use from the charts group in the Insert tab (as in Error! Reference source not 
found.) 

 

 
Figure 108: Selecting the chart type that you want to use from the Insert tab, and then go to Charts group 

 

 
Legend: 

1 – Worksheet 
2 – Chart created from worksheet data  

Figure 109: Excel chart example with 2 rows and 2 columns 

Here is also a video tutorial on how to get started with charts in Excel 2010: 
http://youtu.be/c70cjQXWkFI. 
 

1. Saving the document 
You should regularly save your work. When you save an Excel workbook for the first time, you see 
the Save As dialogue box. The appearance and functionality of the Save As dialogue box varies 
depending on whether you are running Excel 2010 on Windows 7 or Vista or on Windows XP. 
 

http://youtu.be/c70cjQXWkFI
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Saving an Excel 2010 workbook on Windows 7 or Vista 
Follow these steps to save your workbook when running Excel 2010 on Windows 7 or Vista: 

- Click the File tab and choose Save. 

o The Save As dialogue box appears (as in Figure 110). 

- Click the Browse Folders button (with the triangle pointing downward) to expand the Save As 
dialogue box if necessary. 

o When you expand the Save As dialogue box, the dialogue box displays the Navigation 
pane, where you can select a folder. 

- In the Navigation pane, select the folder in which you want to save the file. 

o (Optional) If you want to save the workbook file inside a new subfolder within the 
folder currently open in the Save As dialogue box, you can click the New Folder 
button on the toolbar and then type the name of the folder and press Enter. 

- Type a descriptive name for the file in the File Name box. 

- Click the Save button to save the file in the selected folder. 

 
Figure 110: The Save As dialogue box as it appears when running Excel 2010 on Windows 7. 

Saving an Excel 2010 workbook on Windows XP 
Follow these steps to save your workbook when running Excel 2010 on Windows XP: 

- Click the File tab and choose Save. 

o The Save As dialogue box appears. 

- Click the Save In drop-down list button and select the folder in which you want to save the 
file. 

- Type a descriptive name for the file in the File name box. 

- Click the Save button to save the file in the selected folder. 
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2. Closing the document 
To close an Excel sheet: 

- Click on the top right on the 2nd “X” icon (as seen in Figure 111). 

 
Figure 111: Closing excel sheet 

- This will close the current Excel spreadsheet, but won't close down the Excel program itself. 
- To close down Excel program itself, click again on the top right on the top “X” icon as in 

Figure 112. 

 
Figure 112: Close down Excel programme 

 
3. Re-opening the saved document 

When you have an Excel spreadsheet successfully saved in a  in a folder on your PC, you can re-open 
it when you need to use it by the following processes 

- Open Excel and then click on File → Open → Find the Folder where you file exists → Open. 
- If the spreadsheet type is associated with Excel, you can just navigate to the file in Windows 

Explorer and then double click on it. It will open in Excel. 
 

4. Printing the document 
The final result can now be printed. 

- Click the File tab. This takes you to Backstage view. 
- Select Print. The Print pane appears, with the print settings on the left and the Print Preview 

on the right. 
- To Print Active Sheets: 

o Select the worksheets you want to print. To print multiple worksheets, click on the 
first worksheet, hold down the Ctrl key, then click on the other worksheets you want 
to select. 

o Click the File tab. 

o Select Print to access the Print pane. 

o Select Print Active Sheets from the print range drop-down menu as in Figure 113. 
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Figure 113: Selecting the Print Active Sheets command 

o Click the Print button. 

- To Print the Entire Workbook: 
o Click the File tab. 

o Select Print to access the Print pane. 

o Select Print Entire Workbook (Figure 114) from the print range drop-down menu. 

 

Figure 114: Selecting the Print Entire Workbook command 

o Click the Print button. 

- To Print a Selection, or Set the Print Area: 
o Select the cells that you want to print. 

o Click the File tab. 

o Select Print to access the Print pane. 

o Select Print Selection (Figure 115) from the print range drop-down menu. 
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Figure 115: Selecting the Print Selection command 

o You can see what your selection will look like on the page in Print Preview. 

o Click the Print button. 

2.5.3.3 Shortcut Keys for Excel 2010 
In order to access Excel functionalities using the keyboard, following CTRL Combination Shortcut Keys 
exist.  
Table 9: CTRL Combination Shortcut Keys 

CTRL Combination Shortcut Keys 

Key Description 

CTRL+PgUp Switches between worksheet tabs, from left-to-right. 

CTRL+PgDn Switches between worksheet tabs, from right-to-left. 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

CTRL+SHIFT+~ Applies the General number format. 

CTRL+SHIFT+$ Applies the Currency format with two decimal places (negative numbers in parentheses). 

CTRL+SHIFT+% Applies the Percentage format with no decimal places. 

CTRL+SHIFT+^ Applies the Scientific number format with two decimal places. 

CTRL+SHIFT+# Applies the Date format with the day, month, and year. 

CTRL+SHIFT+@ Applies the Time format with the hour and minute, and AM or PM. 

CTRL+SHIFT+! Applies the Number format with two decimal places, thousands separator, and minus sign (-) for 
negative values. 

CTRL+SHIFT+* Selects the current region around the active cell (the data area enclosed by blank rows and 

blank columns). 

In a PivotTable, it selects the entire PivotTable report. 

CTRL+SHIFT+: Enters the current time. 

CTRL+SHIFT+" Copies the value from the cell above the active cell into the cell or the Formula Bar. 

CTRL+SHIFT+Plus 
(+) 

Displays the Insert dialogue box to insert blank cells. 

CTRL+Minus (-) Displays the Delete dialogue box to delete the selected cells. 

CTRL+; Enters the current date. 

CTRL+` Alternates between displaying cell values and displaying formulas in the worksheet. 

CTRL+' Copies a formula from the cell above the active cell into the cell or the Formula Bar. 
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CTRL Combination Shortcut Keys 

Key Description 

CTRL+1 Displays the Format Cells dialogue box. 

CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 Alternates between hiding and displaying objects. 

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A Selects the entire worksheet. 

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second 

time selects the entire worksheet. 

When the insertion point is to the right of a function name in a formula, displays the Function 

Arguments dialogue box. 

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the 

right of a function name in a formula. 

CTRL+B Applies or removes bold formatting. 

CTRL+C Copies the selected cells. 

CTRL+D Uses the Fill Down command to copy the contents and format of the topmost cell of a selected 
range into the cells below. 

CTRL+F Displays the Find and Replace dialogue box, with the Find tab selected. 

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action. 

CTRL+SHIFT+F opens the Format Cells dialogue box with the Font tab selected. 

CTRL+G Displays the Go To dialogue box. 

F5 also displays this dialogue box. 

CTRL+H Displays the Find and Replace dialogue box, with the Replace tab selected. 

CTRL+I Applies or removes italic formatting. 

CTRL+K Displays the Insert Hyperlink dialogue box for new hyperlinks or the Edit Hyperlink dialogue 
box for selected existing hyperlinks. 

CTRL+L Displays the Create Table dialogue box. 

CTRL+N Creates a new, blank workbook. 

CTRL+O Displays the Open dialogue box to open or find a file. 

CTRL+SHIFT+O selects all cells that contain comments. 

CTRL+P Displays the Print tab in Microsoft Office Backstage view. 

CTRL+SHIFT+P opens the Format Cells dialogue box with the Font tab selected. 

CTRL+R Uses the Fill Right command to copy the contents and format of the leftmost cell of a selected 
range into the cells to the right. 

CTRL+S Saves the active file with its current file name, location, and file format. 

CTRL+T Displays the Create Table dialogue box. 

CTRL+U Applies or removes underlining. 

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar. 

CTRL+V Inserts the contents of the Clipboard at the insertion point and replaces any selection. Available 

only after you have cut or copied an object, text, or cell contents. 

CTRL+ALT+V displays the Paste Special dialogue box. Available only after you have cut or 

copied an object, text, or cell contents on a worksheet or in another program. 

CTRL+W Closes the selected workbook window. 
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CTRL Combination Shortcut Keys 

Key Description 

CTRL+X Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z Uses the Undo command to reverse the last command or to delete the last entry that you typed. 

 
A complete overview of keyboard shortcuts in Excel 2010 is available from 
http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-
HP010342494.aspx#BM2. 

2.5.4 Making and saving a simple spreadsheet in 

LibreOffice Calc 

2.5.4.1 Overview of LibreCalc 
LibreOffice Calc can be downloaded at http://www.libreoffice.org/download/. 

Note: it is free. 

Calc is the spreadsheet component of LibreOffice. Calc works similarly to Excel with documents called 
spreadsheets. Spreadsheets consist of a number of individual sheets, each sheet containing cells 
arranged in rows and columns. A particular cell is identified by its row number and column letter. 

Cells hold the individual elements—text, numbers, formulas, and so on—that make up the data to 
display and manipulate. 

Each spreadsheet can have many sheets, and each sheet can have many individual cells. 

 

Figure 116: Parts of the Calc window 

The parts of the LibreCalc window are shown in Figure 116. The window consists broadly of the 

menus at the top, a bar for data entry below that, and the contents of the sheet in the bulk of the 

window. The active (or highlighted) cell (or cells) is (are) marked with a bold outline. 

http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-HP010342494.aspx#BM2
http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-HP010342494.aspx#BM2
http://www.libreoffice.org/download/
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2.5.4.2 Using LibreCalc 
1. Adding a data table 

To move the focus using the mouse, simply move the mouse pointer to the cell where you want the 
focus to be and click the left mouse button.  You can now enter data. By pressing Enter or the down 
arrow, you go to the cell below, or by using the mouse you can click on any other cell. Pressing Tab or 
Shift+Tab moves the focus to the right or to the left, respectively. 

Pressing the arrow keys on the keyboard moves the focus in the direction of the arrows. 

Each sheet in a spreadsheet is independent of the others, though they can be linked with references 
from one sheet to another. 

2. Displaying a simple chart (Pie or bar) 

LibreOffice allows you to present data graphically in a chart, so that you can visually present data. 
- Select the cell range that you want to present in your chart (as in Figure 117).  

 
Figure 117: Selected data cells to appear in the chart, together with selected data graphic. 

- Click the Insert Chart icon on the Standard toolbar. You see a chart preview on your 
spreadsheet while also the Chart Wizard is started (as in Figure 118). 

 
Figure 118: Chart wizard with different steps and options. 

- On the first page of the Chart Wizard you can choose a chart type. 
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- Choose a basic chart type: click any of the entries labelled Column, Bar, Pie, and so on. The 
contents on the right side will change to offer more options depending on the basic chart 
type. Optionally, click any of the options. While you change the settings in the wizard, watch 
the preview in the document to see how the chart will look.  A handy tip is to press Shift+F1 
and point to a control to see an extended help text.  

- Click Next to see the next wizard page, or click the entries on the left side of the wizard to go 
to that page. 

- Click Back to see the previous wizard page. 
- Click Finish on any wizard page to close the wizard and create the chart using the current 

settings, and the cart should finalise similar to the one in Figure 119.  
- Click Cancel to close the wizard without creating a chart. 

 

 
Figure 119: Resulting chart 

To edit a chart: 
- Click a chart to edit the object properties: Size and position on the current page, alignment, 

text wrap, outer borders, and more.  
- Double-click a chart to enter the chart edit mode: Chart data values (for charts with own 

data). Chart type, axes, titles, walls, grid, and more.  
o Double-click a chart element in chart edit mode: 

 Double-click an axis to edit the scale, type, colour, and more. 
 Double-click a data point to select and edit the data series to which the data 

point belongs. With a data series selected, click, then double-click a single 
data point to edit the properties of this data point (for example, a single bar 
in a bar chart). Double-click the legend to select and edit the legend. Click, 
then double-click a symbol in the selected legend to edit the associated data 
series. Double-click any other chart element, or click the element and open 
the Format menu, to edit the properties.  

- Click outside the chart to leave the current edit mode.  
 

3. Saving the document 
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To save the spreadsheet, select File → Save (as in Figure 120), and the Save As dialogue box opens. 
A simple CTRL+S will have the same outcome. You now select the place where you want to store the 
file, give it the appropriate name and file type, and select Save (as in Figure 121). 
 

 

Figure 120: To save the spreadsheet, select File → Save 

 

Figure 121: Save As dialogue box 

4. Closing the document 

To close LibreOffice Calc completely, choose File → Exit. 

If all the documents have been saved, LibreOffice Calc closes immediately. If any documents have 
been modified but not saved, a warning message appears. 

5. Re-opening the saved document 

You open an existing document by: 

- Choosing File → Open... 
- The Open dialogue appears. 
- Select the file you want, and then click Open. 
- If a document is already open in LibreOffice Calc, the second document opens in a new 

window. 
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6. Printing the document 

Printing from LibreOffice Calc is much the same as printing from other programmes but some details 
are different, especially regarding preparation for printing. Print ranges have several uses, including 
printing only a specific part of the data or printing selected rows or columns on every page.  

To print in landscape format, proceed as follows: 

- Go to the sheet to be printed. 
- Choose Format - Page. 

o The command is not visible if the sheet has been opened with write protection on. In 
that case, click the Edit File icon on the Standard bar. 

- Select the Page tab. Select the Landscape paper format and click OK. 
- Choose File - Print. You will see the Print dialogue. 

o Depending on the printer driver and the operating system, it may be necessary to 
click the Properties button and to change your printer to landscape format there. 

- In the Print dialogue (Figure 122)in the General tab page, select the contents to be printed: 
o All sheets - All sheets will be printed. 
o Selected sheets - Only the selected sheets will be printed. All sheets whose names (at 

the bottom on the sheet tabs) are selected will be printed. By pressing Ctrl while 
clicking a sheet name you can change this selection. 

o Selected cells - All selected cells are printed. 

 

Figure 122: Specifying repeating rows 

2.5.4.3 Using keyboard shortcuts in LibreCalc 
Following table provides an overview of the shortcuts allow for navigating in the spreadsheets. 

Shortcut Keys Effect 

Ctrl+Home Moves the cursor to the first cell in the sheet (A1). 

Ctrl+End Moves the cursor to the last cell on the sheet that contains data. 

Home Moves the cursor to the first cell of the current row. 

End Moves the cursor to the last cell of the current row. 

Shift+Home Selects cells from the current cell to the first cell of the current row. 

Shift+End Selects cells from the current cell to the last cell of the current row. 

Shift+Page Up 
Selects cells from the current cell up to one page in the current column or extends the existing 
selection one page up. 

Shift+Page Down 
Selects cells from the current cell down to one page in the current column or extends the 
existing selection one page down. 
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Shortcut Keys Effect 

Ctrl+Left Arrow 
Moves the cursor to the left edge of the current data range. If the column to the left of the cell 
that contains the cursor is empty, the cursor moves to the next column to the left that contains 
data. 

Ctrl+Right Arrow 
Moves the cursor to the right edge of the current data range. If the column to the right of the cell 
that contains the cursor is empty, the cursor moves to the next column to the right that contains 
data. 

Ctrl+Up Arrow 
Moves the cursor to the top edge of the current data range. If the row above the cell that 
contains the cursor is empty, the cursor moves up to the next row that contains data. 

Ctrl+Down Arrow 
Moves the cursor to the bottom edge of the current data range. If the row below the cell that 
contains the cursor is empty, the cursor moves down to the next row that contains data. 

Ctrl+Shift+Arrow 
Selects all cells containing data from the current cell to the end of the continuous range of data 
cells, in the direction of the arrow pressed. If used to select rows and columns together, a 
rectangular cell range is selected. 

Ctrl+Page Up 
Moves one sheet to the left. 
In the page preview: Moves to the previous print page. 

Ctrl+Page Down 

Moves one sheet to the right. 

In the page preview: Moves to the next print page. 

Alt+Page Up Moves one screen to the left. 

Alt+Page Down Moves one screen page to the right. 

Shift+Ctrl+Page Up 
Adds the previous sheet to the current selection of sheets. If all the sheets in a spreadsheet are 
selected, this shortcut key combination only selects the previous sheet. Makes the previous 
sheet the current sheet. 

Shift+Ctrl+Page Down 
Adds the next sheet to the current selection of sheets. If all the sheets in a spreadsheet are 
selected, this shortcut key combination only selects the next sheet. Makes the next sheet the 
current sheet. 

Ctrl+ * 

where (*) is the multiplication sign on the numeric key pad 

Selects the data range that contains the cursor. A range is a contiguous cell range that contains 
data and is bounded by empty row and columns. 

Ctrl+ / 

where (/) is the division sign on the numeric key pad 

Selects the matrix formula range that contains the cursor. 

Ctrl+Plus key Insert cells (as in menu Insert - Cells) 

Ctrl+Minus key Delete cells (as in menu Edit - Delete Cells) 

Enter (in a selected 
range) 

Moves the cursor down one cell in a selected range. To specify the direction that the cursor 
moves, choose Tools - Options - LibreOffice Calc - General. 

Ctrl+ ` (see note below 
this table) 

Displays or hides the formulas instead of the values in all cells. 

 

A complete overview of keyboard shortcuts in Excel 2010 is available from 
http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-
HP010342494.aspx#BM2. 

http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-HP010342494.aspx#BM2
http://office.microsoft.com/en-us/excel-help/keyboard-shortcuts-in-excel-2010-HP010342494.aspx#BM2
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2.6 Web Browsing and Security 
The World Wide Web (WWW, 3W) is the most used and exploited system that provides high 
performance access to a huge amount of documents, which are linked together, through a global 
computer network (the Internet).  In fact it is an unprecedented tool for data collection.  

Computer users can browse through information, publish documents and exchange information.  

The World-Wide Web is designed around two key concepts: hypertext documents and network based 
information retrieval. Hypertext documents are simple documents that contain information, graphics 
and/or videos and sounds and acting as links to other documents. Typically these documents are 
presented to the user with text with highlighted words or images, known as hyperlinks. Many Web 
sites are hyperlinked together allowing users to access materials or services hosted on other sites. 
Users can move between these sites by clicking links, an act that is known as navigating or “surfing” in 
the WWW. Access to WWW is provided by dedicated computer programs called web browsers, which 
can run on PCs, laptops, netbooks and smartphones. 

However, along with its potentials the World Wide Web brings along a number of problems such as 
missing data, unacceptable and incorrect data and security and integrity problems.   

General security issues related to the use of WWW, concern Web readers, namely anyone who uses a 
Web browser and publishers.  

Specifically some of the causes that a Web reader can face are the following that are quoted below:  

 Damage to the system and user information from buggy software, 

 Virus-infected executables 

 Trojan horse programs  

 Embedded macros and downloadable applets (an applet is a small program that is 
downloaded and executed on-the-fly by the browser). 

Users’ browsing activities can be published or sold, hence individuals’ personal information and data 
can be exposed. 

Specifically Web threats could be derived from shortcuts in the software development process, 
shortcomings in popular operating systems or deficiencies in the Internet protocols.  

2.6.1 Web browsing software 
Currently there are many web browsers available for free. We shall present the most widely used and 
explain how to start them (launch the web browser software). 

The most common web browsers and their respective identifiers (icons) are shown in Table 10. 

Table 10: Web browsers and their icons/identifiers 

Name Icon 

Internet Explorer 

 

Google Chrome 
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Name Icon 

Mozilla Firefox 

 

Lynx Text browser (useful for visually 

impaired people) 
 

Opera 

 

Safari 

 

2.6.2 How to start a web browser 
A user can launch a web browser through alternative options such as a) by clicking on its icon on the 
desktop, b) clicking and selecting the Quick Launch icon or c) from the start panel. The three options 
are explained in the following. 

a) Launch from desktop 

To start a browser from the desktop, simply move your cursor over its icon and do a double left click  

 on it. The icons of the mentioned Web browsers, as appearing on the desktop of a device running 
MS Windows operating systems, are shown in Figure 123 to Figure 126. 

i) Internet Explorer  

 

Figure 123: Icon of Internet Explorer on the desktop  

ii) Google Chrome 
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Figure 124: Icon of Google Chrome on the desktop  

iii) Mozilla Firefox 

 

Figure 125: Icon of Mozilla Firefox on the desktop  

iv) Lynx Text browser 

 

Figure 126: Icon of Lynx Text browser on the desktop  

b) Launch the browser from the quick launch bar 

Another way of starting a web browser is from the quick launch bar (Figure 127) placed in the task 
bar (the bar where the time and date are displayed). If the icon of the browser is displayed there you 

can simply move your cursor over its icon and do a single left click   on it:  

 

Figure 127: Web browsers’ icons as appearing on the quick launch bar 

If the icon is not displayed on the taskbar you can add it by right-clicking  on the desktop icon and 
choose “Pin to taskbar” (see Figure 128). 
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Figure 128: The “Pin to Taskbar” option to move an icon on the quick launch bar 

(Tip: This can work with any program that you would like to appear on the taskbar e.g. MS Outlook) 

c) Launch from start panel 

Start the web browser from the start panel click  on the windows logo at the left bottom of the 
screen and type the name of the browser at the “Search programs and files field” as shown below for 
Mozilla Firefox (see Figure 129) 
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Figure 129: Starting a Web browser from the Start panel 

As soon as the desired browser’s name appears on the screen, you have to select it by a single click 

  on its name. 

2.6.3 Using a Web Browser 
This subsection is dedicated to web browsing capabilities of navigating and revisiting web pages. The 

web browser used for the illustration is Internet Explorer 9 as most Windows PCs come with it 

preinstalled. However, the relative information that is mentioned in this section, concerns every 

recent web browser since they all follow a similar design. 

Figure 130, below, shows the browser window with the most important page-sections numbered, in 

order to be able to explain them individually. 
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Figure 130: Identification of the different sections in a page of a Web browser, with numbers and red-line borders 

2.6.3.1 Navigation via URL and domain names 
The most basic step in order to start web browsing (navigating through the pages in the Internet) is 

to decide what page you would like to visit. Once you decide, you must enter its Internet address (in 

section 2 of Error! Reference source not found.) known as the Uniform Resource Locator (URL). A 

URL is made of strings of characters that are necessary to identify the subject address on the 

Internet. For example, the URL of Google is http://www.google.com. Looking more carefully we note 

that it consists of three parts: 

I. The protocol identifier (http), which defines how your browser and the service 

behind the webpage communicate. 

II. A colon and two slashes, and 

III. The domain name www.google.com, which is used to identify the desired webpage. 

The most known types of protocol identifiers are: 

i. Http: The most common, used for simple communication and browsing through the Internet. 

ii. Https: This is the secure version of Http. It is widely used for sensitive data transmissions e.g. 

money transfer, because it encrypts the exchanged information in order to avoid access from 

unauthorised sources. 

iii. Ftp: A URL that begins with ftp:// means that the target website is used to transfer files over 

the Internet. 

http://www.google.com/
http://www.google.com/
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The total number of registered domain names worldwide nearly reached the 220 million at the end 

of the third quarter of 2011, with all of them using a common structure. Every domain name begins 

with the “www.” prefix that indicates that the target webpage is on the World Wide Web. After 

www, the specific name of the domain is entered e.g. Google. In order for a URL to be complete, a 

suffix is needed to indicate the type of the page. Error! Reference source not found., provides a list 

with the most common types: 

Table 11: A list with the most common types of suffixes for URLs. In the above list some suffixes of countries’ specific 
URLs are also provided as examples (http://www.web-l.com/country-codes/). 

Suffix Explanation 

com Commercial Business 

edu Educational Institutions 

org Non profit organizations 

eu European union 

ac Academic 

cy Cyprus 

uk United Kingdom 

be Belgium 

gr Greece 

lt Lithuania 

 

Since an interpretation of the URL has been given (Uniform Resource Locators), the next step is to try 

to enter one in the browser window. An URL is copied or typed into the browser’s address bar, 

section 2 in Figure 130. In order to copy and paste an URL into the address bar you must first find the 

text containing the target website. Then, press and hold the left mouse button   , while dragging 

the cursor over the URL to highlight it. After that, right click   on the highlighted text and select 

copy (see also Figure 131). 
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Figure 131: The Copy option by selecting and right clicking on a URL 

Note: Be sure to select all the necessary information to avoid errors. 

After the previous selection, go to the browser’s address bar (Figure 130, section 2), right click  on 

it and select paste (see also Figure 132). 

 

Figure 132: The Paste option by right clicking in the URL position of a Web browser  

Alternatively, you can type the URL directly in the address bar (Figure 130, section 2). Simply click 

on the address bar and press delete to clear unnecessary information. Then type the target 

website. Please, note that you do not have to type the http:// prefix every time, since browsers are 

smart enough to add it when you type only the domain name e.g. www.google.com. However, you 

have to type the prefix in case of a secure page (https) or a file transfer page (ftp).  

2.6.3.2 Hyperlinks 
Hyperlink or link for short is another alternative for web target navigation. Hyperlinks are texts that 

perform some action when you click or select it and press ENTER. When you come across a link or an 

image that is set as a hyperlink, your cursor will change shape and become a hand pointer .  All you 

have to do is a single left click and you will be redirected to the linked webpage. Moreover, you can 

move through all the links on the page by pressing the TAB key.  
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To create a hyperlink on your web page, type the text that you want to be the link. Highlight over the 

text that you want to make into a hyperlink. In the properties window, type in the url in the link field 

2.6.3.3 Use of back and forward button 
Every time you move to another page the browser gives you the option to go back to the previous 

page you were viewing. To do this, you must click on the arrow pointing left called the back button 

(Figure 130, section 1). If you would like to move back again you can click again until you reach the 

very first page when you opened the browser. When you move back through your already visited 

pages, you can move forward again to the most recent pages. This is done with a single click on the 

arrow pointing right, named the forward button (Figure 130, section 1). 

In some cases, it is advised not to use the back button, for example when conducting an online 

payment, but to use instead the navigation options provided on the webpage itself. 

2.6.3.4 Browsing history 
The back and forward buttons are useful when the pages you want to access were opened at the 

current session of browsing (no closing and re-opening of the browser happened in the meantime). 

For instance, if you would like to revisit a page that you have opened yesterday but you do not 

remember its address, you can use another useful feature called the history list. As the name 

suggests, history is a list with all the pages that you have visited during the last 3 weeks (for Internet 

Explorer 9). To find the history list, click on the command bar (Figure 130, section 9) and choose 

Explorer BarsHistory, as shown in Figure 133.  

 

Figure 133: Illustration of procedure to find the History list, for Internet Explorer 9 

The history list should now appear at the left of the screen as shown in Figure 134. 
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Figure 134: The history list as presented in Internet Explorer 9 

A single click on a list’s option will reveal the websites visited that day and you can visit them again 

without having to remember all the details. The history’s list duration can be configured by the user 

as illustrated bellow: 

i. From the menu bar (Figure 130, section 9) select Tools Internet options 

ii. Then from the pop up screen, locate the section labelled “Browsing history” and select 

Settings as shown in Figure 135. (Note: You can erase the history list by selecting “Delete...” in 

the same section) 

 

 

Figure 135: The Settings button in the Internet Options window, for Internet Explorer 9 
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iii. Finally, from the new pop up screen, configure the “Days to keep pages in history” option 

and select OK, as shown in Figure 136. 

 

Figure 136: The window where you can define the days to keep the pages in history, for Internet Explorer 9 

2.6.3.5 Favourites feature 
The history list is not the only option for the browser to remember the pages you might want to 

revisit. Another feature of modern browsers is the favourites list. This list offers you the option to 

save a web address in order to save time searching for it or typing it. To add a website to this list, first 

click on the Favourites label (or Bookmarks for some browsers) on the menu bar (Error! Reference 

source not found., section 8) and then select the Add to favourites (or bookmark) option. For fast 

access to the saved page, you can choose Add to favourites bar and the link will appear at the 

favourites bar (Error! Reference source not found., section 10).  Alternatively, you can open this 

menu by clicking on the star symbol (Error! Reference source not found., section 6). The whole 

procedure to add a page to the favourites list is called bookmarking a page and the link to the page is 

called a bookmark. 

2.6.3.6 Reload button 
If, for any reason, a website stops loading its content, you can take action to make it reload. This is 

done by clicking the reload button (Figure 130, section 3). In the same way you can prevent a website 

from loading by clicking the stop button (Figure 130, section 4). Instead of moving to the next page, 

some hyperlinks might open the page in a new tabbed window. You can then select the tab by 

clicking its name (Figure 130, section 7) or close it by clicking the x symbol next to it. Usually a 

website does not perfectly fit on the screen but you must scroll vertically to reach content at the 

bottom by using the scroll bar arrows (Figure 130, section 11). Another way of fitting more content 

on the screen or zooming in to a particular area of the screen is with the use of the zoom bar (Figure 

130, section 12). Select a higher percentage number to zoom-in or a lower to zoom-out. 

2.6.4 Performing a search 
The Internet offers unlimited sources of information for all tastes. Like in traditional libraries, in 

digital libraries you have to first perform a search to find the right information and compare deeper 

similarities and differences based on information-seeking goals. For this purpose, many Internet 

search engines have emerged in recent years in order to explore the potential impact of these 

libraries. Search engines are “dedicated Web pages” that accept keywords from the user and search 

the web for relevant information. The most popular search engines are www.google.com from 

Google, http://www.bing.com from Microsoft and www.search.yahoo.com from Yahoo. The use of a 

../../user/Documents/MILISG/My%20Dropbox/Eurocy/Projects/VIPI/Deliverables/WP3-Curriculum&Handbook/ViPi_Carriculum/EuroCy_contribution/www.google.com
http://www.bing.com/
../../user/Documents/MILISG/My%20Dropbox/Eurocy/Projects/VIPI/Deliverables/WP3-Curriculum&Handbook/ViPi_Carriculum/EuroCy_contribution/www.search.yahoo.com
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search engine is very simple. When you decide on the subject for which you want to obtain more 

information, enter the most important words in the textbox. Suppose we would like to find 

information about the subject Internet’s history. First visit the search engine you would like to use, as 

learnt earlier in this course. Then in the page’s search box enter the words Internet and history as 

shown in Figure 137 for Google and in Figure 138 for Bing search engines and then press the enter 

button of your keyboard or do a single left-click on the dedicated Search button of the web browser. 

 

Figure 137: Performing a search for “internet history” in Google search engine 

 

Figure 138: Performing a search for “internet history” in Bing search engine 

As you type, recommendations regarding your search may appear but ignore them if they do not 

satisfy your current search and keep typing. When you press enter or Search, a list with results will 

appear on the screen. Look carefully in every given option in order to find the best that suits your 

search. You should be aware that most search engines put on the top of the list some results that are 

related with your search but they come first because their owners pay for advertisement. These 

advertisements usually appear in different colour background. Moreover, they are marked with the 

word ad, as shown in Figure 139, in order to avoid them (if so wished) and to focus on your search. 
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Figure 139: A page with search results, with a marked first entry as advertisement 

Search engines offer the option to search specifically for images, videos, maps and many other extras 

depending on the specific engine. All you have to do is to select what you would like to search for 

from the list on the left (for Google) or from the list on the top (for Bing). Another way of searching 

the Internet is through the address bar (Figure 130, section 2). Most browsers use google.com or 

bing.com as a default search engine. You only have to type the words in the address bar (as shown in 

Figure 140) without any prefixes just like you would do on a dedicated search page as learnt earlier in 

the course. 

 

Figure 140: Selecting a default search engine for Internet Explorer 9 and performing a search quickly 

Mozilla Firefox offers an additional search box next to the address bars which allows you to change 

the engine used for searching by clicking on the arrow pointing down, as shown in Figure 141. 

 

Figure 141: Selecting a default search engine in Mozilla Firefox 

Search engines provide many options for customized search, using Boolean operators such as: 

implied "AND" (if several concatenated search terms separated by spaces are given, only pages 

containing all of them should be returned), exclusion ("-xx"), alternatives ("xx OR yy") and wildcard 

("x * x"). 
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For example, you may want to search for “(search engine – Google) OR (search software)”. Figure 

142 shows the result of this search if we use the Google search engine. Looking at a specific search 

result, we identify the following parts: 

1. A title of the result which acts as a hyperlink to the actual page of the result 

2. The URL of the result 

3. The day of publication and a couple of sentences extracted from the target page, that contain 

the terms for which we searched 

 

Figure 142: Results of a searching using Google and customized search operators  

2.6.5 Printing a web page 

In order to print a web page directly from internet web browser you must first make sure your 

printer is connected and turned on. Then you only have to choose the Print option from the 

command bar (Figure 130, section 9) and the printing should begin. If the browser does not have a 

shortcut for printing you can do so from the menu bar (Figure 130, section 9). Select FilePrint and 

the menu of your printer should pop up to click on print. Figure 143 shows how to print a page using 

Mozilla Firefox. 

3 

2 
1 
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Figure 143: The Print option of a page in Mozilla Firefox 

2.6.6 Filling a web form 

With the rapid evolution of technology and the Internet, the need to interact with the owner (the 

individual or organization) of the website (Note: A website is a set of web pages linked together 

including videos, images and sounds), emerged. The most basic way to interact is by physically filling-

in information in web forms, e.g. providing  personal information to an organization or a University 

or sellers of goods (to be covered in next courses), etc.. In fact, a lot of organizations have their own 

websites where you can fill-in a form or a request just like the one that you would fill as hard copy at 

their offices. The only difference is that instead of using your pen to fill-in the form, you enter your 

details using the keyboard or any other mean of typing on the computer. Each form might ask for 

different details but the general structure is the same. Next to each detail field (label of the field) 

there is an action box (e.g. a text box) to enter the required detail. An example of a web form is 

shown in Figure 144. 

 

Figure 144: An example of a Web page that shows a form requiring the user to enter data 

You must be aware that fields market with a * are usually treated as mandatory and must be 

completed in order for the form to be valid and the processing to continue. This is usually specifically 

mentioned at some location around the web form. 

Also, some forms require you to enter a text from an image (called captcha and shown in Figure 145) 

as a countermeasure against automated software (called robots) that create fake accounts. In case 

the form provides full accessibility features, you can also select to hear the text on the image to 

enable you to type it. Moreover, in case it is not possible for you to read (or hear) the text properly, 

there is the option to load a new text-image. 
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Figure 145: An example of a captcha that is used to avoid robots filling in the forms on the Web 

When you are done filling the form, usually at the bottom there is an option to submit the form or 

proceed to a next step. 

2.6.7 Downloading a file 

While surfing the Internet you will come across cases where you must download a file from a website 

such as a document or a program’s executable. Usually a hyperlink is used to pop up a window for 

saving the file, as shown in Figure 146.  

 

Figure 146: A link to a file to download from a Web page 

When you click on the link to download the file the browser asks if you want to open the file or if you 

want to save it on the computer, as shown in Figure 147. 

 

Figure 147: An example of a window that prompts you to open or save a file when you select to download it from 
Internet.  

If you choose to open a file, the browser saves it in a temporary folder and deletes it after ending 

your browsing session. As a result, you will need to download it again if you would like to open the 

file another time, which means that you will need an Internet connection.  
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Instead you can choose to save the file on your hard disk (locally on your computer as shown in 

Figure 148) and make it available for offline use.  

 

Figure 148: An example of a window that shows how you can save a file downloaded from the Internet, to your local file 
system 

There is a possibility that your browser is configured to download the files by default to a pre-

specified location on your computer. You can change this location or re-configure this option by 

following these steps in Internet Explorer 9 as shown also in Figure 149: 

i. From the Menu bar (Figure 130, section 9), select Tools View downloads 

ii. From the download pop up screen select Options at the bottom left of the screen. 

 

Figure 149: The window from where you can define the options for downloading files, in Mozilla Firefox 

 

iii. From the new screen select the “Browse” option. 
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Figure 150: The window from where you can define the default download location for Internet files 

 

iv. Then navigate to the preferred location on the computer and click on the “Select Folder 

“option (Figure 150 and Figure 151). 

 

 

Figure 151: Selecting the default destination folder for the Internet downloads (Internet Explorer 9) 

For Mozilla Firefox, select the Firefox logo on the right upper of the screen and then select 
OptionsOptions as shown in Figure 152 : 
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Figure 152: Detecting the options window to perform changes on the default saving location of Internet files 

From the new pop up you can configure the browser to save downloads to a specific folder (Figure 
153, Label no.1 ) or to always ask for the location (Figure 153, Label no.2) as shown in the next 
image. 
 

 

Figure 153: Selecting the default destination folder for the Internet downloads (Mozilla Firefox) 
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If you are using Google Chrome select the “screwdriver“   button and then click on “Options”. 
From the new window select the “Under the Hood” tab and at the section “Downloads” configure 
your settings. The steps are illustrated in Figure 154 below: 
 

 
Figure 154: Selecting the default destination folder for the Internet downloads (Google Chrome) 

2.6.8 Basics for other Web browsers 

In this subsection Mozilla Firefox and Google Chrome Web browsers are introduced as the alternative 

solutions to the Internet Explorer Web browser. All three browsers offer identical features and it is 

up to the user to choose the one to use. In the figure below, the common features of Firefox and 

Chrome are illustrated and marked with the same number. Detailed explanation of each feature can 

be found in the previous subsections of this course. 
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Figure 155: The different sections of a page of other Web browsers, comparing to Figure 130. Mozilla Firefox is on top 
and Google Chrome at the bottom 

Afterwards, in order to get more familiar with the Web browsers a short explanation of each 

numbered feature is given, shown in Figure 155: 

1. Menu bar: Here you can find your bookmarks and history but you can also create a new tab 

or print a page. Specifically, for Google Chrome, to access the menu bar you have to select 

the  button. 
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2. Back and Forward: These buttons as explained earlier, offer navigation through visited web 

pages. 

3. Address Bar: This is the location where you type the web page you would like to visit. The 

reload button  is located in the address bar for Firefox but outside from it for Chrome. 

4. Search box: Firefox offers a dedicated search box for performing a search although you can 

search directly by typing in the address bar. Chrome supports search only by typing in the 

address bar. To learn how to perform a search, check the subsection Performing a search. 

5. Home button: This button will open the page that loads when you launch the browser. It is 

known as the homepage.  

6. Bookmarks toolbar: Bookmarks are the equivalent feature of Favourites in the Internet 

Explorer. The bookmarks toolbar is a shortcut to access saved pages without going through 

the menu. To learn how to manage your favourites check the subsection Using a Web 

BrowserFavourites feature. 

7. Tabs: In order to avoid multiple browsers’ windows for every page that you visit, tabs are 

used to organise open web pages. To visit a new web page in a tab, select the “+” option and 

type the address in the new window. 

8. Web page content: This is the main screen of the browsers. Here the web page that you visit 

will be displayed. 

2.6.9 Social Networking sites 

(More specific information can be found in the dedicated course 2.11.7) 

In the last decade, social networks managed to become a part of many people’s lives and their trend 

spreads extremely fast among people of all ages. Social networks can be used to keep in touch with 

friends, play games and many other things. There are also business related networks that allows 

users to meet new people and find job opportunities. Social networking is the grouping of people 

into specific groups, small communities that function as on line places where people generally 

socialize. Error! Reference source not found. provides a list with some of the most popular networks 

and a short description. 

Table 12: A list of the most popular Social networking services on the Internet 

Network Logo Description 

Facebook 

(http://www.facebook.com) 

 

A social network that allows you to 

add friends, chat live with them, 

track their updates, play games, 

upload photos, videos and interact 

using many other features. This is 

the most used social network to 

date. 

Accessibility information of 

Facebook can be found here: 

www.facebook.com/help/accessibil

http://www.facebook.com/
http://www.facebook.com/help/accessibility
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ity 

Google+ 

(https://plus.google.com/) 

 

It offers similar features like 

Facebook. You can organise your 

friends in lists called circles and 

search for content among your 

contacts. In order to use this social 

network you first need to create an 

account with Google service. 

Netlog 

(http://www.netlog.com/) 

 

A social network specifically 

targeted at the European youth 

demographic. Members are able to 

share videos, music and create their 

own website. Moreover it offers the 

option to show news from user’s 

local area and from members of the 

same age as the user. 

Twitter 

(http://twitter.com/) 

 

This social network offers a unique 

feature that allows a user to send 

and read text-based posts of up to 

140 characters, known as "tweets". 

Other users can subscribe to a 

user’s tweets and “follow” his 

updates. 

LinkedIn 

(http://www.linkedin.com/) 

 

A business related social 

networking site that, among others, 

allows users to search for job 

opportunities and employers to list 

jobs and find candidates.  

YouTube 

 

This web site is used by users to 

upload their videos and to share 

them with other people.  

Tube Majestyc 

http://tube.majestyc.net 
 

Accessible Interface to YouTube 

Easy Chirp 

http://www.easychirp.com  

Accessible interface to Twitter, but 

not developed by the same team. 

   

https://plus.google.com/
http://www.netlog.com/
http://twitter.com/
http://www.linkedin.com/
http://tube.majestyc.net/
http://www.easychirp.com/
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2.6.10 Web security 

Using the World Wide Web is not without any danger. Critical and sensitive information might be 

transferred over the Internet, such as credit card details, personal information, etc. If this 

information is not protected, it would be exposed to anyone who attempts to steal it. As a result, the 

connection between a user and a page, when sensitive information is exchanged, should be 

encrypted and secured.  This encryption is necessary when you are asked to enter personal details, 

for example passwords and credit card numbers, as it ensures that when they will be transferred 

though the Internet no one will understand its content except the correct receiver. 

A safe way to encrypt personal data and information and prove that the user has a valid security 

certificate is concrete URL with the https:// prefix. The website name must use this prefix. If it does, a 

lock symbol will appear in the address bar to indicate that your connection is safe. When you click 

the lock symbol, more encrypted information is revealed (Figure 156). 

 

Figure 156: The popup window that appears after clicking on the lock icon on the address bar of a Web browser 

Some browsers like Mozilla Firefox instead of showing a lock symbol, highlight the left part of the 

address bar as shown in Figure 157. 

 

Figure 157: The popup window that appears after clicking on the highlighted left part of the address bar of Mozilla 
Firefox 
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2.6.11 Safe online search 

When searching for information on the Internet, a user may come across irrelevant but offensive 

content. Fortunately, search engines are aware of this and have taken measures to protect their 

users by introducing the Safe Search option. This option acts like a smart filter that checks the results 

before the users access them and blocks any offensive content from reaching the final set of results. 

Usually this feature is enabled by default but in the following images we illustrate how to 

enable/disable it. 

 

For Google.com (Figure 158) you will need to click on the gear symbol on the top right and select 

“search preferences”. Then depending on how much you want your results to be filtered, move the 

slider to the correct position and click save at the bottom of the page. 

 

 
Figure 158: The place from where you can define the search settings in google.com 

For Bing the process is quite similar (Figure 159): 

 

 
Figure 159: The place from where you can define the search settings in bing.com 

In an effort to protect their citizens from Internet dangers, many countries’ Governments have 

established dedicated Internet Centers to promote the safer use of the Internet. You may find the 

Web site to the respective Center in your country, in Table 18. These Centers, through their Web 

sites provide the means for you to report any Illegal or annoying content that you might come across 

on the Internet simply by clicking on links in from their first page in their Web site and filling in forms.  

In addition, helplines are provided where you can ask for help (through chat, email, phone) about 

problems that you may face while using the Internet.  
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2.6.12 Malicious software and computer viruses 

Another issue a web user should be aware of, are viruses and spyware. A virus is a harmful piece of 

software that usually causes malfunctions of computers, reduction in performance and possible loss 

of user’s data. Spywares are files that software tools or websites can upload on a computer in order 

to track the user’s habits to show him related advertisements or save the keys pressed on the 

keyboard in order to find passwords. All the aforementioned, together with other types of harmful 

files and software tools are called malwares and they act silently thus making it very difficult for a 

user to notice their existence. 

 

One way to protect your computer from those risks is to install an antivirus product (covered in more 

detail in the course in section 3.6). Keeping your operating system up to date is another necessary 

measure. As a user you can act in several ways to reduce the risk of infection. First do not visit 

websites that you are not sure of concerning their reliability. Next, avoid clicking on pop up 

advertisements that might ask you for personal information. Also, never download files from 

websites whose purpose you do not know. Always look for the secure connection symbol before 

entering sensitive information like passwords or credit card details. If the website does not use 

encrypted connection and you are not sure, better not to enter any details to avoid unwanted access 

to them. 

 

For the same reason, you should be careful when you share personal pictures. If you upload pictures 

to a social network or a dedicated picture-hosting site, you can always limit access to them if you do 

not want unknown persons to view them. This will be further discussed in the course in the course 

3.6-Safety and Security, as well.  

 

Since users on the Internet interact with each other without eye contact, it is very easy for someone 

to pretend being someone else. This might happen by email (using a fake email address), but with 

the rise of social networking the number of fake identities increased sharply. When unknowns try to 

contact you by emails or by friend requests you must be sure if you know them before you reply.  

For this reason, you must check their details very carefully in order to find out if they are real. 

Unfortunately, not all Internet users have good intentions or manners. Some of them try to offend 

other users or to upset them. This is like bullying others in real life but it is done through the Internet 

thus called cyber bullying. One way to reduce the chance of being a victim of those people is to avoid 

opening emails and messages from unknowns. 

 

Last but not least, you must be careful when you copy information or images from the Internet as 

they might be copyright protected. A copyrighted document or image cannot be reproduced without 

the permission of the real owner or creator. Some owners allow reproduction of their documents or 

images as long as their name is also mentioned. You should check the specific item’s rules usually 

found at the bottom of the page for more information. A website or an image usually carries the © 

symbol followed by the year of the first publication of the work and the name of the copyright 

holder. A useful document to learn more about copyrights can be found here 

http://www.copyright.gov/circs/circ1.pdf .  

 

http://www.copyright.gov/circs/circ1.pdf
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Also, Figure 160 shows an example found at the bottom of Google web pages,  

 

 
Figure 160: The text showing the copyright information for a Web page, usually found at the bottom 

and Figure 161 shows a copyrighted image. 

 
Figure 161: An example of an image with a copyright 

2.7 Email and Security 
The Internet changed the way people communicate. In the older days people used to tell their news 

or send greeting cards to friends by mail. Nowadays traditional mail lost ground to the electronic 

mail, called e-mail. In a generally electronic world e-mail is critical mostly to any business being 

competitive. However, as e-mails become more prevalent in the market, the importance of email 

security becomes more significant. In the following subsections we explain how to send and receive 

emails and files in an email (called attachments). Finally, we explain the risks involved with this way 

of communication and how to avoid them. 

2.7.1 Using E-mail 
Just like a normal address, you can also have an e-mail which is an electronic address with a unique 

identification among the million addresses on the Internet. There are many websites (providers) that 

offer free email addresses (can be thought of as an electronic version of the traditional mail box), 

known as email accounts (e.g. gmail.com, hotmail.com). Universities and companies also offer email 

accounts to their students and employees respectively.  

An email address looks like in Figure 162 below and consists of three parts: 

 

Figure 162: An example of an email address 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

1. Username: Usually the user chooses this and it could be a word or a name, as long as it is 

unique and has never been used at that domain (see 3 below). 

2. At sign: The “@” symbol indicates at which domain the name is registered. 

3. Domain name: This is the name of the email account provider. The “.com” suffix has the 

same meaning as explained in Section 2.6 and can vary for the same reasons. 

The most common publicly available email accounts (and providers, respectively) are given in Error! 

Reference source not found.: 

Table 13: The most common publicly available email accounts’ providers 

Provider’s website Domain 

www.gmail.com @gmail.com 

www.hotmail.com @hotmail.com or @live.com 

http://mail.yahoo.com @yahoo.com 

http://mail.aol.co.uk @aim.com 

2.7.2 Creating an email account 
If you do not have an email account, you have to follow an easy and non time consuming (only some 

minutes required) process in order to create one. The procedure that has been adopted by most of 

the providers and mentioned above is more or less the same, with minor differences.  

In order to explain the initial steps we selected the “www.gmail.com” provider as the example. 

Firstly you have to visit the website of the provider and at the login screen locate the “Sign up” or 

“Create new account” or any other similar option, as shown in Figure 163 for gmail.com.  

 

Figure 163: The place from where you can create an account in gmail.com 

Then you will have to fill in some details (as shown in Figure 164) including the desired username. If 

the username is already in use, the website will ask you to choose another one. You must also set a 

http://www.gmail.com/
http://www.hotmail.com/
http://mail.yahoo.com/
http://mail.aol.co.uk/
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password used for logging in to your personal account (mail box). This password should be difficult 

for other persons to know, so do not use your birthday or other obvious ones. 

 

Figure 164: Form to fill in your details and create an email account 

You can add an extra email address but this is not obligatory. Also, as shown in Figure 165, you must 

accept the terms of service in order to proceed and you must read carefully any other options before 

selecting them.   

 

Figure 165: Accepting the terms of service when creating an email account, in gmail.com 

Finally, the account will be created (Figure 166) and you will be able to start using it immediately. 
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Figure 166: Page shown immediately after successfully creating an email account with gmail.com 

2.7.3 Email software and Internet access 
After you have created your email account, you can gain access to it by two different ways. The first 

is to use a dedicated email software client and the second is to use the provider’s website.  

2.7.3.1 Dedicated email software client 
Just like a web browser is used for web browsing (Section 2, Web browsing and security), email 

software is designed to offer full control over your email account. Two of the most popular email 

software clients are given in Error! Reference source not found.: 

Table 14: List of the two most popular email software clients 

Name Icon 

Microsoft Office Outlook 
 

Mozilla Thunderbird 
 

 

These programs can be launched exactly the same way as a web browser (Section 2, Web browsing 

and security). We illustrate in the next paragraphs how to configure these email software clients for 

sending and receiving emails.  The procedure is again more or less the same, therefore, we choose 

the Mozilla Thunderbird tool as example, which can be downloaded for free at 

www.getthunderbird.com.  

2.7.3.2 Adding an email account in the program 
When you have your email account, you must configure the email software client to be able to 

access it.  This is known as adding a new account and can be done by two ways.  

The first one is by selecting the “Create new account” from the welcome screen, as shown in Figure 

167: 

http://www.getthunderbird.com/
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Figure 167: Option to create a new account in the Welcome screen of Thunderbird 

The second one is by selecting ToolsAccount Settings from the menu bar (Figure 168): 

 

Figure 168: Defining the new account’s settings in Thunderbird 

Then from the pop up screen select “Account options” and “Add Mail account” as shown below in 

Figure 169: 
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Figure 169: The follow up actions to add mail account Thunderbird 

You may follow one of the two ways since both will pop up the screen shown in Figure 170: 

 

Figure 170: Screen that appears after selecting to add a new email account in Thunderbird 
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Here you must fill in your name (this is how recipients will see who sent them the email), your email 

address and your password. A very important note here is to unclick the “Remember my password” 

option if you are using a public computer (more on this in the Securities issues subsection). 

When you fill in the required information and click the “Continue” button, more settings will be 

revealed at the bottom of the screen: 

 

Figure 171: Final form to select an Internet standard by which to access your email account in Thunderbird 

You now have to select one of the two Internet standards for retrieving emails from your account, 

IMAP or POP3 (Figure 171). The IMAP protocol offers access to your emails without downloading 

their contents on the computer currently being used. This is useful when you are not the owner of 

the computer or when you are using a public computer. On the other hand, POP3 protocol 

downloads the emails and their contents and makes them available for offline use (that is, even 

when you do not have access to the Internet). When you have decided on the protocol, select the 

“Create Account” button. Now and every time you launch the application the main screen will appear 

(Figure 172).  
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Figure 172: Main window of Thunderbird after creating an account, with numbered sections 

The numbered areas are: 

1. Tool menu bar where you can find sub-menus with all allowed actions on the application 

2. A sub-menu bar where you can see specific functionalities for quick access 

3. Search engine to find specific messages in your email folders 

4. The tree with all folders (default and created by you) in which your messages are classified 

and stored 

5. Access to the two most basic functionalities, to read and write messages 

6. Quick access to the settings functionality for the email accounts setup in the application 

2.7.3.3 Reading emails 
To check your email account for new messages you must select the “Get mail” option from the Mail 

toolbar (Figure 172, section 2) and wait for the bar at the bottom right (Figure 172, section 7) to  

become inactive (the green moving rectangle  should disappear). This indicates that 

the procedure for downloading your new emails has been completed. You can also get your new 

messages by selecting the “Get new messages” option (Figure 172, section5). If you need to enter 

your password in order to authenticate your connection (log in) the client will ask you to do so by 

using a pop up screen, as shown in Figure 173.  

 

Figure 173: Window in which you provide your password in order to gain access to your email account from Thunderbird 

All of your emails, either read or unread, are placed in the Inbox folder by default. To view this folder, 

select the “Inbox” label from the list on the left, as in Figure 172, section 4. If you single click on a 
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message’s title, its content will appear in the window at the bottom half of the screen, but if you 

double click the email will open in a new tab. 

Some emails may contain files, such as documents or images, known as attachments. When you 

receive an email with an attachment a clip symbol will appear at the left or at the right of the 

subject (the title of the email). If you open the email, at the bottom of the screen you will find details 

regarding the files attached and options to manage them (Figure 174): 

 

Figure 174: The attachments and the options to manage them, at the bottom of an email message in Thunderbird 

At the left side the number of the files will be displayed. For one attachment only, you will be able to 

see its name and file type. At the right of the display there is an option to save the files. When you 

click on this button a list of options appears in order to manage the attachment (Table 15): 

Table 15: Options available to manage an attachment in an email in Thunderbird 

Option Description 

Open Opens the file without the option to save it 

on the computer 

Save As Asks for a place to save the file to be 

available on the user’s computer 

Detach Saves the file like the Save As option but 

removes it from the email 

Delete Deletes the attachment, leaving the email 

without any files attached. 

2.7.3.4 Sending emails 
Sending an email can be done either by creating a new one (known as composing a message), by 

replying to another email or by sending a copy of the received email (known as forwarding).  

i. Creating a new email 

To create a new email simply click the   button from the main window (Figure 172, section 

2) or from the main menu (Figure 172, section 1) and select FileNewMessage as shown in Figure 

175: 



 
 
ViPi Project 511792-LLP-1-2010-1-GR-KA3-KA3NW  
 

 

Figure 175: Selections on the main page of Thunderbird, to create a new email message 

You can also create a new message by selecting the “Write a new message” option from the main 
window (Figure 172, section 5).  

Either way, the new screen for composing a new message will be the same and looks like in Figure 
176 below: 

 

Figure 176: Screen for composing/creating a new message in Thunderbird, with numbered sections/parts 

 
To write a message, you must first decide who will receive this email. The email address of the 

receiver must be filled in the  field like the example given (Figure 176, section 4). If you 
want to send the email to more than one receiver, separate their emails with a comma. 
 
As you may have noticed there are other fields available as well and they can be customized by 
clicking on their name (Figure 177): 
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Figure 177: The selection box to define the type of the recipient To, CC, BCC, etc, in Thunderbird  

The  (stands for Carbon Copy-Figure 176, section 4) is another way of sending an email 
to secondary recipients.  You can fill-in as many email addresses as you like but always separated 
with commas. 
 
One important note regarding these two field types is that all the recipients are aware of each other. 
That is, user1 will know that user2 also received the email and vice versa (Figure 176, section 4).  
There are cases when you might want to keep recipients’ addresses hidden from each other. In that 

case you must select the  option (stands for Blind Carbon Copy). With this option, all 
the addresses in the Bcc field are hidden from each other and from the primary (To) and secondary 
(Cc) recipients. As a result user3 will be aware of user1 and user 2 but these two will not see user’s 3 
address. 

Your sending address and name will appear to others the exact way as shown in the  field 
(Figure 176, section 3) and they are the same as configured earlier in the account setup. You can 
access these settings by selecting the “View settings for this account” option (Figure 172, section 6). 
 
After deciding the recipients, the next step is to find a title (subject) for your email (Figure 176, 
section 5). You may leave this field blank but it is not recommended as some email providers might 
consider it fake and block it, that is, it will not be delivered.  
 
Then, the next step is to write the actual content of the email. You can write as many words as you 
like in the space given (Figure 176, section 6) and there are options for formatting the text, just like in 
a word processing tool.  If you would like to save your email and continue later you can do so by 

selecting the  button (Figure 176, section 2). This will save the email in the Drafts folder 
(Figure 172, section 4) and you will be able to continue writing it at any time later. An alternative way 
to save a message is from the menu bar (Figure 176, section 1). Select FileSave and the email will 
be saved in the drafts folder (Figure 178). 

 
 

Figure 178: Showing the selections required in order to save an email in the Drafts folder, in Thunderbird 

Just like receiving files as attachments to emails, you can send files as attachments as well. 

Depending on what email provider you use there is a maximum size to the files you can attach to an 

email. The email providers mentioned earlier in this text support attachments up to 25MB in size. 
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However, the people you are sending the files to might have smaller limits. It is therefore 

recommended to attach filed of maximum 9MB in size. To attach the files click the   

button and using the new window navigate to the location of the files on your computer. This can be 

done by the main menu too (Figure 176, section 1), by selecting FileAttachFile(s) (Figure 179). 

 

Figure 179: Selection required in order to attach a file in an email message, in Thunderbird 

To attach multiple files at once hold down the “Ctrl” button on the keyboard and single click on the 

files, once at a time. 

The final step is to send the email. To send it simply select the  button (Figure 176, section 

2) or use the main menu by selecting FileSend Now (Figure 180). 

 

Figure 180: Selection from the File menu to send the created email message, in Thunderbird 

When you click on the sent button a pop-up window (Figure 181) indicating the sending progress will 

appear: 

 

Figure 181: Popup window indicating the sending progress of an email 
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Once the bar reaches 100%, the program will copy the sent email to the “Sent Mails” folder (Figure 

172, section 4), Figure 182.  

 

Figure 182: Window that shows the process of copying the sent email to the Sent Mail folder 

All the emails that you send are stored in this folder and you can access them anytime, until you 

permanently delete them from that folder. 

You must not exit the program or disconnect from the internet until the progress bar reaches 100%. 

When everything is completed the “Write” window (Figure 176) will close and you will be transferred 

to the main window. 

ii. Replying to an email 

To reply to an email you must select the “Reply” button found at the top of the email content (when 

opened in a new tab), as shown in Figure 183. 

 

Figure 183: An opened message with a mark on the Reply option 

You can also reply by selecting the reply button on the main screen of the program, without opening 

the email in a new tab, as shown in Figure 184 below: 
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Figure 184: Marking the Reply option in the main screen of Thunderbird where emails are listed 

Another way of replying is to navigate from the menu bar (Figure 172, section 1) to the “Reply” 

option by selecting MessageReply (Figure 185):  

 

Figure 185: Finding the Reply option in the Message menu on the top menu bar 

Is some cases the sender of the email, might send the same email to other users too. If you would 

like to reply to the sender but also to the other recipients as well, you can do so by selecting the 

“Reply to All” option (Figure 186).  

 

Figure 186: Finding the Reply to All option from the Message menu in the top menu bar 

Before using this function you will have to be sure that the email is of common interest and will not 

distract other recipients. 

When you use the Reply (or Replay to All) function, your email subject will begin with the prefix “Re:” 

to indicate that this is a reply to a previous email, as shown in Figure 187. 

 

Figure 187: The subject of the message with the Re: prefix, when replying 

The remaining procedure is identical to the one described in sending a new email. 
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iii. Forwarding an email 

When you want to send a received email to someone else, instead of writing it again you can use the 

Forward function. This function includes the original message but allows the user to add extra 

content to the email, such as text, images or other files. To forward a message select the “Forward” 

button when viewing an email in the main window (Figure 188):  

 

Figure 188: Marking of the Forward option in the main window of listing emails in Thunderbird 

You can forward an email when opened in a new tab too (Figure 189): 

 

Figure 189: Marking of the Forward option in the window of a specific email in Thunderbird 

Finally, you can forward it by selecting MessageForward from the menu bar (Figure 172, section 1 

and Figure 190) 
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Figure 190: Marking of the Forward option in the Message menu item in the top menu bar 

To indicate that you email contains forwarded content the prefix “Fw:” will be inserted in the email’s 

subject. Also the email will contain the forwarded content but it will be separated from you 

additional content (Figure 191). 

 

Figure 191: Marking of the text appearing in the forwarded message content, that indicates the original message 

2.7.3.5 Organizing and searching your emails 
One easy and fast way of finding emails in your account, is to use the search function. Simply enter 

the keywords in the search field and press enter (Figure 172, section 3). 

You can also create folders to move your messages for easier access. Right click on the folders list 

(Figure 172, section 4) and select “New Folder” (Figure 192). 
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Figure 192: Creating new folder to organize the email messages in Thunderbird 

Name the folder and move your emails by right clicking on their subject and by selecting “Move to” 

or “Copy to” if you want to make a copy of the email (Figure 193). 

 

Figure 193: Showing how to move or copy a message in another folder than the original one (usually the Inbox) 

If you want to delete a message, right click on its subject and select “Delete Message”. 

a) Dedicated websites of providers (Internet email clients) 

As mentioned earlier, another way to access your email account is by using your provider’s dedicated 

tool on her website (gmail.com for this example). All functions explained earlier are achieved by the 

same procedures described in the case of email software clients, so here we shall focus on where you 

can locate the dedicated tools of providers. 

The first thing to do when you navigate to the website is to log in or sign in, that is, enter your 

username and password (Figure 194). 

 

Figure 194: The page to login to the gmail.com email provider 
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Do not check the “Stay signed in” option and decline any offer to remember your password if you are 

using a public computer.   

After successfully logging in, you will be transferred to the main window of your email account 

(Figure 195) and to your Inbox messages: 

 
Figure 195: Main window of the gmail.com email client, with numbered sections 

 

To write a new email select the  button (Figure 195, section 1), in order to navigate to 
the “Compose mail” screen where you can compose your email as explained at the “Creating a new 
email” section above. 
You can see the sent mails at the “Sent Mail” folder from the list on the left (Figure 195, section 2) 
and you can search your account as well by entering the text at the search box (Figure 195, section 
3). 
To read an email, you may click anywhere on the highlighted line (Figure 195, section 5). If there is an 
attached file with the email the clip  icon will appear next to the title and you will be able to 
download it once you open the email. (Some tools perform also a scanning of the email for malware 
code before opening it). To reply or forward the message, select the corresponding option at the 
bottom of the email (Figure 196): 

 
Figure 196: Options to Reply of Forward an email, in gmail.com 

To delete a message, click on the tick box on the left of the sender’s name and then click on the 

 button. This can be also done when you open the email. 
Finally, do not forget to sign out when you are done by clicking on your username (Figure 195, 
section 4) and selecting the “Sign out” option (Figure 197). 
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Figure 197: Signing out from your gmail.com account 

2.7.4 Alternative Email software 
In the subsection 2.7.3.1, Mozilla Thunderbird has been introduced as a dedicated type of software 

that allows you to access and organise your emails. There are also alternative email applications, two 

of the most widely used are the Microsoft Outlook™ and the Windows Live Mail ™.  

Figure 198 shows the basic and common functions of the two alternatives of email software. Their 

features are marked with red-line borders. Each one is given with a short description in the next 

paragraph. Detailed explanation about the usage of each option can be found in subsection 2.7.3.1 

(Email and SecurityEmail software and Internet access Dedicated email software).  

1. New message: This option launches a new window to write a new email as explained in 

section 2.7.3.1 (Email and SecurityEmail software and Internet access a) Dedicated email 

software Sending email). 

2. Reply, Forward & Delete message: The reply option allows the user to reply to an email, 

while the reply all option is used to reply to the group of email addresses that were included 

in the To and CC fields of the received message. With the forward button you can send the 

selected email (or the opened email) to another address. Finally, the Delete option moves 

the selected message to the Deleted items folder. 

3. Send/Receive: Use this button to refresh your inbox in order to receive all the latest emails 

or to send any emails pre-created and saved in the Outbox folder. 

4. Search box: Here you can search your inbox for specific messages by using words or phrases 

that might be included in the title and/or content of the email messages. 

5. Personal Folders: the folders where your email messages are stored in. Usually new emails 

are place in the Inbox folder unless they contain advertisements or offensive content. In that 

case the software moves them automatically in the “Junk email” folder. The recognition of 

such junk emails is performed by the email software using pre-existing knowledge on senders 

and offensive content, but it can also be trained by you when marking specific emails as 

spam/junk. 

6. Other pages: These dedicated email applications offer the ability to have a personal calendar 

to save your appointments or other notes. You can use the Contacts page to add new email 

addresses in order to have quick access to them while sending an email. 

7. Emails list: This is the main window of the email application. The contents of the selected 

folder are displayed here.  
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Figure 198. Alternative email software (Microsoft Outlook™ on top and Windows Live Mail ™ at bottom). The figure 
presents screenshots with the positions of the numbered items as explained in the text. 
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2.7.5 Security Issues 
Unfortunately with email usage some vulnerabilities issues have been emerged. However, knowing 

better these issues will make it easier to protect yourself and your account. You may find additional 

information on risks and dangers from using the Internet and communicating through email, in the 

Web sites of the Centers promoting safer Internet in your country. Links are available in Table 18.  

2.7.5.1 Logging-out of account and saving 

passwords 
One of the most important actions you must remember is to always log out of your account when 

you finish your work. Never close the browser or the email applications without logging out since 

they might keep you logged in to your account, thus increasing the risk of someone else accessing 

your account. 

Another important thing to consider is NOT to save your password on a public computer, e.g. an 

internet cafe. You must neither save your password on a computer that you do not own (nor click the 

“Remember my password” option), since the password will be saved even if you log out.  

2.7.5.2 File Attachments and dangerous extension 

types 
Sometimes you might receive emails from unknown senders. You must open this emails with caution 

as they might contain dangerous attachments infected with malware code. Usually a potentially 

dangerous type of attachment is an executable (a file ending in .exe). Most email providers scan your 

emails for malwares but you must run an antivirus scan yourself or delete the email if you are feeling 

unsure (Section 2.11, Safety and Security).  

2.7.5.3 Spam / Unwanted emails 
Always be very careful in what websites you share your email address since spam email messages 

(massively sent and usually unwanted emails) are a constantly growing problem. These are messages 

that contain advertisements or even offensive content and usually come from unknown users. Most 

of the times they are sent from automated computers that find your address when you share it with 

a not so trustworthy website.  Fortunately, email providers have filters that cut out spam emails and 

save them in the “Spam” folder (Figure 172, section 4). Again be extremely cautious with these 

emails and avoid opening them.  

2.7.5.4 Phishing/Spoofing  
A sub category of spam messages are the phishing/spoofing messages. This kind of messages may 

come from an unknown sender and pretend to be sent from a trusty account or website. Their 

purpose is to trick the recipient and try to acquire information such as usernames, passwords and 

credit card details. Some emails ask you to navigate to a website to enter your username and 

password. This website might have exactly the same appearance as the original website. Most 

websites and online services never ask for any sensitive information to be given through email. You 
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must therefore be suspicious when someone asks for personal or other kind of information through 

email. 

2.7.5.5 Copyright issues  
Finally, you must be aware that images, documents and other form of work exchanged through 
emails, retain their copyrights and their creator can claim them. This means that before 
sharing/distributing any content of which you are not the original creator, you have to ensure that it 
is not bounded by a license that prevents such actions. Alternatively, you can ask for the explicit right 
by the owner of the content. 
 

2.8 Communication software 
2.8.1 Skype 
Skype is one of the most popular programmes used for chatting, internet phone calls and 

communication with everybody around the World. You can download the programme for free at: 

www.skype.com. 

1. Installation 

- When the File Download screen is displayed, click Save.   
- Choose somewhere on your computer to save the SkypeSetup file and click Save. 
- When it has downloaded, go to the location you saved the SkypeSetup file to and double-

click it.  
- When the Open File screen is displayed, click Run. 
- Select your language, read the Skype End User License Agreement and the Skype Privacy 

Statement, and then click I agree – next. 
- Your Skype installation starts. When it is complete, Skype opens and the Welcome to Skype 

sign-in screen is displayed. 
- Select the language you would like to be used for Skype. Afterwards, you can still change this 

language from the Menu → Tools. The programme supports more than 32 languages. 
- On the Welcome screen, enter your Skype Name and password and click Sign me in or create 

an account by clicking Create a new account and follow the steps. 
- If this is the first time that you have signed in to Skype, you can now check your sound and 

video to ensure they are set up correctly and add a profile picture for your Skype account.   
- Click Continue. 
- Select the speakers, microphone and webcam you want to use with Skype, and then click 

Continue. 
- You can now add a profile picture to make it easier for your friends and family to find you on 

Skype. 
- If you don’t want to add your profile picture right now, just click Add later and go to the next 

step.  
- To take a picture of yourself using your webcam, click Take a picture. Alternatively, if you 

already have a picture that you want to use as your profile picture, click Browse… to find and 
select it. 

- The picture you have taken or selected is displayed. If you want to resize the picture, use the 
slider underneath it. If you are not happy with the picture, click Try again to take another 
picture or select a different one. 

- When you are happy with your profile picture, click Use this picture. 
-  Your profile summary is displayed. Click Start using Skype. 

http://www.skype.com/
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Figure 199: Skype webpage 
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Figure 200: Installation box 

2. Using Skype 

 

 

Figure 201: Skype top screen with menu, status and call phones bar 

A. Menu bar. Includes all the options that will help you get the most out of Skype. 

B. Status bar. You can change your Skype status and access Skype Home from here. 

C. Call phones bar. Displays the dial pad so you can call phones and mobiles (this requires you have 

provided payment details, because calling to phones and mobiles is not free). 
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Figure 202: Skype top screen with contact list, facebook list and recent list. 

D. Contact list. Lists your contacts and lets you see their status. 

E. Facebook list. Lists all of your friends from your Facebook account, and shows whether they are 

online, away, or offline on Facebook. 

F. Recent list. Lists the recent conversations you’ve had in Skype. 

 

 

Figure 203: Skype screen with contact summary, conversation window and box. 

G. Contact summary. Displayed when you select a contact or set up a group chat. Summarizes the 

details of the contacts you’re currently chatting to in Skype. 
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H. Conversation window. Displayed when you select a contact or set up a group chat. Shows 

the instant message conversation you’re having. The buttons at the top of the conversation window 

let you call someone on Skype, send files, send contacts, share your screen or add more people to 

the conversation. You can also check your call quality information. 

I. Conversation box. Displayed when you select a contact or set up a group chat. Use this box to type 

and send your instant messages and text messages.  

 

 

Figure 204: Skype screen with functionalities to add a contact and create a group. 

J. Add a contact. Lets you search for your friends and add them as contacts. 

K. Create a group. Lets you create a group so that you can make a conference call or group video call. 

 
3. Skype Hotkeys, Shortcuts and Chat Commands 

These hotkeys all Call Related and must be enabled and defined at Skype- Tools- Options -Advanced- 

Hotkeys. Undefined means that the user needs to define what combination he would like to use. 
- Alt-PgUp: Answers a call 
- Ctrl-Alt-PgUp: Answers a call with video 
- Undefined: Ignore call 
- Alt-PgDn: Reject/Hang up call 
- Undefined: Focus Skype 
- Undefined: Search for Skype Users 
- Undefined: Mute Microphone 

 

Main Window: 
- Ctrl+E: Switch between Events History and Contact List 
- Ctrl+U: Show/Hide Offline Contacts 
- Ctrl+W: Hide Main Skype Window 
- Ctrl+Q: Quit Skype 

 

Chat Window: 
- Ctrl+F Find/Search this Chat 
- F3/Shift-F3: Find Next/Previous Match (use after Ctrl+F) 
- Ctrl+W Close/Hide Chat Window 

 

Quickfilter: 
- F6: Jump to Quickfilter 
- Escape: Clear Quickfilter 
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Chat commands: 
- /add skypename: add the specified Skype Name to this chat (example: “/add john”) 
- /help: list available system commands 
- /topic newtopic: change chat topic to “newtopic” 
- /me something: others will see an action that you perform (example: “John smiles”) 
- /history: show full history for the chat (you can then review and search it) 
- /find text: find messages containing “text” in the chat 
- /fa or /: repeat last search 
- /alertsoff: disable new message alerts for this chat. Useful if you don’t want chat window to 

pop up or the taskbar entry to blink for this chat, but would still like to be “connected” to it. 
If a chat is in this mode, it will be in the “Unread chats” section on Start Tab when new 
messages are posted to it. 

- /alertson or /alertson text: restore default behaviour, to be notified when new messages are 
posted. If you use “/alertson text”, you are notified only when a message is posted that 
contains “text”. 

- /leave: leave the chat (does the same as clicking the “Leave” button on toolbar. 
 
An updated list of these commands is provided at 
http://kosi2801.freepgs.com/2008/12/20/skype_chat_commands.html. 
 

2.8.2 Google Talk 
Google Talk (GTalk) is Google Talk, a downloadable chat application by Google with which you can do 

the following: 

- Text chat 
o Instant messages: share quick thoughts in real time 
o Status updates: see if friends are around and what they are up to 
o File transfer: instantly send and receive files, pictures and more 

- Voice chat 
o Free long distance: make PC-to-PC calls to people anywhere in the world 
o Audio conferencing: talk to multiple people at once 
o Google Mail integration: chat with your friends on Google Mail 

- You can also get the video chat plug-in to make voice and video calls within Google Mail. 
 
How to install it on a PC: 

- Visit www.google.com/talk/ OR by type Google Chat or Google Talk in Google and then 
clicking on the first page that is shown. 

- When you open the website of Google Chat or Google Talk, look for a Download link. 
- Click on the Download link. The website may automatically recognize your OS (Windows, Mac 

or Linux) or you may have to choose yourself. 
- Download the installation files for your OS. 
- Wait for the Download to finish. Double click on the downloaded installation file. (Make sure 

that all web browsers are closed. It is also recommended that all other programs be closed). 
- Follow the step by step installation process – it will take a small amount of time. 
- If you are a Windows user, you will then have to restart your computer. 
- The Google Talk window will open on starting the computer. 
- You can log in by entering your Google (or GMail) username and password. 
- After this, you can add friends and chat with them. 

http://kosi2801.freepgs.com/2008/12/20/skype_chat_commands.html
http://www.google.com/talk/
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- Google Talk is also integrated with Google Voice and it allows for video and voice calls. 
A complete online guide for every functionality is available at http://support.google.com/talk/?hl=en. 

2.8.3 Windows Live Messenger 
This product can be downloaded at http://windows.microsoft.com/en-US/windows-live/essentials-
home. 
Note: it is free. 

1. Installation 

- Ensure you have an e-mail address. 
- Download MSN Messenger by going to the download website and clicking Download. 
- Once downloaded, install it. 
- After installation, launch the application. 
- Log in or in case you are a new user select Sign up. 

 
Fig. 60 Windows Live Messenger login screen 

 
- Add a contact, a person to talk to, by clicking Add A Contact on the Contacts menu. 

http://support.google.com/talk/?hl=en
http://windows.microsoft.com/en-US/windows-live/essentials-home
http://windows.microsoft.com/en-US/windows-live/essentials-home
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- When/If the person is online, a green figure will appear beside their name in your contact 
list. Double click on their name and type a greeting into the lower rectangular box. Click Send 
an Instant Message. 

- Type a message to the person. Click Send. Wait for the person to answer you. You can see 
when the person is typing a letter to you. 

- Engage in conversation if they reply. If desired, many options can be taken from here. You 
can select an action to take by selecting something from the Actions menu on the 
conversation's toolbar. 

- Click Tools or Actions to use some of Messenger's other features. Use emoticons if you want 
to send an icon to someone as part of your message. 

- Click the Invite button at the top of the chat window to invite another person to your 
conversation. You can now chat with two people at once. Click the red X at the top of the 
screen to close the chat window. Click File and then Sign Out to be offline. 

 
Fig 61 Windows Live Messenger Chat screen 

 
More detailed instructions can be found on http://windows.microsoft.com/en-

US/messenger/features. 

http://windows.microsoft.com/en-US/messenger/features
http://windows.microsoft.com/en-US/messenger/features
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2. Windows Messenger keyboard shortcuts 

Following shortcut keys exist for Windows Messenger. 

Table 16: 2. Windows Messenger keyboard shortcuts - For the Messenger conversation window 

For the Messenger conversation window 

Shortcut Command 

Invite someone to this conversation Alt+I 

Create a Sharing Folder Alt+L+H 

Send a single file Alt+L+F 

Start or stop a video call Alt+O 

Call a computer Alt+C 

Call a contact at home Alt+C+H 

Call a contact at work Alt+C+W 

Call a contact at a different number Alt+C+O 

Call a new number Alt+C+N 

See a list of activities Alt+V 

See a list of games Alt+G 

Block a contact from seeing you or contacting you Alt+K 

Select an emoticon Alt+M or Ctrl+E 

Select a wink Alt+W 

Send a nudge Alt+N 

Select a background for your conversation window Alt+B 

  

Keyboard shortcuts for Windows Live Call  

Make a call CTRL+D 

End a call CTRL+D 

Open the Options dialogue box ALT+T+O 

Open Help F1 

Show Options CTRL+E 

Delete selected Call History entry DELETE 

Show Call History CTRL+H 

Get more information about Windows Live Call CTRL+I 

Add minutes CTRL+T 

Manage your account CTRL+O 

Mute the speaker CTRL+S 

Mute the microphone CTRL+M 

 

More shortcuts can be found at http://shortcutkeys.net/windows-live-messenger-keyboard-

shortcuts/. 

2.8.4 Safety and communication software 
While online communication offers a wide variety of advantages (cheap, easy and possible on mobile 
and PC), there are also risks associated to using online communication software. Here are some 
recommendations (based on http://www.chatdanger.com): 

 Do you know everyone on your contacts list? Think carefully about who is on your list. People 
may not be who they say they are, so a friend of a friend is not necessarily a friend. 

 Keep your personal information secret when talking to someone you don’t know in the real 
world. Also think about what visible information you have, for example in your profile. 

 Keep an archive/save a copy of your conversation, and don’t be afraid to tell someone you 
are saving their conversation. This is supported by most applications. 

http://shortcutkeys.net/windows-live-messenger-keyboard-shortcuts/
http://shortcutkeys.net/windows-live-messenger-keyboard-shortcuts/
http://www.chatdanger.com/
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o Archiving or saving your conversations can provide useful evidence if you come to 
make a report about something or someone. 

o Check your preferences or privacy options in the applications you use. For others that 
do not offer this option, you can still highlight the conversation with your mouse and 
copy and paste conversations into a Word document which you can save. 

 Don’t hesitate to block/ignore people. 
o To do this you right click on the name of the person in the contact list which should 

give you a range of options, and one of these is mostly Block. It will mean that you 
will not receive messages from this person anymore. Block is sometimes called 
’Ignore’, and if right-clicking doesn’t work, have a look in your Preferences for this 
function. 

 Check you know how to report something you feel uncomfortable about: 
o Keep a copy of the conversation that you want to report and provide that to your 

parents or supervisor. 
o Look for a way to contact your Messenger provider by clicking the Help tab. 

 Use a nickname, not your real name, and a nickname that is not going to attract the wrong 
type of attention. 

 Keep your username and password private, and change your password on a regular basis 

 Don’t reply to abusive messages. Don’t send abusive messages either. It’s best not to say 
anything that you wouldn’t say to someone’s face. 

 Don’t accept messages from people you don’t know. 

 Meeting someone you have only been in touch with online can be dangerous. If you feel that 
you ‘have to’ meet, then for your own safety you must inform your parent or carer or friends 
and take them with you – at least on the first visit – and meet in a public place in daytime. 

 If someone you have accepted on your buddy or contacts list is acting weird, don’t pass them 
on to a friend. You could be putting your friend at risk. Just block them and report them. 

 Be also careful when accepting files that are being sent, especially the ones with an .exe 
extension. They are often malicious software that can harm your PC, but also extract 
personal data from your PC. 

 Never provide credentials of any sorts over chat sessions, and definitely not credit card 
details. 

2.9 Mobiles Smartphones and Tablets 
Smartphones and Tablets are devices comprising a combination of cell phone with computer, web 
browser, multimedia player and camera. The smartphone opens up new possibilities for educational 
purposes. The ease-of-use and the mobility of such devices make it possible to use it on buses, public 
places, parks and train for studying. To utilise such a training device it must be easy for an educator 
to produce, edit, and upload training material and also to be able to follow the student’s progress. 
Here are some features that differentiate smartphone from ordinary cell phone. 
 

• Mobile devices 
• Operating System 
• Software 
• Web access 
• QWERTY Keyboard 
• Messaging 

 Solid PIM Functionality (Plenty of info and fields for each contact. Good calendar view, 
flexible, etc.) 

• Universal Search 
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• Office documents editing 

2.9.1 Mobile devices
1
 

This unit will introduce: 

 Phones 

 Smartphones 

 Tablets based on Android, iPad 
 

The shape of a mobile phone can be an important factor in finding a phone that best fits with your 

needs. There are several main categories a mobile phone may fall into. The following briefly 

describes how each shape may be useful depending on your circumstances.  

  

Clam Shell / Flip Phone 

For people with limited or low vision or who are blind, a phone that flips open and 

answers automatically may be useful.  

 

  

Candy Bar / Monobloc/ Stick 
For people with arthritis or poor dexterity, a ‘candy bar’ or ‘bloc’ phone may be useful to 
avoid the need for added movements like sliding or flipping open the phone to use it. 

  

Slide  
Like a flip phone, this style of phone may be useful for people with limited or low vision 
or who are blind, as they will answer automatically upon sliding open. 
 

 Swivel 
Like a flip or sliding phone, this style of phone could be useful for people with limited or 
low vision or who are blind as they will answer automatically upon opening.  
  

 
Touchscreen 
This style may be useful to those people who are deaf or have moderate to profound hearing 
loss and who will use their larger screen sizes for texting or video calling (using e.g. sign 
language). 
 
  

Smart Phones 
Similar to a touchscreen, this style could be useful to those 
people who are deaf or have moderate to profound hearing loss 
and who will use the larger screen size for texting or video calling.  
In addition, increasingly also the accessibility for people with 
visual impairments is being enhanced, using multi-touch and 
gesture technology. 
 
 

                                                           
1
 http://mobileaccessibility.info/device.cfm?lang=eng 

http://mobileaccessibility.info/device.cfm?lang=eng
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Fig 62. Various smartphones (Resource: http://electronics.howstuffworks.com/smartphone.htm)  

2.9.1.1 What is a smart phone?
2
 

Unlike many traditional mobile phones, smartphones allow individual users to install, configure and 
run applications of their choosing. A smartphone offers the ability to conform the device to your 
particular way of doing things. Most standard mobile-phone software offers only limited choices for 
re-configuration, forcing you to adapt to the way it's set up. On a standard phone, whether or not 
you like the built-in calendar application, you are stuck with it except for a few minor tweaks. If that 
phone were a smartphone, you could install any compatible calendar application you like. 
 
Here's a list of some of the things smartphones can do: 

 Send and receive mobile phone calls – some smartphones are also Wi-Fi capable 
 Personal Information Management (PIM) including notes, calendar and to-do list 
 Communication with laptop or desktop computers 
 Data synchronization with applications like Microsoft Outlook and Apple's iCal calendar 

programs 
 E-mail 
 Instant messaging 
 Applications such as word processing programs or video games 
 Play audio and video files in some standard formats 

The following sections detail particular features that may be useful in different circumstances. It is 
important to realise that there is no one solution for all, and as such, finding a suitable phone will 
involve considering all of the available features of a particular model, knowing what you need or 
what is likely to be more useful to you and testing the phone to ensure that it really does meet your 
particular needs. 

Resource:  
http://mobileaccessibility.info/device.cfm?lang=eng 

http://electronics.howstuffworks.com/smartphone.htm 

2.9.1.2 Features of smartphones 
 

Inside a Digital Mobile Phone 

On a "complexity per cubic inch" scale, mobile phones are some of the most intricate devices people 
use on a daily basis. Modern digital mobile phones can process millions of calculations per second in 
order to compress and decompress the voice stream. 
A mobile phone contains following components: 

 A circuit board containing the brains (processing power)  of the phone 
 An antenna to receive and transmit the audio signal 
 A liquid crystal display (LCD) to display messages, phone numbers, addressbook, etc. 
 A microphone to provide audio input 

                                                           
2
 Based on http://electronics.howstuffworks.com/smartphone.htm 

http://electronics.howstuffworks.com/smartphone.htm
http://mobileaccessibility.info/device.cfm?lang=eng
http://electronics.howstuffworks.com/smartphone.htm
http://electronics.howstuffworks.com/lcd.htm
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 A speaker to provide audio output 
 A battery that provides the power source for the phone functions. 
 An input mechanism to allow the user to interact with the phone. The most common input 

mechanism is a keypad, but touch screens are also found in some high-end smartphones. 
 Basic mobile phone services to allow users to make calls and send text messages. 
 All GSM phones use a SIM card to allow an account to be swapped among devices. 
 Individual mobile phone devices are uniquely identified by an International Mobile 

Equipment Identity (IMEI) number. This is useful in case your mobile is stolen to block any 
usage with the mobile. 

The functionalities that are supported are mainly the following: 

 phones of different types and in different countries can communicate with each other (calls, 
smses, etc.) 

 roaming permits the same phone to be used in multiple countries, providing that the 
operators of both countries have a roaming agreement. 

 send and receive data and faxes (if a computer is attached), access WAP services, and 
provide full Internet access using technologies such as GPRS, mobile internet or WiFi. 

 applications like a clock, alarm, calendar and calculator and a few games. 
 sending and receiving pictures and videos through MMS, and for short distances with e.g. 

Bluetooth. 
 GPS receivers integrated or connected (i.e. using Bluetooth) to cell phones. 
 push to talk, available on some mobile phones, is a feature that allows the user to be heard 

only while the talk button is held, similar to a walkie-talkie. 
 features aimed toward personalisation, such as user defined and downloadable ring tones 

and logos, and interchangeable covers 
 usually one can choose between a ring tone, a vibrating alert, or a combination of both. 

Smartphone Operating Systems 
The most important software in any smartphone is its operating system (OS). An operating system 
manages the hardware and software resources of smartphones. The most common smartphone 
operating systems are: RIM (Blackberry), Symbian (developed by NOKIA but now in hands of 
Accenture), iOS (developed by Apple), Android (developed by Google), Windows Phone (developed 
by Microsoft). iOS and Android are the most popular OS3 

Symbian 
Symbian was the number one smartphone platform by market share from 1996 
until 2011 when it dropped to second place behind Google's Android OS due to a 
rather old technology that is being used. It will be discontinued most likely by the 
end of 2016 

 
 
 

Photo source: http://www.zdnet.com  

Windows Mobile 
                                                           
3
 Gartner Smart Phone Marketshare 2012 Q1, Gartner, Inc. Retrieved 2012-05-26. 

http://computer.howstuffworks.com/software-channel.htm
http://computer.howstuffworks.com/operating-system.htm
http://computer.howstuffworks.com/hardware-channel.htm
http://www.zdnet.com/
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The multi-touch-enabled Windows Mobile 7 (now replaced by Windows Phone) 
arrived in 2010. The OS is based on Windows OS. Much of the strength of this OS lies 
in the compatibility with the Microsoft Office suite of programs. 

Photo source: http://www.digitaltrends.com  

 

 

 

Android   
Android is a Linux-based operating system for mobile devices such as smartphones 

and tablet computers. It is developed by the Open Handset Alliance, led by Google, 

and other companies.  

Android 4.0 (Ice Cream Sandwich) is the latest version of the Android platform for 
phones, tablets, and more. Refined animations and feedback throughout the 
system make interactions engaging and interesting. An entirely new typeface 
optimized for high-resolution screens improves readability and brings a polished, 
modern feel to the user interface.  
 

Photo source: http://www.aliexpress.com 
Multitasking is a key strength of Android and it's made even easier and more visual on Android 4.0. 
The Recent Apps button lets you jump instantly from one task to another using the list in the System 
Bar. The list pops up to show thumbnail images of apps used recently — tapping a thumbnail 
switches to the app.  
Rich and interactive notifications let you keep in constant touch with incoming messages, play music 
tracks, see real-time updates from apps, and much more. On smaller-screen devices, notifications 
appear at the top of the screen, while on larger-screen devices they appear in the System Bar.  

Unique Operating Systems 

iPhone  
Apple’s iPhone uses a variation of the Mac OS, known as OS X. iOS (originally iPhone OS) is a mobile 
operating system developed and distributed by Apple Inc. Originally released in 2007 for the iPhone 
and iPod Touch, it has since been extended to support other Apple devices such as the iPad and 
Apple TV. Unlike Windows CE (Mobile and Phone) and Android, Apple does not license iOS for 
installation on non-Apple hardware. 
 
The user interface of iOS is based on the concept of direct manipulation, 
using multi-touch gestures. Interface control elements consist of sliders, 
switches, and buttons. The response to user input is immediate and 
provides a fluid interface. Interaction with the OS includes gestures such as 
swipe, tap, pinch, and reverse pinch, all of which have specific definitions 
within the context of the iOS operating system and its multi-touch interface. 
Internal accelerometers are used by some applications to respond to 
shaking the device (one common result is the undo command) or rotating it 
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in three dimensions (one common result is switching from portrait to landscape mode). 
iOS is derived from OS X. 
 
 

Photo source:  http://iphonedevelopmenttutorial.org/  

 

BlackBerry  

BlackBerry OS is a proprietary mobile operating system, developed by 
Research In Motion (RIM) for its BlackBerry line of smartphone handheld 
devices. The operating system provides multitasking and supports 
specialized input devices that have been adopted by RIM for use in its 
handhelds, particularly the trackwheel, trackball, and most recently, the 
trackpad and touchscreen. 
 

 
Photo source:  http://www.gsmarena.com 

 
Bada 

The Bada is an operating system for mobile devices such as smartphones and tablet computers. It is 
developed by Samsung Electronics and announced in 2009.  
 
Resource:  Ed Hansberry (11 November 2009). "Samsung Bailing on Windows Mobile" 

2.9.2 Using mobile devices 
The mobile phones provide an incredible array of functions. The following provides an overview. 

2.9.2.1 Calling operation 
The primary function of a mobile phone is voice communication. Like traditional landline phones, 

mobile phones allow one user to call another and talk from afar. Functions related to voice 

communications include automatic redial, last number recall, caller ID, logging of incoming and 

outgoing calls, speakerphone or hands-free capabilities, and speed dialling. 

 Some phones also are equipped with voice-activated dialling and features like a silent mode, which 

disables ringing or indicates incoming calls and alerts by vibration. Many mobile phones also feature 

the ability to block calls from unwanted numbers or customize ringtones to send an audible 

indication of the source of an incoming call. 

Read more: What Are the Functions of Mobile Phones? | eHow.com 

http://www.ehow.com/list_6363799_functions-mobile-phones_.html#ixzz1y8ZhSLMt  
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2.9.2.2 Text messages 
4
 

SMS stands for short message service. Simply put, it is a method of communication that sends text 
between mobile phones, or from a PC or handheld to a mobile phone. The "short" part refers to the 
maximum size of the text messages: 160 characters (letters, numbers or symbols in the Latin 
alphabet). 
Even when a mobile phone is not in use, it is constantly sending and receiving information. It is 
talking to its mobile phone tower over a pathway called a control channel. The reason for this 
chatter is so that the mobile phone system knows which mobile your phone is in, and so that your 
phone can change mobiles as you move around. Every so often, your phone and the tower will 
exchange a packet of data that lets both of them know that everything is OK. 
 
The phone also uses the control channel for call setup. When someone tries to call you, the tower 
sends your phone a message over the control channel that tells your phone to play its ringtone. The 
tower also gives your phone a pair of voice channel frequencies to use for the call. 
 
The control channel also provides the pathway for SMS messages. When a friend sends you an SMS 
message, the message flows through the Short Message Centre, then to the tower, and the tower 
sends the message to your phone as a little packet of data on the control channel. In the same way, 
when you send a message, your phone sends it to the tower on the control channel and it goes from 
the tower to the Short Message Centre and from there to its destination.  

 
The actual data format for the message includes things like the length of the message, a time stamp, 
the destination phone number, the format, etc.  

2.9.2.3 Accessing internet services 
An E-mail Message 

To look at e-mail messages, an e-mail client is used (e.g. Gmail on Android). All e-mail client 
programmes generally do four things: 

 Show you a list of all of the messages in your mailbox by displaying the message headers. 
The header shows you who sent the mail, the subject of the mail and may also show the time 
and date of the message and the message size. 

 Select a message header and read the body of the e-mail message. 
 Create new messages and send them. You type in the e-mail address of the recipient and the 

subject for the message, and then type the body of the message. 
 Add attachments to messages you send and save the attachments from messages you 

receive. 

Get information (news, entertainment, etc.) from the Internet 

Staying connected has become so important that internet services moved also to mobile phones. 
That's where wireless Internet comes in, whether accessed through a Wifi spot, or using the 3G and 
4G capacities of the phones.  

                                                           
4
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2.9.3 Applications 
An ‘App’ is an application that does something – whether that’s for business, communication, or 
entertainment. In recent years, the term ‘App’ has been referred to as an application that primarily 
runs on the web (i.e. Chrome applications), or on a mobile device – such as a mobile phone or a 
tablet computer. 

The rise of smartphones and tablet computers has meant that there are now thousands of apps 
available, from simple note-taking apps, to news readers, and increasingly games. 

In terms of operating system, the two big contenders at the moment are Apple’s iOS and Google’s 
Android. Apple’s iPad runs their own iOS system, while Google’s Android system is a lot more open, 
so that other manufacturers are able to use it in on their devices. While this variety is good, it also 
means there is a wide range of screen sizes and performances which must be taken into account 
when creating an app for Android devices. 

As of March 2012, there were over 360.000 active apps in the Apple App Store, and nearly 300,000 in 
the Android Market. Nearly 700 new apps are being added daily to the Apple App Store and nearly 
1.000 are being added daily to the Android Marketplace. Games account for 16% across both 
platforms and books have about 14% of the market. 

Once you have your tablet pc, it is easy to purchase an app and install it on your device. On the iPad 
you can use Apple’s App Store directly from the device, or hook it up to your computer and 
download it through iTunes. The experience on an Android device is very similar. You can access the 
Android Market directly from the device, or go to the Market website from your computer which will 
push the app to your device. 

Apps come in a wide variety of prices, from free all the way up to almost € 1.000. As of March 2012, 
33% of the Apps were free in the Apple App Store, and 63% in the Android Market. 

 

2.9.4 Purchasing a matching device considering 

alternative text input and browsing methods5 
Following provides a quick overview of advice regarding what characteristics one needs to pay 
attention to when purchasing a new mobile phone. 

2.9.4.1 Customers who are blind or visually 

impaired 
There are many degrees of visual impairment ranging from difficulty in reading small characters 
through to complete blindness.  
 
All mobile phones incorporate displays that provide a range of options for users with visual 
impairments: 

 Tactile markers to help orient your fingers on the keypad 
 Audible or tactile feedback to confirm a button has been pressed 
 Adjustable font sizes 

                                                           
5
 http://mobileaccessibility.info 

http://mobileaccessibility.info/device.cfm?lang=eng
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 Audible cues for low battery, caller waiting or ending a call and volume level 
 Adjustable brightness/contrast controls for the display 
 The size of the main display 
 Backlit display 

The shape of the device may also be something to consider. In this case a sliding or flip phone design 
may be of interest to make it easier to answer or hang up a call.  
Voice recognition is also a very useful feature that can help people with a visual impairment. This 
allows the user to use voice commands for dialling and accessing features on the phone.  
Another feature is the ability to assign different ring tones to different numbers stored in the phone. 
Most phones have a raised dot on the number 5 to help you find your way around the keypad, as 

well as making a noise when you press keys. Others let you chose individual ringtones for different 

people. You can even set up voice-activated calling for your most popular numbers. 

Look out for: 

 Large, well spaced, keypad & raised keys 

 Audio feedback 

 Back-lit keypad 

 Adjustable contrast 

 Adjustable font size 

 Large, clear, screen display 

 Voice calling 

 Profiles 

 Audible battery indicator 

2.9.4.2 Customers who are deaf or hard of hearing 
For people with moderate to profound hearing loss using a telephone of any type can be a real 

challenge. Most mobile phones offer a range of features that can certainly make a noticeable 

difference to those with hearing difficulties, including:  

 A range of visual alerts to notify the user of incoming calls/messages  
 Adjustable volume control  
 Display of missed, received or dialled calls through call logs  
 Visual or tactile indicators showing what’s been pressed on the keypad, and visual display of 

text  
 Text based messaging options  

Two-way video conferencing allows sign language to be used to communicate. This sort of facility 
depends heavily on the network speed and video capabilities (front camera is needed) of the phone. 
Other features that may be interest include hearing aid compatibility and Text phone/TTY 
compatibility for those using such services. As the quality, immunity and customization of hearing 
aids vary greatly, hearing aid wearers should definitely test different phones before buying to ensure 
that the particular model of phone is going to work well with their hearing aid. 
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Adjustable volume, vibrating alerts and the ability to send emails are very much standard features 

today. You can also use your phone to send & receive texts. Many models can also be used in 

conjunction with an induction loop. 

Look out for: 

 Vibrating alert or flashing 

 Predictive text 

 Tactile feedback 

 Volume control 

 Changeable ringtones 

 Hearing loop 

 WAP 

 GPRS 

2.9.4.3 Customers with limited dexterity or poor 

grip 
For people with limited dexterity such as those with arthritis, operating the keypad or simply holding 
the phone can be difficult. For these people, the following features may be of interest: 

 Ability to use the phone in handsfree mode 
 Predictive text input that predicts the word and minimizes the number of key presses  
 Any key answering which allows the call to be answered by pressing any key 
 Voice recognition for dialling or accessing features within the phone 
 Design where the controls of the phone do not require pinching, twisting or rotation of the 

wrist 

Consideration may also be given to the shape of the device with a 'candy' bar design being more 
useful to avoid the extra movements that a phone with a folding or sliding design requires.  A flat 
back on the phone can also be helpful to allow for operation on a table top rather than having to be 
held.  
Optional accessories such as a Bluetooth headset or keyboard can also make life easier by making 
texting and talking much easier. 
Many phones now have voice-activated calling for your most popular numbers, while a hands-free 

loudspeaker means you don't have to hold your phone while talking. Accessories such as belt clips 

and headsets keep your mobile ready for use whatever you're doing 

Look out for: 

 Voice calling 

 Hands-free loudspeaker 

 Lightweight 

 Large, well spaced, keypad 

 Recessed keys 

 Tactile feedback 

 Vibrating alert 
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 Shock/Water/Dust resistant casing 

2.9.4.4 Speech impairment 
People that have speech related accessibility needs will tend to rely on the text-based features of 
phones to help them communicate effectively. These options may include: 

 Text Messaging/SMS (including making reusable sms’es) 
 Email 
 Instant Messaging 
 Real-time texting 
 Multi-media Messaging 
 Predictive Text 

2.9.4.5 Cognition 
Ensuring menus and instructions are clear and simple to understand, providing simple instructions 
when something is required from the user and providing enough time for people to enter the 
required information are all features that most people will benefit from. 
Another useful feature is the ability to associate photos with telephone numbers in the phones 
memory. Other features that may be useful include: 

 Having a choice between audio, visual or vibrating alerts to let users know when they're 
receiving a call 

 Keys provide audio, visual and tactile feedback when pressed 
 Popular functions such as placing a call can be controlled by repeating pre-recorded voice 

commands 
 Help menus designed to anticipate the information being sought 
 Keypad shortcuts to make every step quick and efficient  

2.9.4.6 Mobile security
6
 

While the number of immediate threats to mobile devices remains relatively low in comparison to 

threats targeting PCs, there have been new developments in the field. And as malicious code for 

mobile begins to generate revenue for malware authors, there will be more threats created for these 

devices, especially as people increasingly use mobile devices for sensitive transactions such as online 

shopping and banking. 

Security company Symantec has classified the types of threats into a variety of categories based on 

their functionality. The following are specific definitions of each subcategory: 

 Collects Device Data—gathers information that is specific to the functionality of the device, 
such as IMEI, IMSI , operating system, and phone configuration data. 

 Spies on User—intentionally gathers information from the device to keep monitor a user, 
such as phone logs and SMS messages, and sends them to a remote source. 

                                                           
6
 Based on 

http://www.symantec.com/threatreport/topic.jsp?id=threat_activity_trends&aid=analysis_of_mobile_threats  

http://www.symantec.com/threatreport/topic.jsp?id=threat_activity_trends&aid=analysis_of_mobile_threats
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 Sends Premium SMS—sends SMS messages to premium-rate numbers that are charged to 
the user’s mobile account. 

 Downloader—can download other risks on to the compromised device. 
 Back door—opens a back door on the compromised device, allowing attackers to perform 

arbitrary actions. 
 Tracks Location—gathers GPS information from the device specifically to track the user’s 

location. 
 Modifies Settings—changes configuration settings on the compromised device. 
 Spam—sends spam email messages from the compromised device. 
 Steals Media—sends media, such as pictures, to a remote source. 
 Elevates Privileges—attempts to gain privileges beyond those laid out when installing the 

app bundled with the risk. 
 Banking Trojan—monitors the device for banking transactions, gathering the sensitive details 

for further malicious actions. 
 SEO Poisoning—periodically sends the phone’s browser to predetermined URLs in order to 

boost search rankings. 

Mobile applications (“apps”) with malicious intentions rose to prominence in 2011, presenting 

serious risks to users of mobile devices. These metrics show the different functions that these bad 

mobile apps performed during the year. The data was compiled by analyzing the key functionality of 

malicious mobile apps. Symantec has identified five primary mobile risk types:  

 Collect Data. Most common among bad mobile apps was the collection of data from the 

compromised device. This was typically done with the intent to carry out further malicious 

activities, in much the way an information-stealing Trojan might. This includes both device- 

and user-specific data, ranging from configuration data to banking details. This information 

can be used in a number of ways, but for the most part, it is fairly innocuous with IMEI8 and 

IMSI9 numbers, taken by attackers as a way to uniquely identify a device. More concerning is 

data gathered about the device software, such as operating system (OS) version or 

applications installed, to carry out further attacks (say, by exploiting a software vulnerability). 

Rarer, but of greatest concern is when user-specific data, such as banking details, is gathered 

in an attempt to make unauthorized transactions. While this category covers a broad range 

of data, the distinction between device and user data is given in more detail in the 

subcategories below. 

 Track User. The next most common purpose was to track a user’s personal behaviour and 

actions. These risks take data specifically to spy on the individual using the phone. This is 

done by gathering up various communication data, such as SMS messages and phone call 

logs, and sending them to another computer or device. In some instances they may even 

record phone calls. In other cases these risks track GPS coordinates, essentially keeping tabs 

on the location of the device (and their user) at any given time. Gathering pictures taken with 

the phone also falls into this category. 

 Send Content. The third-largest group of risks is bad apps that send out content. These risks 

are different from the first two categories because their direct intent is to make money for 

the attacker. Most of these risks will send a text message to a premium SMS number, 

ultimately appearing on the mobile bill of the device’s owner. Also within this category are 
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risks that can be used as email spam relays, controlled by the attackers and sending 

unwanted emails from addresses registered to the device. One threat in this category 

constantly sent HTTP requests in the hopes of bumping certain pages within search rankings. 

 Traditional Threats. The fourth group contains more traditional threats, such as back doors 

and downloaders. Attackers seem keen to port these types of risks from PCs to mobile 

devices, and progress has been made in 2011.  

 Change Settings. Finally there are a small number of risks that focus on making configuration 

changes. These types attempt to elevate privileges or simply modify various settings within 

the operating system. The goal for this final group seems to be to perform further actions on 

the compromised devices. 

2.9.4.6.1 Viruses, Malware and Spyware7 
The mobile developer professionals are stressing that common sense is often the best defence 

against malicious attacks - don’t click on links in emails and only go to sites you trust. People tend to 

forget those advices. 

The solution to this problem is simple. Software companies have developed antivirus software for 

mobiles and Smartphone’s and the download is as simple as it would be on a PC. Here are some 

examples. 

Lookout 

Lookout is an Android virus protection software that scans every app on your smartphone and 

immediately alerts you of any mobile viruses, spyware or malware on your phone. The Android virus 

scanner remains vigilant by automatically scanning your smartphone – daily or weekly – at any time 

of day you request. In addition, the Lookout virus scan is constantly updated with the latest threat 

information. 

AhnLab Mobile Security 

AhnLab Mobile Security is a solution for viruses and worms protection that runs on Windows Mobile, 

Symbian and Palm OS. 

BitDefender Mobile Security 

BitDefender Mobile Security provides permanent antivirus protection for mobile devices running 

Symbian or Microsoft Windows Mobile. Relying on the valuable BitDefender experience in fighting 

computer threats, BitDefender Mobile Security is a light, easy to use instrument that will keep your 

mobile device on the move. 

Kaspersky Mobile Security 

Kaspersky Mobile Security is a complete protection package for the Smartphone. The package 

includes anti-theft protection, virus protection, firewall and anti-spam for SMS, EMS and MMS. 

                                                           
7
 http://www.comptalks.com/top-10-mobile-antivirus-for-download-2010/ 

http://global.ahnlab.com/en/site/main/main.do
http://www.bitdefender.com/PRODUCT-2149-en--BitDefender-Mobile-Security-v2.html
http://www.kaspersky.com/kaspersky_mobile_security
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Norton Smartphone Security 

Norton Smartphone Security is a well known antivirus package which includes anti-spam and firewall 

for Smartphone protection. The package is offered by Symantec. 

ESET Mobile Antivirus 

A fully integrated real time protection package against any malicious attacks to your Smartphone. Its 

On-Demand Scanning includes scanning of principle memory and portable memory media, full 

memory and running processes scan. Specific folder scanning is also possible. Advanced On-Access 

protection offers effective scanning of all created/used files with enhanced virus detection 

capabilities and access time. Scanning of files incoming via wireless connections is covered 

(Bluetooth, Wi-Fi, Infrared). Like others it also provides SMS spam protection and a user friendly 

activity log. 

Whatever mobile antivirus you go for, a few extra tips to protecting your phone is to never accept 

any content on Bluetooth if you do not know the sender. Be very cautious when installing third party 

softwares such as games, ringtones, wallpapers, or theme-packs. 

2.9.4.6.2 5 Privacy Tips for Mobile App Users8  
Look For Signs Of Trust 
Check consumer reviews before you download an app. Users are quick to publicize bad experiences 

so you can typically find out if you’re dealing with a “scammy” or “spammy” app by reading recent 

reviews of the app in your mobile app marketplace or store. 

Read App Privacy Policy 
An app should contain a privacy policy or link to an external policy – contact the app developer and 

request this information if they fail to include it. An app’s privacy policy contains important 

disclosures, such as what information the app collects and how it uses that information. Some apps, 

for example, may access your contact information or notify your social contacts of your app use after 

asking you to sign-in using your existing email or social network log-in credentials. Activities like this 

are disclosed in an app’s privacy policy so by reading it you can make informed decisions about 

sharing your personal information. 

An app’s privacy policy is typically found under the “Settings” or “About this App” tab, or as a link at 

the bottom of the app screen. 

Review and Set App-Level Privacy Settings 
Many mobile apps have privacy settings within the app itself, typically via a “Settings” or “Privacy” 

tab on the home screen or control panel. These settings can manage activities like whether the app 

can access your location information. Before using an app, review the privacy default settings on the 

app to make sure you agree with them. 
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Some apps engage in mobile ad targeting, collecting information about your online activity or using 

such information to deliver you targeted ads on your mobile phone. It may be possible to opt-out of 

targeted mobile advertising directly within the app privacy settings, but in some cases these opt-outs 

may only be available via the company’s traditional website. 

Review and Set OS-Level Privacy Settings 
Most mobile operating systems (OS), including iOS (iPhone), Android, and Blackberry, offer privacy 

settings. By using OS privacy settings, for example, you can usually turn off the phone’s ability to geo-

locate you, thus denying all apps the ability to access your location data. You can also use these 

settings to create a password to access the phone, a smart idea if you have sensitive information 

stored on it that could be compromised in the event of phone theft or loss. If you’re using the 

Android mobile OS, for example, you can find the phone’s location privacy settings under the 

“Settings” menu option. Android users can deny or allow various location permissions on their 

phones, such as permitting wireless networks to detect their position or enabling GPS satellite 

location. iPhone users, via their OS privacy settings, can restrict or allow location data sharing on an 

app by app basis. For example, iPhone users might want to allow map and restaurant apps to access 

their location data, but restrict gaming apps from accessing this information. 

Pay Attention to Pop-Up Notices 
Many mobile apps may ask to show you pop-up alerts or will display them by default. Usually, these 

pop-ups are about app updates or activity (such as a friend request), but sometimes you’ll see 

privacy pop-ups, like a pop-up requesting your location data. It’s worth taking five seconds to read 

these short notices before clicking “accept” or “ok”. Also, if you turn off an app’s notifications, be 

aware that you may disable privacy-related pop-up notices as well. 

2.9.5 Communication software 
Almost all mobile smartphones and tablets have the ability to use the communication software 

mentioned in the previous section (2.8 Communication Software), therefore the use of Skype, MSN 

and Google Talk is similar and follows the principles described. In the following paragraphs we will 

make a quick review of the installation and use of the two main communication applications, Skype 

and Google Talk. The User Interface in both cases is almost the same and the experience of the User 

in handling the applications in a desktop / laptop environment or a smartphone / tablet has minor 

differences. 

2.9.5.1 Skype 
For Android OS, we use the mobile app repository, Google Play, to search and find Skype for Android. 

For other mobile operating systems download and installation is also possible through the official 

website of Skype (Symbian, Windows, IOS, etc. http://www.skype.com/intl/en-us/get-skype/). 

http://www.skype.com/intl/en-us/get-skype/
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Figure 205: Finding Skype app in Google Play 

We select the app, by tapping on the relevant icon, and select to install it.  
 

 
Figure 206: Skype installation process in Android 

At the next prompt, we select the “download and install”. 
 
When the installation process is completed, we select “Open”. We assume at this point that the User 
will have an existing Skype account used with his / her desktop or laptop (otherwise the user may 
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follow the steps of creating one through the mobile app) and a working wifi or data connection. The 
user enters the login credentials to the relevant input fields, and the application connects to the 
Skype service 
 

 
Figure 207: User has logged-in to his / her Skype account through the smartphone 

The User can then open the contacts (the same ones existing on his / her desktop Skype installation), 
select one or more contacts in order to start a chat or a voice call, or a video call, or transfer a file. 
 

 
Figure 208: Contact list on Skype installed on an Android smartphone 
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Figure 209: The User has selected a contact to communicate (Voice / Video call or Chat or by sending a file) 

2.9.5.2 Google Talk 
Google Talk (GTalk) is an embedded application to all Android smartphones, but can also be 

downloaded and installed to devices with other operating systems (Windows mobile, blackberry, 

etc.) With Google Talk, we can do the following: 

- Text chat 
- Voice chat 
- Video chat 

 

 
Figure 210: Contact list of a Google Talk installation on an Android smartphone 
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Figure 211: Text chat (IM) with a contact via Google Talk. (Video and Audio chat is also available) 

2.9.5.3 Gestures 
These days, the use of a contemporary smartphone or tablet device provides convenient and hassle-
free ways of operating trivial tasks, such as browsing, searching, writing and reading to and from our 
apparatus. Smart phone users have focused a lot on the voice-oriented operation and control of their 
phone by interacting through Google's Voice Actions and Vlingo. But talking to a high-tech device 
isn't always a practical option, especially when the user has a disability. 
Touch screens are a great way to interact with applications on mobile devices, where users can easily 
tap, drag, interactively zoom-in/out, or slide the screen, quickly performing specialised actions in 
their favourite applications. Gestures are a common feature in touch or multi-touch screens and 
hence are commonly used in smartphones and tablets. This subject was analysed in a previous 
section (2.2.3) but here we are going to make a review and a specific reference to Android gestures 
for version 4.0.x of the OS. 
 
Gestures allow users to interact with your app by manipulating the screen objects provided. The 
following table shows the core gesture set that is supported in Android 4.0.x. 
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Figure 212: Touch gesture 

Touch gesture - Triggers the default functionality for a given item. 
Action: Press, lift 
 

 
Figure 213: Long press gesture 

Long press gesture - Enters data selection mode. Allows you to select one or more items in a view 
and act upon the data using a contextual action bar. Avoid using long press for showing contextual 
menus. 
Action: Press, wait, lift 
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Figure 214: Swipe gesture 

Swipe gesture - Scrolls overflowing content, or navigates between views in the same hierarchy. 
Action: Press, move, lift 
 

 
Figure 215: Drag gesture 

Drag gesture - Rearranges data within a view, or moves data into a container (e.g. folders on Home 
Screen). 
Action: Long press, move, lift 
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Figure 216: Double touch gesture 

Double touch gesture - Zooms into content. Also used as a secondary gesture for text selection. 
Action: Two touches in quick succession 
 

 
Figure 217: Pinch open gesture 

Pinch open gesture - Zooms into content. 
Action: 2-finger press, move outwards, lift 
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Figure 218: Pinch close gesture 

Pinch close gesture - Zooms out of content. 
Action: 2-finger press, move inwards, lift 
 

 
Figure 219: Two finger scroll gesture 

Two finger scroll gesture - Scrolls content up / down. 
Action: 2-finger press, move up / down, lift 
 

2.9.5.4 QR Codes 
QR code is the trademark for a type of matrix barcode (two-dimensional code) first designed for the 
automotive industry.  
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Figure 220: QR code paradigm 

More recently, the system has become popular outside the industry due to its fast readability and 
large storage capacity compared to standard linear barcodes. The code consists of black modules 
(square dots) arranged in a square pattern on a white background. The information encoded can be 
made up of four standardised kinds ("modes") of data (numeric, alphanumeric, byte/binary, Kanji), or 
through supported extensions, virtually any kind of data.  
 
QR codes in ICT are used for several occasions such as: to create website links, store phone numbers, 
email ids, direction, etc. QR Codes can be used in Google's mobile Android operating system via 
Google Goggles application or 3rd party barcode scanners like ZXing. The browser supports URI 
redirection, which allows QR Codes to send metadata to existing applications on the device.  
Nokia's Symbian operating system features a barcode scanner which can read QR Codes. For Apple 
iOS, a QR Code reader is not natively supported, but there are numerous paid and free apps available 
with both scanning capabilities and hard-linking to URI.  
BlackBerry devices with the App World application, have the ability to natively scan QR Codes and 
load any recognized Web URLs on the device's Web browser. Windows Phone 7.5 is able to scan QR 
Codes through the Bing search app. 
 

2.10 Accessible ICT: What Is There For Me? 
Using ICT is one thing, but what if I have a disability that necessitates me to use supportive 

technology to make adequate usage of ICT? 

Following sections provide a concise overview of relevant initiatives that might be of interest to 

people with disabilities. 

2.10.1 Europe 
Assistive Technologies related projects and initiatives: 

 ATLEC project - www.atlec-project.eu: This project aims to create an AT ICT curriculum, 
focused towards people with disabilities to empower them in becoming more aware about 
relevant ICT based assistive technologies that can help them in gain and or maintain 
employment. 

 EASTIN Network - www.eastin-cl.eu/eastin: EASTIN is a European network that offers 
information on assistive technology to all citizens. It is the most comprehensive web-service 
in Europe on assistive technology, due to the joint effort of the partners in the EASTIN 
project and to the European Commission which initially financed part of the work. The core 
of the network is the EASTIN website www.eastin.info. This website provides, in all official 
languages of the European Union, and in a user-friendly and accessible manner, a complete 

http://www.atlec-project.eu/
http://www.eastin-cl.eu/eastin
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set of information and guidance tools concerning assistive technology. It includes 
information on over 50.000 assistive technology products available on the European market 
and over 5.000 manufacturers / suppliers; it also includes related info such as fact sheets and 
suggestions on assistive solutions for daily living problems. 

 Oatsoft - www.oatsoft.org: OATSoft is dedicated to improving Assistive Technology and 
computer accessibility through the power of Open Source development techniques. OATSoft 
makes the best Open Source Assistive Technology Software (OATS) easy to find.   

2.10.2 Belgium 
Assistive technologies: 

 ICTwijs - http://www.ictwijs.eu/index.cfm?ee=2|262 

 Steunpunt Dyslexie - http://www.steunpuntdyslexie.nl/dyslexie-op-school/aanpassingen-en-
hulpmiddelen/ 

 Center for Assistive Technology - Coaching in Hulpmiddelen - http://www.cat-
ch.eu/Wat%20bieden%20we/Wat%20bieden%20we.html 

 Dyslexiewegwijzer - http://www.dyslexiewegwijzer.nl/cms/ict-hulpmiddelen.html 

 Instituut Samenleving en Technologie (till 2013) - 
http://www.samenlevingentechnologie.be/ists/index.html 

 ICT en Handicap - http://www.ictenhandicap.nl/ondersteunde_communicatie.htm 
 
Advisory organisations: 

 Toegankelijkheidsbureau - http://www.toegankelijkheidsbureau.be 

 Enter vzw – http://www.entervzw.be 

 Westkans vzw – http://www.westkans.be 

 Werkgroep Vorming & Aktie - http://www.wvavzw.be/ 
 
Belgian computer- and internet organisations for blind and visual impaired: 

 AnySurfer - http://www.anysurfer.be/, http://www.toegankelijkheidsmonitor.be/ 

 Computeracademie vzw – Vigitac ICT-projects - http://www.computeracademie.be/vigitac/ 

 GOCI vzw - http://www.goci.be/ 

 ICTwijs - http://www.ictwijs.be/ 

 Infovisie vzw - http://www.infovisie.be/ 

 MODEM Communicatie- en Computercentrum - http://www.modemadvies.be/ 

 Open IT - http://www.openit.nu/ 

 Webbra - http://www.webbra.be/ 

 Centre de Ressources et d’Evaluation de Technologies pour les personnes Handicapées 
(CREH) - http://www.fundp.ac.be/medecine 

 La Place des Ados - http://www.ados.ciger.be/index.html 

 Axistive - http://www.axistive.com/ 

 Blinden en slechtzienden - http://www.facebook.com/pages/Blinden-en-
slechtzienden/168310585097 

 TReyeIT - Uitleendienst van geavanceerde hulpmiddelen voor personen met een 
visusbeperking - http://www.treyeit.be 

 GOCI vzw - http://www.goci.be/ 

 Sclera vzw – http://www.sclera.be 

 Luisterpuntbibliotheek - http://www.luisterpuntbibliotheek.be/ 

 Kamelego - http://www.kamelego.be/ 

 SPK vzw – Digidak - http://www.digidak.be/ 

http://www.oatsoft.org/
http://www.ictwijs.eu/index.cfm?ee=2|262
http://www.steunpuntdyslexie.nl/dyslexie-op-school/aanpassingen-en-hulpmiddelen/
http://www.steunpuntdyslexie.nl/dyslexie-op-school/aanpassingen-en-hulpmiddelen/
http://www.cat-ch.eu/Wat%20bieden%20we/Wat%20bieden%20we.html
http://www.cat-ch.eu/Wat%20bieden%20we/Wat%20bieden%20we.html
http://www.dyslexiewegwijzer.nl/cms/ict-hulpmiddelen.html
http://www.samenlevingentechnologie.be/ists/index.html
http://www.ictenhandicap.nl/ondersteunde_communicatie.htm
http://www.toegankelijkheidsbureau.be/
http://www.entervzw.be/
http://www.westkans.be/
http://www.wvavzw.be/
http://www.anysurfer.be/
http://www.toegankelijkheidsmonitor.be/
http://www.computeracademie.be/vigitac/
http://www.goci.be/
http://www.ictwijs.be/
http://www.infovisie.be/
http://www.modemadvies.be/
http://www.openit.nu/
http://www.webbra.be/
http://www.fundp.ac.be/medecine
http://www.ados.ciger.be/index.html
http://www.axistive.com/
http://www.facebook.com/pages/Blinden-en-slechtzienden/168310585097
http://www.facebook.com/pages/Blinden-en-slechtzienden/168310585097
http://www.treyeit.be/
http://www.goci.be/
http://www.sclera.be/
http://www.luisterpuntbibliotheek.be/
http://www.kamelego.be/
http://www.digidak.be/
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 Ithaka vzw – http://www.vzw-ithaka.be 

 Flemish Disability Agency VAPH, Brussels - http://www.vaph.be/vlafo/view/nl/10525-
Hulpmiddelen.html 

2.10.3 Cyprus 
Education and other training centres for basic ICT skills 

 Christos Steliou Joannou Foundation (www.ioannoufoundation.org) 

 Deaf School Cyprus (http://agrino.org/deafschoolcy/) 

 School for the Blinds (http://eid-scholi-tyflon-lef.schools.ac.cy) 

 Cyprus Private Training Centers Association (http://www.sifk.org.cy/) 

 Epiteygma-ICT Training Center for PwDs (http://www.epiteugma.com/) 

 G.E. English Center (http://ge-centre.com/) 

 New hope Private Special & Tutorial Schools (http://www.newhope.com.cy/) 

 MK Prosopsis CYPRUS ASSISTIVE TECHNOLOGY - special education Cyprus 
(http://www.mkprosopsis.com/) 

 SE.S and ICTEACH, CYPRUS (www.icteach.org/) 

 Cybernet Training Centers (www.cybernet.ac.cy) 

 eduCyber (http://www.educyber.com/) 

 Futurekids (www.futurekidscyprus.com) 

 CompuSuccess (http://www.compusuccess.net/) 

2.10.4 Greece 
 Open source and freeware accessibility and assistive software: 

http://access.uoa.gr/fs/eng/pages/home 

2.10.5 Lithuania 
 Baltijos Kompiuteriu Akademija - http://moodle.bka.lt/ - Basic ICT training resources 

2.10.6 UK (English language resources) 
Basic ICT Training 

 ALISON http://alison.com/course/category.php?id=1 “Whether you are new to computing or 
have some experience, this curriculum will help you develop a fundamental understanding of 
computers. The courses help you learn the essential skills to begin computing with 
confidence, be more productive at home and at work, stay safe online, use technology to 
complement your lifestyle, and consider careers where you can put your skills to work.” 

 BBC WebWise - http://www.bbc.co.uk/webwise/courses/computer-basics - A set of learning 
objects consisting of a mix of interactive video and games and text based documents. 
Inaccessible to non-mouse users. Topics include: Your computer, using the web, email and 
sharing, safety and privacy. 

 BBC Raw http://www.bbc.co.uk/raw/computers/yourcomputer/index.shtml Provides a 
further set of BBC computer training resources includinf computer basics, the mouse, the 
keyboard, icons and windows, music and photos, printing, internet basics, internet browsers, 
searching the internet, registering a website, shopping online and using email. 

 ECDL (The European Computer Driving License) - 
http://www.homeandlearn.co.uk/BC/ecdl.html 

 Excellence gateway - http://www.excellencegateway.org.uk/ A portal of submitted learning 
resources from the Learning and Skills Improvement Service (LSIS). It gives you access to the 

http://www.vzw-ithaka.be/
http://www.vaph.be/vlafo/view/nl/10525-Hulpmiddelen.html
http://www.vaph.be/vlafo/view/nl/10525-Hulpmiddelen.html
http://www.ioannoufoundation.org/
http://agrino.org/deafschoolcy/
http://eid-scholi-tyflon-lef.schools.ac.cy/
http://www.sifk.org.cy/
http://www.epiteugma.com/
http://ge-centre.com/
http://www.newhope.com.cy/
http://www.mkprosopsis.com/
http://access.uoa.gr/fs/eng/pages/home
http://moodle.bka.lt/
http://alison.com/course/category.php?id=1
http://www.bbc.co.uk/webwise/courses/computer-basics
http://www.bbc.co.uk/raw/computers/yourcomputer/index.shtml
http://www.homeandlearn.co.uk/BC/ecdl.html
http://www.excellencegateway.org.uk/
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most comprehensive collection of information and resources, networks and development 
opportunities, brought together specifically for the further education and skills sector. 

 FreeEd.net The Free Education Network - http://www.free-ed.net/free-
ed/Navigation/Level01/Level02/02_CompInfoTech/02_Comp_InfoCommTech.asp A 
collection of online courses – including introductions to coding in several languages 

 Goodwill Community Foundation - http://www.gcflearnfree.org/computers - A suite of free 
resources to teach a number of topics including computer basics, internet basics, email 
basics, social media basics, Google, Microsoft Office, Windows, Apple Mac OSX, Google Docs, 
Microsoft Word, Microsoft Excel, Microsoft Powerpoint, Microsoft Access, and OpenOffice. 

 Home and Learn, free computer tutorials - 
http://www.homeandlearn.co.uk/BC/BeginnersComputing.html 

 Microsoft Digital Literacy resources – A free basic ICT curriculum developed by Microsoft 
http://www.microsoft.com/About/CorporateCitizenship/Citizenship/giving/programs/UP/dig
italliteracy/eng/default.mspx 

 Priory Woods School and Arts College provides a number of free game resources to develop 
skills in ICT literacy and maths. These resources are aimed at users with intellectual disability. 
http://www.priorywoods.middlesbrough.sch.uk/page_viewer.asp?page=Free+Program+Reso
urces&pid=161 

 ViPi at http://www.vipi-project.eu/ – Accessible ICT training resources for people with 
disabilities 

 CBeebies – the BBC provides some switch accessible games on its CBeebies website. 
http://www.bbc.co.uk/cbeebies/games/theme/switch/ 

Assistive Technologies: 

 ACE Centre at http://www.ace-centre.org.uk   initiative on communication devices – 
bumblebee 

 BBC _ My Web My Way http://www.bbc.co.uk/accessibility/guides/ - A number of guides to 
assist people with disabilities to access information online. 

 Teach-ICT presents a list of recent news articles relevant to the use of ICT by people with 
Disabilities. http://www.teach-ict.com/news/news_stories/news_disability_and_ict.htm 

 A list of Assistive Technology Resource Centre which may provide useful tutorials, software 
reviews etc.http://webtoolboxes.wikispaces.com/AT 

2.11 Safety and Security 
The Internet has so many advantages and potentials that outweigh possible risks. Even so, Internet 

users should be aware of these risks and know how to eliminate them. To emphasize on the 

criticality of the subject, you should know that even the Governments themselves realize the need to 

protect their citizens from risks and danger while surfing on the Internet. Therefore, dedicated 

Internet Centers are being established in each country, with the aim to promote the safer use of the 

Internet. You may find the Web site to the respective Center in your country, in Table 18. Through 

these Websites you can report any illegal or annoying content that you might come across on the 

Internet simply by clicking on dedicated links in the first page in their Web site and filling in forms.  In 

addition, helplines are provided where you can ask for help (through chat, email, phone) about 

problems that you may face while using the Internet. 

Specific information about how to configure and use your computer and respective software, are 

discussed in the following subsections. 

http://www.free-ed.net/free-ed/Navigation/Level01/Level02/02_CompInfoTech/02_Comp_InfoCommTech.asp
http://www.free-ed.net/free-ed/Navigation/Level01/Level02/02_CompInfoTech/02_Comp_InfoCommTech.asp
http://www.gcflearnfree.org/computers
http://www.homeandlearn.co.uk/BC/BeginnersComputing.html
http://www.microsoft.com/About/CorporateCitizenship/Citizenship/giving/programs/UP/digitalliteracy/eng/default.mspx
http://www.microsoft.com/About/CorporateCitizenship/Citizenship/giving/programs/UP/digitalliteracy/eng/default.mspx
http://www.priorywoods.middlesbrough.sch.uk/page_viewer.asp?page=Free+Program+Resources&pid=161
http://www.priorywoods.middlesbrough.sch.uk/page_viewer.asp?page=Free+Program+Resources&pid=161
http://www.bbc.co.uk/cbeebies/games/theme/switch/
http://www.ace-centre.org.uk/
http://www.bbc.co.uk/accessibility/guides/
http://www.teach-ict.com/news/news_stories/news_disability_and_ict.htm
http://webtoolboxes.wikispaces.com/AT
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2.11.1 Operating System (OS) and software 

updates 
Operating systems are the most important type of software on a computer since they are responsible 

for starting the computer and allowing users to install and run all other software tools. As such, 

protecting the operating system from malware (malicious software) or other risks is the most crucial 

part in system security. 

The first step is to make sure that you install the current OS updates. These updates are offered by 

the OS creator and, as the name suggests, they keep the system up to date by fixing any detected 

vulnerabilities. As an example, we shall illustrate how to install these updates on the Windows 7 

operating system and how to configure the OS to install them automatically. 

From the start  button on your computer’s desktop, write “Windows Update” in the search box, 

wait for the option to appear (as in the figure below) and then click on its name (Figure 221). 

 

Figure 221: Using the start panel to launch the Windows Update tool 

The main window of the Window’s update software tool will appear (Figure 222) and in case there 

are available updates for the OS that are not already installed on your computer, it will display the 

amount and their size: 
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Figure 222: The main window of the Windows Update tool, displaying available updates 

Otherwise a message will indicate that your system is up to date (Figure 223): 

 

Figure 223: The main window of the Windows Update tool, displaying a message that indicates up to date system 

In case your OS is configured to provide updates’ notifications, when updates are available a 

notification icon (and a balloon) will appear at the bottom right of your screen (Figure 224): 

 

Figure 224: Notification about availability of new updates at the bottom-right of the screen 

You can launch the Windows update tool by double clicking on the icon (or the balloon), an 

alternative way to the one described above. Either way, you will be transferred to the main window 

and you will have to select the updates to be installed. Click on the blue text indicating the available 

number of updates (Figure 225): 
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Figure 225: Text indicating the available number of updates 

Then select the updates for installation by ticking their box and click OK (Figure 226). Usually it is 

recommended to install all the updates in the list as some are required by other programs e.g. MS 

Word, to work properly. 

 

Figure 226: Selecting the updates which you wish to install and clicking ok to start the process 

Finally select the  button to start the downloading and installation procedure. When 

the process is completed the main window will change to green status indicating the successful 

installation of updates (Figure 227).  

 

Figure 227: Indication of successful installation of updates, as soon as this is finished 

There are cases where some updates require a restart of your computer in order to complete their 

installation. You can restart your computer either immediately or at a later stage, however make 
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sure that you do not disconnect the power supply in order not to disturb the update process. You 

also have the option to configure updates to be automatically installed. To do so, select the “Change 

settings” option from the left list, choose the “Install updates automatically” option and select OK. 

2.11.2 Antivirus Programs 

Another important category of software tools for system security are the antivirus programs. These 

programs scan your files and the data downloaded from the Internet (or from other sources), detect 

any malware (malicious software) and provide proper notifications and actions to avoid damaging 

your computer. There are many proprietary antivirus tools which you can buy from the software 

market (either via the Internet or from shops). Currently there are many free antivirus programs on 

the Internet. Table 17 gives a list with the most popular ones and their websites: 

Table 17: List of the most popular Antivirus software tools 

Antivirus Logo Website 

Avast! Free Antivirus 
 

http://www.avast.com/free-antivirus-download  

AVG Anti-Virus Free 
 

http://free.avg.com/  

Microsoft Security 

Essentials  
http://windows.microsoft.com/mse  

Avira AntiVir Personal 

 

http://www.avira.com/en/avira-free-antivirus  

 

We use the Avast! free edition as example to illustrate basic functions, how to protect your computer 

and your data from viruses. All the programs mentioned above provide similar functionality and it is 

up to the user to choose which one to use. 

Antivirus programs once installed are default always active, but without interrupting the user. They 

run in the background and scan every file you open or receive/download from the Internet.  

There are a lot of potential viruses (one type of malware) sources which you must be aware of. The 

first one is downloading files from the Internet. The most dangerous file-type is the one used for files 

able to start a process on your computer, called executables (ending in .exe). As a result you must 

only open executables downloaded from trustworthy sites. Email is another common source of virus 

infections. Attachments may contain a virus, so if you are not sure of their source/sender avoid 

opening them. Also removable media such as flash drives and CDs are a potential virus source and 

should be scanned before opening as we explain in the following. 

http://www.avast.com/free-antivirus-download
http://free.avg.com/
http://windows.microsoft.com/mse
http://www.avira.com/en/avira-free-antivirus
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You can launch the antivirus tool from the desktop or from the start panel but you can also launch it 

by double clicking on its task bar icon on the bottom right of the screen (Figure 228). 

 

Figure 228: The icon of the Antivirus software on the task bar 

The main screen of the tool reports your antivirus status. Most antivirus tools download and install 

automatically updated lists with all detected and known viruses (known as definitions). However, 

there exist cases when this is not done automatically, if not configured so. Therefore, it is 

recommended to update them before scanning your computer. To do so locate and select your 

antivirus tool’s “Maintenance” or “Update” option (Figure 229): 

 

Figure 229: The maintenance window of the avast Antivirus software tool 

To scan your computer, locate the “Scan” option (Figure 230) where you might be given options 

about the scan you would like to perform with descriptions for their purpose: 
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Figure 230: The Scan option from the avast antivirus main window 

If you would like to scan a group of files and folders (or a single file), select them and right click on an 

item from the group. Then from the pop up screen (Figure 231), select the “Scan with ....” (where you 

will see your antivirus’ program name) or the text “Scan filename.type”. 

 

Figure 231: Selecting a single file in your local file system and choosing to scan it by right-clicking 

2.11.3 Personal Firewalls 
An additional protection measure against Internet’s dangers is a personal firewall. Personal firewall is 

a software tool that checks what kind of data your computer sends and receives and blocks 

potentially dangerous traffic (sent and/or received data).  Again, there are plenty of free firewalls 
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available online and Windows 7 also has its own firewall installed together with the OS. To check if it 

is currently active, from the start panel , search for the “Windows firewall” (Figure 232). 

 

Figure 232: Finding the Windows Firewall tool from the Start panel 

If the firewall statuses are both green then the firewall is ON, as shown in Figure 233 below: 

 

Figure 233: Window showing the status of the firewall as ON 

If they are red, click on the “Use recommended settings” to enable the firewall protection (Figure 

234): 
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Figure 234: Window showing the status of the firewall as OFF and providing options to update it and set it up 

Firewall tools, like antivirus tools, work silently in the background and take care of the system’s 

protection to prevent any unwanted infections (traffic of malicious files or data from/to your 

computer). 

2.11.4 Web security 
As mentioned earlier in Section 2, there are some basic prerequisites to consider for a pleasant and 

safe web experience. Critical and sensitive information is transferred every second over the Internet. 

If this information is not protected, it would be exposed to anyone who would attempt to steal it. As 

a result, the connection between a user and a Web page, when sensitive information is exchanged, 

should be encrypted and secured. This encryption is even more necessary when personal details, for 

example passwords and credit card numbers are among the information exchanged. By encryption, it 

is ensured that when information is transferred though the Internet, anyone that intervenes in the 

communication channel, will not understand its content. On the other hand, the correct receiver has 

the proper keys to decrypt and understand the information. To find out more about encryption and 

how to recognise encrypted websites please refer to Section 2 Web security. Then you may read 

further in this section where the issues of security and safety in Internet usage are analysed in more 

depth.  

2.11.4.1 Safe online search 
When searching for information on the Internet, a user may come across irrelevant but offensive 

content due to the fact that everyone is free to post information online. Fortunately, search engines 

are aware of this and have taken measures to protect their users by introducing the Safe Search 

option. This option acts like a smart filter that checks the results before the users access them and 

blocks any offensive content from reaching the final set of results. Usually this feature is enabled by 

default but in the following we illustrate how to enable/disable it. 

For Google.com you will need to click on the gear symbol on the top right and select “search 

settings”. Then depending on how much you want your results to be filtered, move the slider to the 

correct position and click save at the bottom of the page (Figure 235). 
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Figure 235: Defining the search settings and the level of desired filtering of results for protection reasons, in Google 

For the Bing search engine the process is quite similar. Click on the link Preferences on the top-right 

corner of the page, then select the protection level from the list appearing on the page and finally 

click on the Save button on the right (Figure 236). 

 

 
Figure 236: Defining the search settings and the level of desired filtering of results for protection reasons, in Bing 

2.11.4.2 Important rules for secure Internet use 
In course 2 Web browsing and security, an introduction was provided to the kind of malware 

(malicious software) that exists. In this course we illustrated how to use an antivirus and a firewall to 

protect your computer from infections. In the following we shall revise some important rules to keep 

in mind while surfing the web. The list is non-exhaustive; however, it covers the most important 

aspects. 

 

 Do not visit websites whose reliability you are not sure of.  

 Avoid clicking on pop up advertisements that might ask you for personal information to win a 

price, participate in a lottery, etc. 

 Never download files from websites whose purpose you do not know 

 Always look for the secure connection indicator before entering sensitive information like 

passwords or credit card details.  

 If the website does not use encrypted connection and you are not sure, do not enter any 

details to avoid unwanted access to your personal details. 

 Be very careful when you share personal pictures. 
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 When people unknown to you try to contact you by email or by friend requests you must be 

sure to know them before you reply.  

 Avoid opening emails and messages from people unknown to you. 

2.11.5 More security settings 
Many websites try to draw your attention by opening new advertisement windows while browsing 

their content. This technique, also called “pop up advertising”, sometimes might hide potential risks 

such as viruses or spoofing websites. At some occasions, offensive content may pop up as well. In 

order to avoid all these, modern web browsers offer built-in pop up prevention.  

To enable the pop up blocker in e.g. Internet Explorer 9, select ToolsPop-up BlockerTurn on Pop-

up Blocker (Figure 237). 

 

Figure 237: Enabling the Pop-up blocker in Internet Explorer 9 

In addition, in case you do not want the browser to store visited pages and other data, (in case, for 

instance the computer that you using is at an Internet café), you can use a privacy mode to prevent 

unwanted intrusion. This mode is known as “InPrivate browsing” for Internet Explorer 9 (or Private 

Browsing for Mozilla Firefox and Incognito mode for Google Chrome) and can be launched by 

selecting ToolsInPrivate Browsing (Figure 238). 
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Figure 238: Selecting the option InPrivate Browsing in Internet Explorer 9 

The new window (Figure 239) will have an indicator in the address bar, to indicate that you are using 

a private session that does not store anything: 

 

Figure 239: Window confirming that the InPrivate Browsing option is turned on 

2.11.6 Illegal content 
While surfing the Internet you might come across different types of data whose distribution is illegal. 

For example, a website that offers free downloading of a song that normally is sold at music stores. 

The illegal downloading of songs without the permission of the original author is known as music 

piracy. Moreover, Web piracy extends to other types of media such as movies and software. The 

distribution of these files is prohibited by law and there are cases where people faced justice and got 

severe financial penalties. As such, before downloading software and media, you have to be sure that 

their distribution is not illegal and if you think it is, you can report them to your country’s 

organisation against web piracy. 
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Table 18, below provides a non-exhaustive list with some countries and the websites of the 

dedicated authorities, with more information on protecting yourself and reporting illegal content: 

Table 18: Non-exhaustive list of websites of authorities acting for cyber security in different countries 

Country Website 

Belgium http://www.saferinternet.be/ 

http://www.clicksafe.be/ 

United Kingdom http://www.saferinternet.org.uk/ 

http://www.getsafeonline.org/ 

Greece http://www.saferinternet.gr  

Cyprus http://www.cyberethics.info/cyethics1/  

Lithuania http://www.draugiskasinternetas.lt/lt 

2.11.7 Social Networking 
In course 2-Web Browser and security we introduced the concept of a social network and provided 

some examples. In this course we illustrate common security and privacy settings to avoid unwanted 

access to your pictures, account etc. Note that the settings introduced in the following sections are 

recommendations for a safer social networking experience. You can always configure your account in 

a way that will make you feel more comfortable and safer. 

2.11.7.1 Facebook 

To access Facebook’s privacy settings click on the small arrow pointing down ( ) on the top right of 

the screen and select Privacy settings. You will be transferred to the Privacy Setting page (Figure 

240). Here you can set who will be allowed to view your profile and other information related to your 

personal account such as your pictures and shared items. It is recommended to set this option to the 

Friends choice.  

 

Figure 240: Setting Facebook privacy settings 

You can also change who can sent you messages by selecting the “How you connect” option and then 

configuring the given options (Figure 241): 

http://www.saferinternet.be/
http://www.clicksafe.be/
http://www.saferinternet.org.uk/
http://www.getsafeonline.org/
http://www.saferinternet.gr/
http://www.cyberethics.info/cyethics1/
http://www.draugiskasinternetas.lt/lt
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Figure 241: Page where you can configure How You Connect options in Facebook 

Be sure to click on the button Done, at the bottom of the window, once you have completed the 

changes to your personal settings. If you need more information you can always visit the Facebook’s 

help page at www.facebook.com/help . 

2.11.7.1.1 Facebook accessibility page 
Although Facebook does not have a dedicated accessible webpage, it does have a useful help section 

about accessibility at www.facebook.com/help/accessibility, as also shown in Figure 242.  

 

Figure 242: The accessibility page of Facebook 

http://www.facebook.com/help
http://www.facebook.com/help/accessibility
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There you can find useful information like keyboard shortcuts when using Facebook. A simpler 

version of Facebook can be found at https://m.facebook.com. This is the mobile version of the 

website but works with desktop browsers too. Some important shortcuts mentioned in the 

accessibility page are the zoom in (Ctrl & plus “+“).and the zoom out (Ctrl & minus “-“). 

2.11.7.2 Google + 

To access privacy settings on Google+, click on the icon with a small arrow pointing down ( )and 

select “Privacy Settings”. Here you can change who can view your profile information or your photos. 

Select the Edit visibility on profile ( ) option to change which information is 

available to whom. From the new window select the Anyone on the web ( ) option 

and change it accordingly to your personal taste. It is recommended that you set your information’s 

visibility among your circles as shown below (Figure 243): 

 

Figure 243: Window from where to define privacy settings in Google+ 

When done, select the Continue to my profile ( ) option. Next, on the Google+ 

( ) tab, you can change settings regarding your notifications and who can contact you. 

Keeping your personal information and pictures among your circles is safer since you protect them 

from unwanted access. 

To find out more about Google+ visit http://support.google.com/plus . 

2.11.7.3 Twitter 

For Twitter’s settings (Figure 244), select the small arrow pointing down ( ) option on the top left, 

next to your username. If you do not want to add location to your tweets, thus increasing your 

privacy, make sure the “Add Location to your tweets” option is unchecked. Also, it is recommended 

that you do not check the “Display media that may contain sensitive content” option as this will stop 

Twitter from filtering the content you see from offensive or other type of media.  

https://m.facebook.com/
http://support.google.com/plus
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Figure 244: Window from where to define privacy settings in Twitter 

If you do not want your tweets to be available to public check the “Protect my Tweets” option and 

also the “Always use HTTPS” as this will encrypt your information sent over the website. You must 

click on the “Save” button for your changes to take effect. 

To find out more about Tweeter visit https://support.twitter.com/ . 

2.11.7.3.1 Easy Chirp (Accessible alternative to 

Twitter) 
Along with YouTube and mobile Facebook, Twitter also has an accessible website. It can be found at 

http://www.easychirp.com. Easy Chirp is not officially developed by the Twitter team but created by 

other users instead. Before you start using the site, you must first sign in with your Twitter account. 

Select the “Sign in with Twitter” option to navigate to the next page (Figure 245). 

https://support.twitter.com/
http://www.easychirp.com/
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Figure 245: The main page of Easy Chirp, the accessible alternative of Twitter 

In order to use Easy Chirp, you must authorise the website to use the Twitter functions (Figure 246). 

This is needed because it is not an official Twitter web page.  

 

Figure 246: Window from where you can authorise the EasyChirp application to use your original Twitter account 

Fill in your Twitter username and password in the respective field and select “Authorize app”. 

Once you authorize Easy Chirp, you will be automatically navigated to the main screen, as shown in 

Figure 247 below. 
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Figure 247: The main screen of Easy Chirp after authorising it to access your Twitter account 

From here to post your 140 characters text, click in the text box and write your tweet. Then select 

the “Post” button to send the tweet online and make it available to your subscribers. 

2.11.7.4 Netlog 
Here we present how to increase your privacy on Netlog. You can change at any time what status 

your friends will see by clicking your current status, next to your username (Figure 248). 

 

Figure 248: Window from where you can define your current status in Netlog 

To access the privacy settings select the “Settings” option below your username, at the top right of 

the screen. Netlog offers some predefined settings but you can set your own by navigating through 

the tabs (Figure 249): 

 

Figure 249: Customising the predefined privacy settings of Netlog 
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Here are some useful settings for protection of your privacy on Netlog. Always click on “Save 

settings” before moving to the next tab: 

Findability: 

 

Figure 250: The Findability group of privacy settings in Netlog 

The page (Figure 250) offers the options to allow others find you through search results or overview 

page on ‘Explore’. You may select any or both of the two options. 

Profile access: 

 

Figure 251: The Profile Access group of privacy settings in Netlog 

The page (Figure 251) offers the possibility to select who can visit your profile (recommended to 

select Only friends), indicate whether the friends of your friends can view your profile, as well as, 

whether members who are not allowed to access your profile could send you private messages 

and/or see a limited version of your profile (there is an update link to define what the limited version 

of the profile would be). 

Communications: 

 

Figure 252: The Communication group of privacy settings in Netlog 
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The page (Figure 252) offers the possibility to define who can send messages to you, who can post 

comments and who can give rating. The options in all cases are: everyone, friends, friends of friends, 

and nobody. 

Logs: 

 

Figure 253: The Logs group of privacy settings in Netlog 

The page (Figure 253) offers the option to define whether your comments will be shown in the logs 

of your friends. 

To learn more about Netlog visit http://en.netlog.com/go/helpdesk . 

2.11.7.5 LinkedIn 
To access privacy settings on LinkedIn, select the “Settings” option below your username (Figure 

254): 

 

Figure 254: Selecting the Settings option under your username in Linkedin 

Here are recommended settings for the “PRIVACY CONTROL” section (Use the “Save” button after 

each change): 

Turn on/off your activity broadcasts: 

 

Figure 255: Turning off your activity broadcast in Linkedin 

 

http://en.netlog.com/go/helpdesk
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The page (Figure 255) provides a selection box. By selecting it, you let people know when you change 

your profile, make recommendations or follow companies. It is recommended to keep this feature 

turned-off in case you are looking for a job and don’t want your present employer to see your moves 

to that direction. 

Select who can see your activity feed: 

 

Figure 256: Selecting who can see your activity in Linkedin 

The page (Figure 256) shows a select box from which you can define who can see your activity feed 

on linkedin. E.g. you may choose the Only you option in case you do not want anybody else to have 

that right. 

Select what others see when you've viewed their profile: 

 

Figure 257: Defining what other can see when you have viewed their profile in Linkedin 

The page (Figure 257) provides buttons to select one of three options; the first is to allow other to 

see your name and headline (it is the recommended one), the second to allow them see your 

anonymous profile characteristics and the third to show you are totally anonymous. 
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Select who can see your connections: 

 

Figure 258: Defining who can see your connections in Linkedin 

The page (Figure 258) provides a selection box from which you can choose who can see your 

connections. For example, in case you do not want anyone to be able to see with whom you appear 

connected, you can choose the Only use option. 

Change your profile photo & visibility: 

 

Figure 259: Changing profile photo and visibility in Linkedin 

The page (Figure 259) asks you to select one of the three options to define who can view your profile 

photo in addition to the users you exchange messages with. The three options are your connections, 

your whole network, or everyone. It is recommended to choose the second option. 

Show/hide "Viewers of this profile also viewed" box: 

 

Figure 260: Defining whether to display the “Viewers of this profile also viewed” box in Linkedin 

The page (Figure 260) provides a check box. By selecting it you define that the “Viewers of this profile 

also viewed” box will not appear in your profile page. That is, the users that visit your profile will not 

be provided with information on what profiles your visitors view in general. 

To learn more about LinkedIn visit http://learn.linkedin.com/ . 

http://learn.linkedin.com/
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2.11.7.6 YouTube 
The YouTube website is a very popular place to share your videos or watch videos shared by other 

users. If you have a Google account (Gmail or Google+) you can use it from there as well since they 

are interconnected Web sites.  From the bar at the top of the page you can search for videos, upload 

your own, create an account or sign in if you have a user name, as shown in Figure 261. 

 

Figure 261: Top bar at YouTube page, with options to search, browse, upload, create account and sign-in 

To view a video after performing a search or after browsing for the most viewed videos of the day, 

click on its title, as shown in Figure 262. 

 

Figure 262: An example of search results in YouTube, with the title of a result marked in red-line box 

In the playback page, YouTube offers some features in order to make it easier for the user to share 
the video and to find similar videos. They are marked in Figure 263 and further explained afterwards. 
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Figure 263: The page from where a video is played. The different options are marked in numbers and explained in the 
text 

1. Uploader’s information: Here the name of the user that uploaded the video is shown and 
you have the option by clicking “Subscribe” to be notified when the user will upload new 
videos. 

2. Main window: The video will be played here. 
3. Playback bar: From here you can move the video forward or backward by moving the white 

dot. Since YouTube is downloading the videos from the Internet it needs some time to 
complete this action. The grey bar shows the download process of the video.  

4. Play button: The play button allows you to stop the video and resume it later. 
5. Video’s volume and duration: You can change the volume of the video here by clicking on 

the speaker symbol. The duration of the video is also shown along with the current process. 
6. Other controls: With these controls you can view the video in full screen or save it for later. 

Some videos offer better resolution and needs to be selected from here. 
7. Share options: Here you can like or dislike a video on YouTube by selecting the proper hand 

gesture. You can also share it with your friends or flag it as inappropriate. 
8. Views: This is a statistic about how many views the video got since the day it was uploaded. 

You can also see how any people liked or disliked the video. 
9. Description: Some uploaders write a description about their videos here. 
10. Comments: YouTube allows registered users to comment on videos. Comment will be shown 

here, unless the uploader does not allow this feature. 
11. Recommended videos: At this side list you can view recommendations made by YouTube 

based on the current video you are watching. This way you can find videos faster without 
further search. 
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2.11.7.6.1 Tube Majestyc (accessible interface to 

YouTube) 
Tube Majestyc is a simpler, more accessible way to visit YouTube. It can be found at 

http://tube.majestyc.net (Figure 264). This minimalistic website uses high contrast theme to provide 

easy access to videos from YouTube. The website is not developed officially by YouTube but it was 

built as a technical exercise as explained in the welcome text.  To search for a video, enter the 

website and at the search box type the video you are searching for. 

 

Figure 264: The main page of the Tube Majestyc, the accessible alternative of YouTube 

From the results page select the desired video and you will be transferred to the video’s webpage. In 

Figure 265, the basic functions for are marked. In the main screen (Label no. 1) the video will appear 

once you select the “Play” option (Figure 265, Label no.2). If you would like to move forward in the 

video select the “Skip Forward” option (Figure 265, Label no.4). To move back, select “Skip 

Backwards” (Figure 265, Label no.3). You can also mute the sound and keep the video playing (Figure 

265, Label no.5). Detailed video information, like the total duration of the video and the time 

elapsed, can be found bellow the playback button (Figure 265, Label no.6). YouTube allows users to 

comment on the online videos (although some video uploaders disable this function). To view the 

video’s comments scroll at the bottom of the page as shown in Figure 265, label no.7. 

http://tube.majestyc.net/
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Figure 265: The playback interface of Tube Majestyc 

2.11.8 Email Security 
We introduced email’s security risks in course 0-Email and Security. In this course we explain more 

security options to protect your system and data from potentially dangerous emails. The software 

tool, used here as an example, is the Mozilla Thunderbird.  

Email clients and dedicated email websites usually block content that is not included in the email but 

instead linked to the email. When this happens a relevant notification appears, informing you that 

some content has been blocked, as shown in Figure 266 below. 

 

Figure 266: Notification about blocking of content in an email message, example from Mozilla Thunderbird 

Read carefully the notification to find out from which address the content is linked to the email. If 

you recognise the address and if it is from the same source as the sender, click on the “Show Remote 

Content” button to see the email as it was sent. If you do not recognise the remote address, or if you 

are suspicious about the sender, do not allow the content to be shown. 
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You can also configure the email software to analyze your emails to avoid phishing/spoofing emails 

(explained in course 0) and to allow your antivirus to scan your messages. To access this options 

select from the main window, Tools Options and select the security tab (Figure 267): 

 

Figure 267: Marked Security Tab in the Options of Thunderbird 

In the following screenshots we illustrate a set of recommended settings for each tab, to achieve 

increased privacy and better protection. 

Junk 

 

Figure 268: The Junk tab and subsequent settings in the security options 

The page (Figure 268) offers three configuration options and each one can be activated with a check 

box next to it. The first allows you to define what the tool will do with the messages you mark as junk 

(here you can further select which folder the messages will be moved to or whether they will be 

deleted). The second option allows you to define whether the messages determined to be junk, will 

also appear as read. Finally, the third option allows you to enable logging on the junk filter, so that 

you can visit it later and check the actions taken by that filter on behalf of you. 

E-mail Scams 

 

Figure 269: The E-mail Scams tab and subsequent settings in the security options 
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The page (Figure 269) offers one configuration option that can be activated with a check box. By 

selecting it, you ask the tool to inform you if the message you read is defined to be suspicious email 

scam. 

Anti-Virus 

 

Figure 270: The Anti-Virus tab and subsequent settings in the security options 

The page (Figure 270) offers one configuration option that can be activated with a check box. By 

selecting it, the email client will allow antivirus tools to keep suspicious incoming messages in a safe 

location (quarantine them) and inform you to take proper actions to prevent damage. 

Passwords 

 

Figure 271: The Passwords tab and subsequent settings in the security options 

The page (Figure 271) allows you to define how the client deals with your passwords and whether it 

shall remember them and help you filling-in the relevant fields on forms. If you would like to check 

what passwords the applications has stored click on the “Saved Passwords...” option. You can 

remove password that you do not want the program to remember. 

Web Content 

 

Figure 272: The Web Content tab and subsequent settings in the security options 

The page (Figure 272) lets you to specify which third-parties (e.g. blogs, web sites, news feeds) are 

allowed to set cookies on your computer. It is recommended to check the box to Accept cookies from 
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sites and then select to keep until you close the tool. Note here that this is an independent setting 

and is not related with your internet browser’s settings. 

Finally, click on the OK button to save all performed changes in your settings. 

2.11.9 MS Security centre 
Microsoft Windows XP with Service Pack 2 and above, Windows Vista and Windows 7 come 

preloaded with many security features in order to maintain system stability and protect the user 

from known malware. All the security settings and systems status are gathered in one place and 

monitor the system to make sure that all the security features available are updated and working 

correctly. This centre was named Windows Security Center in Windows XP and Vista and has been 

renamed to Action Center for Windows 7. To access the Action/Security Center select the start 

button  and from the list on the right select Control Panel. Then select System and Security and 

finally the Action Center option (Security Center for Vista and XP) (Figure 273). 

 

Figure 273: Accessing the Control Panel, from the Start panel 

Then select System and Security (Figure 274),  
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Figure 274: The System and Security group of settings, in the Control Panel 

and finally the option named “Action Center” (Figure 275). 

 

Alternatively, you can select the start button, type “Action Center” in the search program and files 

and press enter. 

 

Figure 275: The Action Center settings from the Systems and Security group of settings, in the Control Panel 

The start-up page of the Action Center will open (Figure 276), indicating the system’s security status. 
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Figure 276: The Action Center settings in the Control Panel, with numbered sections/parts 

In this screen (Figure 276) you should check the status of the following features to make sure you get 

maximum protection for your computer: 

1. Network firewall: Windows firewall must be turned ON. If for any reason is OFF check the 

course Safety and SecurityPersonal firewall to find out how to turn it on. 

2. Windows updates: Windows updates are responsible for keeping the system up to date with 

the latest software fixes. The recommended setting is to have the system automatically 

download and install the latest updates. More info is available at the course Safety and 

SecurityOperating System (OS) and software updates. 

3. Virus Protection: Here you can find information about the status of your installed antivirus. 

As with the firewall status, this should be set to ON as well. If you do not have an antivirus 

installed, please check the course Safety and Security Antivirus Programs to find 

instructions to install an antivirus program. 

4. Spyware and unwanted software protection: Spyware is another dangerous category of 

malware so a countermeasure is a must for a safer online experience. Fortunately Windows 

include a free spyware scanner, the Windows Defender. By default Windows Defender is set 

to ON, but if for any case is OFF, you can turn it on easily. Below the “Spyware and unwanted 

software protection”, select “View installed antispyware programs” (Figure 277). 
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Figure 277: Selecting to view the installed antispyware programmes on your device 

From the pop up window select the “Windows Defender” option and then select Turn On 

(Figure 278). 

 

Figure 278: Turning on the Windows Defender program 

The Windows Defender main window will be launched as shown in Figure 279 bellow. 

 

 

Figure 279: The Windows Defender main window 

To scan your computer manually, select the Scan option. A manual scan can be performed at 

any time by launching the Windows Defender from the start panel (Figure 280). Select the 

start button and type Windows Defender in the Search Program and Files field. 
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Figure 280: Launching the Windows Defender program from the Start Panel 

Windows Defender updates are available through the Windows Update service. 

 

5. Internet Security Settings: This section here is a summary of your internet settings. If all the 

previous settings are configured correctly, the status of this option should be OK. 

 

6. User Account Control: Sometimes referred as UAC this setting configures the level of user 

interaction that is needed during system’s operation. Click on the “Change Settings” below 

the section’s title and then from the pop-up window (Figure 281) make sure the level of 

notifications is at the Default option. Finally click OK. 

 

 

Figure 281: Window from where you can define the level of notifications on changes 

7. Network Access Protection: This setting is for network administrators in order to keep the 

computers of their network updates with the latest security software. This setting is by default 

set to Off. 

1. http://csrc.nist.gov/publications/nistbul/csl96-05.txt 
 


